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List of Help Topics
The 9617 telephone and Personal Call Manager

■ Welcome on page 3

■ Installing the M9617 telephone on page 5

■ Starting and Exiting Personal Call Manager on 
page 23

■ Becoming familiar with the telephone and soft-
ware on page 27

■ Setup and customization on page 79

■ Storing your contacts on page 137

■ Looking up contacts on page 227

■ Making, answering and holding calls on 
page 228

■ Advanced features on page 305

■ Keyboard shortcuts on page 398

Other applications

■ The Voice Mail Assistant on page 392

■ The Launch Pad application on page 394
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Welcome
Welcome to Aastra’s 9617 telephone with Personal Call 
Manager.

The 9617 telephone is an advanced two-line telephone 
designed to work with Personal Call Manager software. 
Without the software, the 9617 telephone works on its 
own. When Personal Call Manager is running, you can 
control calls using either Personal Call Manager or the 
telephone.

The 9617 telephone and Personal Call Manager are 
designed to take full advantage of the latest services 
offered by your local telephone company—Caller ID and 
Call Waiting ID. (The names of these services may vary 
from area to area.)

For more information, refer to Feature Highlights on 
page 4.
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Feature Highlights

The 9617 telephone features:

■ a personal Directory that stores up to 100 contacts

■ a Callers List and a Redial List that record incoming 
and outgoing calls

■ two-line capability

■ a three-line back-lit display that allows for features 
like Call Waiting ID

■ advanced features such as Don’t Disturb and Auto-
busy Redial

Personal Call Manager features:

■ an Address Book which allows you to store the 
names, addresses, and telephone numbers of an 
unlimited number of contacts on your computer

■ the ability to export and import contact information 
to and from text files

■ simplified multiline interaction so it is easier to man-
age multiple calls

■ visual and audible caller identification

■ advanced features such as call screening and pager 
notification

For more information, refer to How the telephone and 
Personal Call Manager work together on page 76.
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Installing the 9617 telephone
The topics below take you step by step through the 
installation of the telephone. Follow them in the order 
that they appear.

■ Determining whether you have two telephone 
lines on one telephone cord on page 6

■ Connecting the cords on page 7

■ Attaching the stand on page 12

■ Adjusting the telephone display on page 18

■ Inserting the number card and lens on page 17

■ Plugging in the telephone for the very first 
time on page 19

■ Changing the telephone display language on 
page 20

■ Setting the date and time on the telephone on 
page 21

■ Telephone network services you should sub-
scribe to on page 22

■ Connecting a fax machine or modem to the 
telephone on page 387.
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Determining whether you have two 
telephone lines on one telephone cord

The 9617 telephone is a two-line telephone. Before you 
begin installing it, you need to know how your telephone 
lines are set up (you may have two telephone lines on one 
telephone cord). If you already know your setup, go to 
the next step: Connecting the cords on page 7. If you 
don’t, follow the steps below first.

To determine your telephone line setup:

1 Connect one end of your telephone cord to the 1  
jack on the telephone and the other end to the wall 
jack. Ensure nothing is plugged into the 2  jack on 
the telephone.

2 If you have not already done so, connect the small end 
of the power adaptor to the  jack on the back of 
the telephone, and plug the other end into a wall 
plug.

3 Read the telephone display. (If it prompts you to select 
a language, follow the directions on the telephone dis-
play to choose your language of choice.)

If only the time and date appear on the telephone display, 
you have two telephone lines on the telephone cord.

If the following message appears on the telephone 
display, you only have one line on that telephone cord:

Check line cord
Line 2

If you want to combine two lines onto one telephone 
cord, contact your telephone company.
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Connecting the cords

Proceed with the following steps once you know whether 
both telephone lines are on one telephone cord. If you are 
not sure, refer to Determining whether you have two 
telephone lines on one telephone cord on page 6.

To connect the telephone cords:

1 Pass all cords except the coiled handset cord through 
the hole in the base as shown below.

continued...

Route the 
handset cord 
along this 
groove.
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2 Connect the telephone cords. 

Refer to the illustration of 
the telephone jacks on the 
right when following these 
steps. 

You may find it helpful to 
refer to one of the following 
illustrations: An illustration 
of a one telephone-cord 
setup on page 10 or An illustration of a two 
telephone-cord setup on page 11.

If both telephone lines are on one telephone cord, 
plug one end of the telephone cord into the 1  jack, 
and plug the other end into the wall jack.

If your telephone lines are on separate telephone 
cords, plug one telephone cord into the 1  jack, and 
plug the other telephone cord into the 2  jack. Plug 
the other ends of the telephone cords into your wall 
jacks.

Attach one end of the coiled handset cord to the 
handset and the other end to the handset jack. Then 
route the handset cord along the groove leading off 
the side of the telephone as shown in the illustration 
on page 7.

3 Insert the hooked end of the thick USB cord into the 
USB jack on the back of the telephone. Insert the 
straight end into the  jack at the back of your 
computer.

continued...
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4 Connect the small end of the power adaptor to the  
jack on the back of the telephone, and plug the other 
end into a nearby electrical outlet.

To avoid potential electrical shock hazard or damage to 
the telephone, use only the manufacturer-supplied 
equipment and installation procedures. Specifically, use 
only 2 or 4 conductor modular teledapt plug/cords with 
this product, and an AC transformer that is CSA/UL or 
CSA-NRTL/C approved Class 2, Level C, rated. 

Substitution of non-approved equipment will void the 
Aastra Telecom warranty.

If you want to attach a fax machine or modem, refer to 
Connecting a fax machine or modem to the 
telephone on page 387.

When ready, go to the next step: Attaching the stand 
on page 12.
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An illustration of a one telephone-cord setup

In a one telephone-cord setup, two telephone lines (each 
with a separate telephone number) are combined into 
one telephone cord. If this is your line setup, plug one end 
of the telephone cord into the 1  jack, and plug the 
other end into the wall jack. (The 2  jack is not used.)

Return to Connect the telephone cords. on page 8.

The power 
adaptor.

The USB cord.

This telephone cord 
contains both of your 
telephone lines.
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An illustration of a two telephone-cord 
setup

In a two telephone-cord setup, each of your two 
telephone lines (each with a separate telephone number) 
is on a separate telephone cord. If you have this setup, 
you need to use two jacks. Plug one telephone cord into 
the 1  jack, and plug the other telephone cord into the 
2  jack. Plug the other ends of the telephone cords into 
your wall jacks.

Return to Connect the telephone cords. on page 8.

The power 
adaptor.

The USB cord.

Each telephone line is on a separate 
telephone cord. For two lines, you 
have two telephone cords.
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Attaching the stand

You have already routed the telephone cords through the 
hole in the stand, and routed the coiled handset cord in 
its groove. You can now attach the telephone stand.

How you attach the stand depends on whether you want 
to keep the telephone on a desk or mount it on a wall. 
When you have decided how you want to store the 
telephone, choose one of the topics below.

■ Desk-mounting the telephone on page 13

■ Wall-mounting the telephone on page 15
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Desk-mounting the telephone

To mount the telephone on the desk:

1 Lower the stand as shown below into the slots on the 
back of the telephone.

continued...
13



 

2 Slide the stand in the direction shown below until it 
clicks into the locked position.

When ready, go to the next step: Inserting the number 
card and lens on page 17.
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Wall-mounting the telephone

When wall-mounting the telephone, it is recommended 
that you use a wall-mounting plate which is available 
through your telephone company or at a local retailer. 
You may also find it easier to wall-mount the telephone if 
you purchase one or two short 20 cm (8”) telephone 
cords and use them in place of the long telephone 
cord(s).

To wall-mount the telephone:

1 Lower the stand into the slots on the back of the tele-
phone as shown below by the arrows.
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continued...

2 Slide the stand in the direction shown below until it 
clicks into the locked position.

3 Line up the keys on the 
wall mounting plate with 
the key holes on the base 
of the 9617 telephone as 
shown. Push the phone 
onto the wall mounting 
plate, and then push 
down to secure the tele-
phone into place. Tuck 
the excess cord inside the stand itself.

When ready, go to the next step: Inserting the number 
card and lens on page 17.
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Inserting the number card and lens

The 9617 telephone comes with a small paper number 
card and a clear plastic number card lens. This card allows 
telephone users to know what telephone number they 
are calling from.

To insert the number card and lens:

1 Write your telephone number on the paper number 
card.

2 Place the number card into the slot underneath the 
handset.

3 Bend the clear plastic lens and place it on top of the 
number card in the slot.

When ready, go to the next step: Adjusting the 
telephone display on page 18.
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Adjusting the telephone display

When you have finished installing the telephone, adjust 
the angle of the telephone display to your liking.

Press ∆ to adjust the contrast. The contrast 
feature allows you to adjust the brightness of the display.

When ready, go to the next step: Plugging in the 
telephone for the very first time on page 19.
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Plugging in the telephone for the very first 
time

The very first time you plug-in your 9617 telephone, a 
message appears asking you to make a language 
selection. Simply follow the directions on the telephone 
display.

Your telephone also runs a test to ensure that the line 
cords are connected properly. If the test fails, the message 
Check line cord appears on the telephone display, and 
the line that is not connected is identified. Make sure that 
all connections are fastened securely. For more 
information, refer to Clearing the Check line cord 
message on page 48.

You can now change the display language or set the date 
and time. For more information, refer to the following 
topics:

■ Changing the telephone display language on 
page 20

■ Setting the date and time on the telephone on 
page 21
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Changing the telephone display language

You may wish to change the language of the messages 
and prompts that appear on the display of your 9617 
telephone.

To change the display language on the telephone:

1 Press the Options key. (To see the location of the 
Options key, refer to The M9617 telephone keys 
and lights on page 29.)

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 1 or press 
‚ ⁄.

4 Press •. The current language selection is shown by a 
checkmark.

5 Press – until you see the desired language.

6 Press • to select the language that appears on the 
display.

7 Press ®.

Note: You cannot change the display language for the 
Personal Call Manager software.
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Setting the date and time on the telephone

If you subscribe to a Caller ID service from your telephone 
company, the date and time displayed on the 9617 
telephone are set automatically when you receive your 
first telephone call. 

Only if you do not subscribe to a Caller ID service must 
you set the date and time by following the steps below.

To manually set the date and time:

1 Press the Options key. (To see the location of the 
Options key, refer to The M9617 telephone keys 
and lights on page 29.)

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 2 or press 
‚ ¤.

4 Press •.

5 Follow the instructions on the telephone display. Press 
‘ to backspace and delete numbers, and 
press ß to save each entry.

6 Press ®.

Note: To revert back to the automatic date and time 
setting after you have manually set the date and time, 
unplug the power adapter and then plug it back in again. 
The next telephone call you receive will then set the date 
and time automatically (if you subscribe to a Caller ID 
service).
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Telephone network services you should 
subscribe to

The 9617 telephone and Personal Call Manager are 
designed to take advantage of many telephone network 
services. The recommended services are listed below. To 
subscribe to these services, contact your local telephone 
company. 

Note: The names of these services may vary from area to 
area. Contact your telephone company for more 
information.

Caller Identification (Caller ID)

When you subscribe to this service, the telephone 
company sends you the name and number of people who 
call you. For more information, refer to Answering a call 
using your telephone on page 264 and Caller ID and 
Personal Call Manager on page 272.

Call Waiting Identification (Call Waiting ID)

This service is similar to Caller ID, except it applies to Call 
Waiting callers. When you subscribe to this service, the 
telephone company sends you the name and number of 
Call Waiting callers. For more information, refer to 
Answering a Call Waiting call using the telephone 
on page 266.

Three Way Calling

When you subscribe to this service, you can conference 
two callers on one line of the 9617 telephone. This 
feature is useful for making conference calls. For more 
information, refer to Making a Three Way Call on 
page 297.
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Starting and Exiting Personal Call Manager
The following sections give an overview of starting and 
exiting Personal Call Manager.

■ The very first time you start Personal Call Man-
ager on page 24

■ Starting Personal Call Manager on page 25

■ Exiting Personal Call Manager on page 26
Once you have launched the application, you need to set 
up Personal Call Manager. Refer to Setting up Personal 
Call Manager on page 123 for more information.
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The very first time you start Personal Call 
Manager

To start Personal Call Manager:

1 If you see a shortcut for Personal Call 
Manager (shown on the right) on your 
desktop, double-click on it.

OR

1 Click on the Start button and point to 
the Programs menu item. A submenu appears.

2 Point to the Personal Call Manager menu item. A 
submenu appears.

3 Click on the Personal Call Manager menu item.

The very first time you launch Personal Call Manger, the 
Choose a TAPI Line dialog box appears. For information 
on choosing a TAPI line, refer to Specifying the TAPI 
line used by Personal Call Manager on page 124.

When you have chosen a TAPI line, the Dialing 
Properties dialog box appears. Use this dialog box to 
specify the dialing properties for the location you are 
dialing from (refer to Specifying dialing properties for 
the location you are dialing from on page 125).

For more information, refer to the following topics:

■ Starting Personal Call Manager on page 25

■ Getting to know Personal Call Manager on 
page 53

■ Personal Call Manager preferences on page 127
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Starting Personal Call Manager

To start Personal Call Manager:

1 If you see a shortcut (shown on the 
right) for Personal Call Manager on 
your desktop, double-click on it.

OR

1 Click on the Start button and point to 
the Programs menu item. A submenu appears.

2 Point to the Personal Call Manager menu item. A 
submenu appears.

3 Click on Personal Call Manager menu item.

When the application launches, the Personal Call 
Manager icon appears on the task tray and task bar, and, 
by default, the Personal Call Manager main window 
appears.

Synchronization on startup

Each time you start Personal Call Manager, the software 
synchronizes with the information in the telephone. For 
more information, refer to How the telephone and 
Personal Call Manager work together on page 76 and 
Changing the Startup synchronization setting on 
page 134.
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Exiting Personal Call Manager 

You can exit Personal Call Manager from the task tray or 
the main window.

To exit Personal Call Manager using the task tray:

1 Right-click on the Personal Call Manager icon in the 
task tray.

2 Click on the Exit menu item.

To exit Personal Call Manager using the main win-
dow:

1 Click on the File menu.

2 Click on the Exit menu item.

You can also exit Personal Call Manager by clicking 
on the close window button (shown on the right) 
in the top right hand corner of the Personal Call 
Manager main window or by typing ALT+F4 on the 
keyboard.

The task tray
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Becoming familiar with the telephone and 
software
The first two sections listed below help you get 
acquainted with the telephone and Personal Call 
Manager. Once you are familiar with their features, read 
the third section to learn more about how they enhance 
each other.

Refer to the following topics:

■ Getting to know the M9617 telephone on 
page 28

■ Getting to know Personal Call Manager on 
page 53

■ How the telephone and Personal Call Manager 
work together on page 76
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Getting to know the 9617 telephone

The 9617 telephone has a three-line backlit display and 
several indicator lights.

For more information, refer to the following topics:

■ The M9617 telephone keys and lights on 
page 29

■ Telephone key descriptions on page 30

■ Telephone display and light messages on 
page 33

■ Viewing multiple display and light messages on 
page 42

■ The Callers List on page 43

■ Voice Mail notification on page 46

■ Controlling the volume of your telephone on 
page 49

■ The telephone Directory on page 139
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The 9617 telephone keys and lights

For descriptions of how these keys work, refer to 
Telephone key descriptions on page 30.

Options key

Down/up arrows

Sliding panel

Left/right arrows

Set indicator light

6 memory keys

Adjustable display

C o n t r a s t

D i r e c t o r y

L i n k

R e d i a l

D i a l

C o n f e r e n c e

L i n e  2

L i n e  1

H a n d s f r e eM u t e

R l s
H o l d

C a l l e r s

S a v e

D e l e t e

Handsfree/Mute
indicator light

Line indicator lights
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Telephone key descriptions

∆ Selects one of eight display contrast 
settings.

¢ Stores and accesses the names and 
telephone numbers of up to 100 contacts.

≈ Accesses a list of the last 100 calls you have 
received, starting with new calls.

ß Stores numbers and names in the Directory 
and in memory keys.

∑ Erases memory keys, deletes the Redial List, 
and deletes items in the Directory and 
Callers List.

ª Moves up and down through any list such 
as the Options List, Directory, Callers List, or 
Redial List.

“ Backspaces and erases when you are 
predialing and when you are adding or 
changing numbers and names in the 
Options List, Directory, or memory keys.

continued...
30



‘ Adds a space when you are entering names 
in the Directory or in memory keys, and 
allows you to view multiple status 
messages on the telephone display.

˙ Puts the call on hold and inserts a pause 
between digits you are storing in the 
Directory or memory keys. 

® Releases (hangs up) a call and exits the 
Options List, Callers List, Redial List or 
Directory.

˚ Accesses network features such as Call 
Waiting. (The Link key is also referred to as 
the Flash key.)

µ Accesses a list of the last ten numbers you 
dialed.

∂ Dials the telephone number on the 
telephone display on your prime line.

ç Joins two calls to create a conference call.

¬ Selects Line 1 or Line 2 and turns on 
Handsfree mode if you have not picked up 
the handset. It also dials the telephone 
number on the telephone display.

continued...
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© Activates the speaker and microphone so 
you can listen and talk without using the 
handset. Also mutes the microphone so 
that your caller cannot hear you.

√ Adjusts the receiver, speaker, and ringer 
volume.

∫ Memory keys store numbers, names, and 
features. You label these keys with the 
name, number or feature you store in them 
by using the paper key cap label sheet 
provided.

† The unlabeled Options key is hidden under 
the sliding panel. This key accesses the 
Options List, which contains options that 
customize the features of your telephone. 
Refer to Using the Options List to 
customize the M9617 telephone on 
page 81 for more details.
32



Telephone display and light messages

The 9617 has a backlit three-line display that uses icons 
and messages for your call information.

For more information, refer to the following topics:

■ General telephone display messages on page 34

■ Light messages - what they mean on page 37

■ Extension in Use notification on the telephone 
on page 41

■ Viewing multiple display and light messages on 
page 42

■ The Callers List on page 43

■ Voice Mail notification on page 46

■ The Clear Message Waiting option on page 47

■ Clearing the Check line cord message on 
page 48
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General telephone display messages

The table below shows some common display messages.

Common General Display Messages (page 1 of 3)

Message What it means

-> There is more information to be 
shown on the telephone display. 

Press ‘ to see it. 

Check line cord
Line 1 or Line 2

The telephone line indicated is not 
connected properly.

Directory empty 
Use SAVE to add

The Directory remains empty until 
you save numbers and names in it.

Directory full
No changes made

The Directory has a 100 entry limit. 
If you want to add another item, 
first delete an item you no longer 
use to make room for the new one.

Extension in use Someone on an extension telephone 
is using the line you have selected.

Feature ON The FeatureLight On key has been 
pressed and the code dialed out. To 
turn off the feature and the light, 
press the FeatureLight Off key and 

lift the handset or press ©, 

∂, or ¬. See 
Using feature keys for network 
telephone services on page 356.
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<Forwarded Call The incoming call is forwarded from 
another telephone.

Key is locked The memory key is factory-
programmed and cannot be erased 
or reprogrammed. Program a 
different memory key.

The caller is calling from outside 
your local area (i.e., long distance).

Make calls first 
or
Make second call

You must make two calls before you 

press ç.

Message Waiting
Line x

Your Voice Mail service has a 
message for you. To subscribe to the 
Voice Mail service, contact your tele-
phone company.

Conference held A conference call is on hold.

Press Confer-
ence

This appears when you try to take a 
held conference call off hold by 

pressing ˙. Press 

ç to take the conference 
calls off hold.

Press line key This appears when you press 

˙ and your call is already 

on hold. Press ¬ to retrieve 
the held call.

Common General Display Messages (page 2 of 3)

Message What it means
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Private number 
or
Private name

The caller has requested that the 
telephone company not deliver his 
or her name or telephone number.

Redial List is
empty

You pressed µ but there 
are no numbers in the Redial List to 
dial.

Ringer is OFF
Line x

The ringer volume is turned off for 
that line. To turn it on, press the 
volume bar. 

Unknown name or
Unknown number

The name or number is unavailable.

>…xxxxxxxxxxxx
or
…xxxxxxxxxxxxx

The telephone number is longer 
than the telephone display.

XX New Callers New callers have been added to the 
Callers List since you last checked it.

Indicates an incoming call.

Indicates that the phone is off hook.

Indicates an incoming Call Waiting 
call.

Common General Display Messages (page 3 of 3)

Message What it means
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Light messages - what they mean

The 9617 telephone set indicator light turns on to alert 
you when the telephone rings, a feature is on, or when 
someone on an extension telephone is using the same 
line as you. Indicator lights beside the line keys and 
© key show you their status (e.g., whether they 
are being used).

For more information, refer to the following topics:

■ Set indicator light messages on page 38

■ Line indicator light messages on page 39

■ Handsfree/Mute indicator light messages on 
page 40
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Set indicator light messages

To see the location of the set indicator light, refer to The 
M9617 telephone keys and lights on page 29.

Set indicator 
light status Telephone status

The light is on. Someone on an extension telephone 
is using one of your telephone lines. 
Refer to Extension in Use notifica-
tion on the telephone on page 41

OR

You have pressed a FeatureLight ON 
key and the feature is active. Refer 
to Using FeatureLight keys on 
page 363

The light is 
flashing slowly.

You have a have a new Voice Mail 
message. Check your Voice Mail. To 
receive voice messages, you must 
subscribe to Voice Mail services from 
your telephone company.

The light is 
flashing quickly.

You have an incoming call. Refer to 
Answering calls on page 263.
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Line indicator light messages 

To see the location of the line indicator lights, refer to The 
M9617 telephone keys and lights on page 29.  

Line indicator light 
status Line status

The light is on. The line is in use.

The light is flashing. The line is on hold.

The light is flashing 
very quickly.

An incoming call is coming in 
on that line.
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Handsfree/Mute indicator light messages

To see the location of the Handsfree/Mute indicator light, 
refer to The M9617 telephone keys and lights on 
page 29.

For more information on Handsfree mode and muted 
calls, refer to Handsfree calls on page 261 and Muting 
a Handsfree call on page 262.

Handsfree/Mute 
indicator light 

status
Handsfree/Mute status

The light is on. The telephone is in Handsfree 
mode.

The light is flashing 
quickly.

The Handsfree/Mute micro-
phone is muted so your caller 
cannot hear you.
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Extension in Use notification on the 
telephone

Line indicator lights let you know whether a line is 
available for you to use. When another extension is using 
a line, the line indicator light for that line (located beside 
the line key) turns on. To see the location of the Line 
indicator lights, refer to The M9617 telephone keys 
and lights on page 29. 

When you are on a call and someone on an extension 
telephone tries to use your line, the set indicator light (the 
light above the ˚ key) turns on. The light 
remains on and the message Extension in use appears 
until the person at the other extension hangs up.

Extension in Use and the Fax switch feature

When you lift the handset or press ©, the 9617 
telephone automatically selects the prime line (for 
information on the prime line feature, see Changing the 
prime line on page 240). 

If your prime line is Line 2 and a fax switch peripheral 
device (e.g,. a fax machine) is using that line, Line 2 is not 
selected when you pick up the handset. Instead, the 
message Extension in use / Press line key appears on 
the telephone display.

Then, if you press ø, you access Line 1 and can 
make a call. If you press π, you access Line 2 
and may interrupt the call to the peripheral.

For more information, refer to Extension in Use 
notification in Personal Call Manager on page 73.
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Viewing multiple display and light messages

There are several messages that can be active at any time, 
such as date and time, X New Callers, Feature ON, 
Message Waiting, and Ringer is OFF. When more than 
one of these messages is active, the telephone display 
shows the most recent message and an arrow beside it 
(e.g., 1 New Caller ‚). 

You can view the other messages by pressing ‘. 
Each time you press ‘, the telephone display 
shows the next active message (and, if applicable, the set 
indicator light associated with the message).

If you are on Line 1 and a call comes in on Line 2, an 
arrow (->) appears on the screen. To see the Caller ID 
information, press ‘.
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The Callers List

The 9617 telephone Callers List logs your incoming calls. 
It can hold up to 100 calls. For each call, it logs the caller’s 
name and number (if available), the time of the call and 
whether the call was long distance.

To view the Callers List, press ≈.

A sample Callers List entry is shown below.

You must subscribe to Caller ID services from your local 
telephone company to receive caller information such as a 
name or number.

Note that even if you subscribe to Caller ID, you may 
sometimes receive “Private name”, “Unknown name”, 
“Private number” or “Unknown number” instead of the 
caller’s actual name or number. 

For more information, refer to Callers List telephone 
display messages on page 44.

01    Steve Gervais

555-1234 (403)

AUG 13  12:45PM       

The item number 

Indicates a new call

The date and time The call was long distance

The caller’s number

The name of the callerYou have returned

The call was The area code 403 has
been stripped off andanswered

the call

in the Callers List

of the call

placed in brackets
after the number.
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Callers List telephone display messages

Common Callers List Display Messages (page 1 of 2)

Message What it means

Callers List is
empty

The Callers List has not logged any 
calls, or you’ve deleted all the calls in 
the Callers List. (Your telephone 
does not record incoming calls until 
you subscribe to the Caller ID 
service.)

Calls bumped=xx A number (xx) of old calls have been 
automatically removed from the 
Callers List to make room for new 
calls. The Callers List limit is 100 
calls.

<Forwarded The call was forwarded from 
another location.

The call was long distance.

No number You are trying to call someone in 
your Callers List and the number is 
“Unknown” or “Private.”

Private number 
or
Private name

The caller has requested that the 
telephone company not deliver his 
or her name or telephone number.

Unknown name or
Unknown number

The name or number is unavailable 
from the telephone company.
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01√Unknown Name
       555-5555

The checkmark (√) means that you 
have returned the call from the 
Callers List.

 NNNN     MAR04 3:30pm N means a new call.

…xxxxxxxxxxxxx An ellipse “…“ followed by x’s means 
the number is longer than the tele-
phone display. 

Indicates an unanswered call in the 
Callers List.

Indicates an answered call in the 
Callers List.

Indicates a Call Waiting call in the 
Callers List.

Common Callers List Display Messages (page 2 of 2)

Message What it means
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Voice Mail notification

When you have a Voice Mail message, the 9617 
telephone’s red indicator light (located above the 
˚ key) flashes slowly and the telephone display 
shows:

Message Waiting
Line x 

or

Message Waiting
Line 1  Line 2 

In Personal Call Manager, the message waiting 
icon (shown on the right) flashes in the task tray 
when you have a Voice Mail message. 

Tip: Voice Mail Assistant is an application, installed with 
Personal Call Manager, which allows you to access voice 
mail from your computer. To start this program, right-click 
on the flashing Message Waiting icon in the task tray and 
then click on the Start VoiceMailAssist menu item. For 
more information, refer to The Voice Mail Assistant on 
page 392.

Once you have listened to your message(s), the indicator 
light stops flashing and the Message Waiting display 
message disappears. If the message does not disappear 
and the light continues flashing, you can use the Clear 
Message Waiting option to remove them. Refer to The 
Clear Message Waiting option on page 47 for more 
information.

Contact your local telephone company to find out how 
you can subscribe to Voice Mail services.
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The Clear Message Waiting option

There may be times when Message Waiting appears on 
the telephone display and the set indicator light continues 
flashing when there are no new Voice Mail messages. 

If so, you can turn the display message and light off using 
the Clear Message Waiting option.

To clear message waiting:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 6 or press 
‚ fl.

4 Press • to clear message waiting.

5 Press ¬ for the line with the Voice Mail ser-
vice. 
If required, repeat steps 4 and 5 for the other line.

Note: This option only applies if you subscribe to Voice 
Mail services from your telephone company.
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Clearing the Check line cord message

There may be times when Check line cord appears on 
the telephone display and you want to clear this message. 
For example, you may have only one line cord connected. 

You can remove the Check line cord message from the 
telephone display by turning off the Check Line Cord 
option for the line that is not connected.

To enable or disable the check line cord message:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 13 or press 
⁄ ‹.

4 Press •.

5 Press ¬ of the line the Check line cord mes-
sage applies to.

6 Press • to enable the Check line cord message. Press 
£ to disable the Check line cord message.

7 Press ®.
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Controlling the volume of your telephone

You can control the volume of the ringer, handset speaker 
and Handsfree speaker. You can also choose the ring tone 
for the 9617 telephone ringer.

For more information, refer to the following topics:

■ Setting the ringer volume on page 50

■ Choosing the ring tone for the ringer on 
page 51

■ The handset and Handsfree speaker volume on 
page 52
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Setting the ringer volume

To adjust the ringer when the telephone is idle:

1 Press one side of √.

2 Press ¬ for the line you want to adjust the 
ringer for.

3 Press the right side of √. The ringer sounds. 
Continue pressing it until you reach the desired ring 
volume. (Pressing the left side decreases the volume 
and pressing the right side increases the volume.)

4 Press ß.

To adjust the ringer volume when the telephone is 
ringing on one line:

1 Press the left or right side of the volume bar 
√ to adjust the ringer volume for the ring-
ing line.

To turn the ringer off:

1 Ensure the phone is not off the hook (i.e., ensure the 
handset is resting in the cradle and the Handsfree indi-
cator light is off).

2 Press √.

3 Press ¬ for the line you want to adjust the 
ringer for.

4 Press the left side of √. Continue pressing 
the left hand side until the ringer is off. 

5 Press ß. Ringer is OFF and the line affected 
appear on the telephone display.
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Choosing the ring tone for the ringer

You can choose one of four different ring tones for each 
line independently.

To select the ring tone:

1 Make sure that the ringer is turned on (see Setting 
the ringer volume on page 50).

2 Press the Options key.

3 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

4 Use ª to scroll to option number 4 or press 
‚ ›.

5 Press •. 

6 Press ¬ for the line you want to set the ring 
tone for. The current ring tone sounds.

7 Use – until you hear the ring tone you want 
to select. When selecting the ring tone, press the left 
or right side of √ to adjust the volume.

8 Press ß when you are satisfied with ring tone 
and ringer volume. Repeat steps 5-8 for the other line 
if desired.

9 Press ®.
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The handset and Handsfree speaker volume

The handset volume

To adjust the handset volume:

1 While you are on a call, press the left or right side of 
the volume bar √. The handset volume 
returns to normal after you have completed your call.

The speaker volume

To adjust the speaker volume:

1 While you are listening to the Handsfree speaker, you 
can press the left or right side of the volume bar 
√. The speaker volume remains at the vol-
ume level you last selected until the next time you 
change it.
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Getting to know Personal Call Manager

Personal Call Manager provides an easy-to-use computer 
interface for the 9617 telephone.

For more information, refer to the following topics:

■ Startup icons on page 54

■ The task tray icon on page 55

■ The task tray menu on page 56

■ The Main Window on page 58
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Startup icons

When Personal Call Manager starts up, two icons are 
added to the screen: the taskbar icon and the task tray 
icon. These two icons have distinctly different functions. 

Use the taskbar icon to open the Personal Call Manager 
main window when it is minimized or hidden behind 
other application windows.

The task tray icon provides quick access to Personal Call 
Manager functions when you are using other programs. 

The diagram below shows where each icon is found.

For more information, refer to The task tray icon on 
page 55.

The task trayThe task bar icon
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The task tray icon

The Personal Call Manager icon (shown on the 
right) appears in the task tray. This task tray icon 
provides quick access to Personal Call Manager 
functions when the main window is closed.

If you turn on the Don’t Disturb feature, this icon changes 
(refer to Don’t Disturb and Personal Call Manager on 
page 327).

Note: If you want to use the task tray icon when you are 
in Personal Call Manager, first click outside the Personal 
Call Manager window to deselect Personal Call Manager.

When you let the mouse pointer hover over the Personal 
Call Manager icon, the number of current calls appears.

When you right-click on the Personal Call Manager icon, 
a menu appears that allows you to:

■ set Personal Call Manager preferences;

■ start the Voice Mail Assistant application

■ open the Personal Call Manager main window; or

■ exit from Personal Call Manager.
When you single click on the Personal Call Manager icon, 
the task tray menu appears. From the task tray menu you 
can perform most basic call functions.

For more information, refer to The task tray menu on 
page 56.

The task tray
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The task tray menu

You can use the task tray menu to perform most basic call 
functions, such as making and answering calls, placing 
calls on hold and creating conference calls with two other 
callers (a three-call conference).

The Personal Call Manager task tray menu is divided into 
two main sections, the upper and the lower.

The upper portion of the menu contains the current calls 
and their status icons. These icons are explained below. 
(These icons also appear in the Calls menu.) If there are 
no calls, the upper portion of the menu does not appear. 

Icons in the Task Tray or Calls Menu  (page 1 of 2)

Icon Call Status Description

Active Call Appears beside the call you are 
currently on.

Held Call Appears beside calls that are 
on hold.

Conference 
Call

Appears beside the calls that 
are part of a conference call.

Held 
Conference

Appears beside calls that are 
part of a conference that is on 
hold.
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The lower portion of the menu contains the following 
features:

■ Callers List – a list of the last ten calls you received 
that you can use to return calls (see The Callers List 
in Personal Call Manager on page 353)

■ Redial List – a list of the last ten telephone numbers 
you dialed that you can use to redial telephone num-
bers (see The Redial List in Personal Call Manager 
on page 354)

■ Quick Dials – a list of telephone numbers stored in 
the Quick Dials folder that you can use to make calls 
(see The Quick Dials folder on page 160)

■ Manual Dial – a command that lets you dial a tele-
phone number using the keyboard (see Dialing 
using the Dial dialog box on page 250)

■ DND – a command that turns the Don’t Disturb fea-
ture on or off (see Don’t Disturb and Personal Call 
Manager on page 327)

Ringing Appears beside calls that you 
have not answered.

Icons in the Task Tray or Calls Menu  (page 2 of 2)

Icon Call Status Description
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The Main Window

The main window allows you access to all of Personal Call 
Manager’s features.

Opening the main window

When you start Personal Call Manager, the main window 
appears. By default, the window remains open.

To maximize the main window (if it is closed):

■ Click on the Personal Call Manager icon in the task-
bar.

OR

■ Right-click on the Personal Call Manager icon in the 
task tray and then click on the Open menu item.

If you do not want the main window to remain open, you 
can set the Startup Option so that the window minimizes 
to an icon on the task bar when you launch Personal Call 
Manager. (See The Startup Option on page 130.)

For more information, refer to the following topics:

■ The parts of the main window on page 60

■ Closing the main window on page 59
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Closing the main window

When you close the main window, it minimizes to an icon 
on the taskbar as shown below.

To close the main window (if it is open):

■ Click on the minimize button (shown on the 
right) in the top right corner of the window.

When you close the main window, you can still 
control your telephone calls from the Personal Call 
Manager icon in the task tray.

For more information, refer to the following topics:

■ The task tray icon on page 55

■ The task tray menu on page 56

■ Exiting Personal Call Manager on page 26
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The parts of the main window

The Personal Call Manager main window is made up of 
the following:

■ the Menu bar

■ the Toolbar

■ the The Address Book section

■ the The Current Calls section

■ the Status bar
All of these components, except the Menu bar, can be 
turned on or off to suit your needs. You can resize any of 
the sections in the main window by dragging their 
borders. You can also move the toolbar by dragging it to 
a new position.

Tree View
List View

Calls box Conference box

Address

Menu bar

Current

Toolbar

book

calls

Status
bar
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Menu bar

You use the menus on the menu bar to access all of the 
features available in Personal Call Manager. The menu bar 
is always visible on the main window.

Menu Description

File Lets you add new contacts and folders, set 
properties for contacts, import and export 
contact information from and to text files 
and exit Personal Call Manager.

Edit Lets you cut, copy, paste and delete contacts 
and folders; lets you undo the last action you 
have performed.

View Lets you choose how contacts are displayed; 
lets you show or hide the toolbar and status 
bar.

Calls Lets you make and answer calls, access call 
lists and turn Do Not Disturb on or off. This 
menu is identical to the task tray menu. See 
The task tray menu on page 56.

Tools Lets you set dialing properties and prefer-
ences, configure a TAPI line and find 
contacts.

9617 
Options

Lets you access the Quick Dial Manager 
and Memory Keys dialog boxes, and hide 
the 9617 Options part of the toolbar.

Help Lets you view help topics and the software 
version you are using.
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Toolbar

The Personal Call Manager toolbar has two sections, the 
main toolbar and the 9617 Options toolbar.

These toolbar sections contain buttons that provide quick 
and easy access to Personal Call Manager functions.

To hide or display both toolbar(s):

1 Click on the View menu.

2 Click on the Toolbar menu item. The combined tool-
bar either appears or disappears. 

When the toolbar is visible, a checkmark (✔) appears 
beside the Toolbar menu item in the View menu.

To show or hide the 9617 Options toolbar:

1 Click on the 9617 Options menu.

2 Click on the 9617 Toolbar menu item. The 9617 tool-
bar either appears or disappears. Choose this menu 
item again to toggle between these settings.

For more information, refer to Toolbar button 
descriptions on page 63.
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Toolbar button descriptions

The toolbar buttons provide quick access to commonly 
used features. To access or activate a feature, simply click 
on the appropriate toolbar button. The toolbar buttons 
are described below.

Toolbar Buttons (page 1 of 4)

Button Feature Description

Up One 
Level

Exits from the current folder 
and moves one level up in the 
Address Book.

New 
Folder

Creates a new folder in the 
Address Book.

New 
Contact

Creates a new contact in the 
Address Book, and opens the 
New Contact Address Prop-
erties dialog box.

Cut Copies the selected folder or 
contact into the Clipboard and 
then deletes it. 

Copy Copies the selected folder or 
contact into the Clipboard. 
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Paste Pastes the folder or contact 
you copied to the clipboard 
into the selected folder. (The 
clipboard still retains a copy 
even after you have used this 
command, so you can paste a 
copied item more than once.)

Properties
(This 
button is 
black.)

Displays the Address Proper-
ties dialog box for the selected 
contact or the Properties 
dialog box for the selected 
folder. 

Large 
Icons

Displays the folders and 
contacts in the Address Book 
as large icons. 

Small 
Icons

Displays the folders and 
contacts in the Address Book 
as small icons.

List Displays the folders and 
contacts in the Address Book 
as small icons organized in 
vertical columns.

Toolbar Buttons (page 2 of 4)

Button Feature Description
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Report Displays the folders and 
contacts in the Address Book 
in a report view format. In this 
format the icon, first name, 
last name, telephone numbers, 
and email information for the 
contact are shown.

Find 
Person

Displays the Find dialog box. 
You can use this dialog box to 
find a contact within the 
Address Book.

Calls Log Displays the Calls Log 
window. This window allows 
you to view the log of 
incoming and outgoing calls.

Configure
Telephony 
Device

Displays the 9617 Configura-
tion Properties dialog box 
which allows you to set the 
options for your telephone.

Help Displays the application Help 
screen which allows you to 
view help topics.

Memory 
Key

Displays the Memory Keys 
dialog box which allows you to 
use the memory keys.

Toolbar Buttons (page 3 of 4)

Button Feature Description
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Directory 
Synchroni-
zation

Synchronizes the Quick Dials 
folder with the telephone 
Directory so that they both 
contain the same contacts.

9617 
Property 
Page
(This 
button is 
blue.)

Displays the 9617 Property 
dialog box which allows you to 
set the ring configuration for 
the selected contact. This 
button is only available when a 
Quick Dials contact is selected.

Quick Dial 
Manager

Opens the Quick Dial 
Manager window so you can 
set the ring configuration for 
your Quick Dials. See 
page 331.

Toolbar Buttons (page 4 of 4)

Button Feature Description
66



The Address Book section

The Address Book is a list of all the contacts stored in 
Personal Call Manager. The Address Book consists of two 
parts: 

■ the Tree View, located on the left-hand side of the 
Address Book, shows the structure of your folders

■ the List View, located on the right-hand side, shows 
the folders and the contacts stored in whichever 
folder is selected in the Tree View section

To see where each part is located, refer to The parts of 
the main window on page 60.

To display the Address Book:

1 Click on the View menu.

2 Click on the Only Address Book menu item to dis-
play only the Address Book. 

OR

Click on the Both Address Book and Calls menu 
item to display both the Address Book and the Current 
Calls.

A bullet symbol (•) appears beside the current 
selection.

For more information on using the Address Book, refer to 
The Address Book in Personal Call Manager on 
page 157.
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The Current Calls section

The Current Calls section consists of two parts:

■ the Calls box which shows your current calls

■ the Conference box which shows the calls that have 
been joined together in a conference

To see where these are located, refer to The parts of the 
main window on page 60.

To display the Current Calls:

1 Click on the View menu.

2 Click on the Only Calls menu item to display only the 
Current Calls. 

OR

Click on the Both Address Book and Calls menu 
item to display both the Address Book and the Current 
Calls.

A bullet symbol (•) appears beside the current 
selection.

For more information, refer to the following topics:

■ Current Calls icons on page 69

■ Current Calls toolbar on page 71
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Current Calls icons

Current Calls icons appear in the Calls and Conference 
boxes to show you the status of your calls.

Note: Different versions of these icons are used in the 
Calls menu and task tray menu. For more information, 
refer to The task tray menu on page 56.

Current Calls icons (page 1 of 2)

Icon Call Status Description

Ringing Appears in the Calls box 
beside the calls that are 
currently ringing.

Active Call Appears in the Calls box 
beside the call you are 
currently on.

Held Call Appears in the Calls box 
beside calls that are on hold. 

Conference 
Call

Appears in the Conference 
box beside calls that are part 
of a conference.

Held Confer-
ence Call

Appears in the Conference 
box beside conference calls 
that are on hold.
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Extension In 
Use

Appears in the Calls box for 
calls made on other tele-
phones using your line. See 
page 73.

Current Calls icons (page 2 of 2)

Icon Call Status Description
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Current Calls toolbar

You manage the calls in the Calls box and the Conference 
box using the toolbars above them. The toolbar buttons 
are briefly described below. 

Current Calls Toolbar (page 1 of 2)

Button Feature Description

Manual 
dial

Displays the Dial dialog box so 
that you can enter a phone 
number using the keyboard. 
This feature is useful for calling 
a number that is not in the 
Address Book.

Release 
Call

Hangs up the selected call.

Properties Displays the Address Proper-
ties dialog box for the selected 
caller and lets you add new 
callers to the Address Book.

Large 
Icons

Displays current calls as large 
icons. 

Small 
Icons

Displays current calls as small 
icons.
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List Displays current calls as small 
icons in vertical columns.

Report Displays current calls in a 
report view format. In this 
format the icon, the callers 
name, the telephone number 
and the call timer are 
shown.The call timer is a 
running count of how long the 
call has been connected.

Current Calls Toolbar (page 2 of 2)

Button Feature Description
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Extension in Use notification in Personal Call 
Manager

When someone is using one of your telephone 
lines on another telephone in your home or 
business, the Extension in Use icon (shown on 
the right) appears in the Calls box.

To join the call: 

■ right-click the call icon and click on the Unhold 
menu item, or

■ press ¬ for the line the call is on.
For more information, refer to Extension in Use 
notification on the telephone on page 41.
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Status bar

When visible, the Status bar appears at the bottom of the 
screen and provides three information message areas.

Help messages – Shows a help message, if available, for 
the area the mouse pointer is over. For example, if the 
mouse is over one of the buttons on the toolbar, the 
Status bar describes what that button does.

Line used – Identifies which TAPI line and which 
telephone line is being used by Personal Call Manager. 
(See page 433 for a definition of “TAPI”.) Also displays 
the progress of synchronization between the software 
and the telephone.

■ Default or Line 1 indicates that Line 1 will be used 
when you make calls from Personal Call Manager.

■ Line 2 indicates that Line 2 will be used when you 
make calls from Personal Call Manager.

DND – When the Don’t Disturb feature is enabled, 
“DND” appears in this area.

To show or hide the Status bar:

1 Click on the View menu.

2 Click on the Status Bar menu item. The Status bar 
appears or disappears depending on its previous set-
ting. When the Status bar is visible, a checkmark (✔) 
appears beside the Status Bar menu item.

Help messages Line used DND
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The About Personal Call Manager window

The About Personal Call Manager window shows the 
version of the Personal Call Manager software you are 
using. You will be asked to provide this information if you 
contact us for technical support.

To access the About Personal Call Manager window:

1 Click on the Help menu.

2 Click on the About PCM menu item.
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How the telephone and Personal Call 
Manager work together

There are four areas of functionality that are synchronized 
(or shared) between the 9617 telephone and Personal 
Call Manager:

1. The Options List and the Memory keys on the 
telephone and the 9617 Configuration Properties 
dialog box in Personal Call Manager

The Options List in the 9617 telephone allows you to set 
the same options as the 9617 Configuration Properties 
dialog box in Personal Call Manager. The changes you 
make in one place are automatically made in the other.

For example, you can program the telephone’s memory 
keys using the telephone itself or using Personal Call 
Manager. The changes you make in one are automatically 
made in the other. (For more on memory keys, see 
Memory keys and the M9617 telephone on 
page 146.)

If you change settings in the Options List when Personal 
Call Manager is not running, these changes are updated 
automatically when you start Personal Call Manager.

Some exceptions: The Pager Notification, Call Blocking 
and Ring Configuration options can only be set using 
Personal Call Manager.

continued...
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2. The Directory on the telephone and Quick Dials in 
Personal Call Manager

The telephone Directory and the Personal Call Manager 
Quick Dials folder synchronize. This means that Personal 
Call Manager and the 9617 telephone work together to 
keep the list of contacts stored in the telephone Directory 
the same as the list stored in the Quick Dials folder.

Normally, the 9617 telephone Directory and the Quick 
Dials folder in Personal Call Manager are identical. 
Differences can arise when:

■ contacts are added to the Personal Call Manager 
Quick Dials folder while the 9617 telephone is 
unplugged or not connected to the computer; or

■ contacts are added to the 9617 telephone Directory 
when Personal Call Manager is not running.

When there are differences between the two lists, you 
must choose between them which one you want to keep. 
You cannot automatically combine the two lists. The 
Startup Synchronization setting you choose determines 
which list – the telephone Directory or the Quick Dials 
folder – is kept. If you want to manually combine the two 
lists, you can choose not to synchronize them. For more 
information, refer to Changing the Startup 
synchronization setting on page 134.

continued...
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3. The Callers List and Redial List

When Personal Call Manager starts, it compares the call 
lists in the 9617 telephone and in the program. If there 
are differences (if you have made or received a call when 
Personal Call Manager wasn’t running), Personal Call 
Manager updates its Callers List, Redial List and Calls Log 
Window.

4. Call Control (making, answering and holding calls)

You can do common call control operations such as 
hanging up a telephone call using either the 9617 
telephone or Personal Call Manager. For example, to end 
a call, you can press ® on the telephone or click on the 
Release menu item in Personal Call Manager.
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Setup and customization
You can customize the way the 9617 telephone and 
Personal Call Manager manage calls. You can also add 
passwords, dialing restrictions, personal security numbers 
and more.

For more information, refer to the following topics:

■ Setting up the M9617 telephone on page 80

■ Setting up Personal Call Manager on page 123
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Setting up the 9617 telephone

There are two ways to customize the features of the 9617 
telephone. You can use the Options List in the telephone, 
or you can use the computer. 

You will find all the options in the telephone’s Options List 
in the 9617 Configuration Properties dialog box in 
Personal Call Manager. 

It doesn’t matter which method you choose. The changes 
you make in the telephone Options List are also made in 
the 9617 Configuration Properties dialog box, and vice 
versa.

Some exceptions: The Pager Notification, Call Blocking 
and Ring Configuration options can only be set using 
Personal Call Manager.

For more information, refer to the following topics:

■ Using the Options List to customize the M9617 
telephone on page 81

■ Using the computer to customize the M9617 
telephone on page 89
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Using the Options List to customize the 9617 
telephone

You can customize the 9617 telephone using the settings 
in the Options List. To view this list, press the Options key 
on the telephone. You may have to move the slider beside 
the telephone’s indicator light to the right to reveal the 
Options key. (To see where this key is located, refer to The 
M9617 telephone keys and lights on page 29.)

If an Options password has been set up, the telephone 
display prompts you to enter it (see Setting the Options 
password using the telephone on page 87). 

Once you have entered the password and accessed the 
list, the following appears on the 9617 telephone display:

Options List=26
Use ÏÔ to view

The number 26 refers to the number of features (or 
settings) you can customize. Use ª on the 
telephone to scroll through the list of options.

For more information, refer to The telephone Options 
List.
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The telephone Options List

The 9617 telephone Options List  (page 1 of 5)

Use this option... to do this...

01. Language 
choice

Choose the language you want 
to see on the telephone display. 
You can choose English, French 
or Spanish. See page 20.

02. Time/Date Set the date and time on your 
telephone display. See page 21.

03. Line x is prime Choose which of your two lines 
is the prime line. See page 240.

04. Pick ring tone Select one of four ring tones for 
Line 1 or Line 2. You can pick a 
different ring tone for each line. 
See page 51.

05. Live dialpad 
OFF (ON)

Turn the live dialpad option on or 
off. When this option is on, 
numbers are dialed out as you 
enter them. When this option is 
off, the numbers you enter are 
not dialed out until you lift the 

handset or press ∂, 

© or a line key. See 
page 239.
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06. Clear Msg. 
Wtg.

Clear the Message Waiting 
display prompt when you have 
finished listening to your Voice 
Mail messages. See page 47.

07. Change 
CALLERS

Specify for each line whether the 
Callers List logs all calls, no calls 
or only unanswered calls. See 
page 336.

08. Call wait ID Turn the display of Call Waiting 
ID on or off. If you turn Call Wait 
ID off, you will only hear the Call 
Waiting tone when you receive a 
Call Waiting call. You must 
subscribe to Call Waiting from 
your telephone company. See 
page 268.

09. Set list mode Specify that the Callers List for 
both lines be combined or sepa-
rate. See page 338.

10. Fax switch OFF 
(ON)

Turn the Fax switch on or off. See 
page 387.

11. Change Answer Specify which line is answered 
when both are ringing and you 
lift the handset or press 

©. See page 270.

The 9617 telephone Options List  (page 2 of 5)

Use this option... to do this...
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12. Headset 
disabled 
(enabled)

Use a headset instead of the 
handset to speak on the tele-
phone. See page 238.

13. Check line 
cord

Specify for each line whether or 
not your telephone checks to 
ensure the line cord is 
connected. The telephone 
displays a message when a line 
cord is not connected. See 
page 48.

14. Area codes Enter area codes that you don’t 
want to appear in the Callers List 
or on the telephone display. See 
page 375.

15. Restrictions Prevent certain numbers from 
being dialled out. See page 378.

16. Overrides Specify up to three numbers to 
override the dialing restrictions 
you have entered into the 
Restrictions option. See 
page 381.

17. Security 
numbers

Prevent certain numbers such as 
passwords or Calling Card 
Numbers from being displayed 
on your telephone when you dial 
them. See page 383.

The 9617 telephone Options List  (page 3 of 5)
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18. Call timer ON 
(OFF)

Enable the automatic display of 
the call timer, which shows how 
long you have been on a call. See 
page 365.

19. Don’t dsturb 
OFF (ON)

Stop or prevent the ringing of 
your telephone. See page 323.

20. Timer key Program the Call timer option 
into a memory key. When you 
press the Timer key, the Call 
timer appears on the telephone 
display. See page 366.

21. Don’t dsturb 
key

Program the Don’t disturb option 
into a memory key. When you 
press the memory key, the option 
turns off or on, depending on 
what it was set to when you 
pressed it. See page 325.

22. Busy redial 
key

Program the Busy redial option 
into a memory key. When you 
press the memory key, the option 
is activated or deactivated. See 
page 371.

23. Busy retry 
delay

Specify the time between auto-
matic busy redial attempts. See 
page 372.

The 9617 telephone Options List  (page 4 of 5)
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24. Busy attempts Specify the number of auto-
matic Busy redial attempts. See 
page 373.

25. Options 
password

Enter a password to restrict 
access to the Options List. See 
page 87.

26. Versions View the version of firmware 
(resident software) your tele-
phone uses. You may be asked 
to provide this information if you 
contact the Aastra customer 
support line.

The 9617 telephone Options List  (page 5 of 5)

Use this option... to do this...
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Setting the Options password using the 
telephone

You can enter a password to prevent others from viewing 
or changing your Options List.

To enter or change an Options List password: 

1 Press the Options key.

2 Enter the old Options password if one has been set.

3 Use ª to scroll to option number 25 or press 
¤ fi.

4 Press •.

5 Enter your password (6 digits maximum).

6 Press ß.

7 Press ® . 

For more information, refer to the following topics:

■ Using the backdoor feature to access the 
Options list on page 88

■ Setting the Options Password using Personal 
Call Manager on page 108
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Using the backdoor feature to access the 
Options list

If you have forgotten your Options password, you can still 
access the Options list by using the backdoor password. 
The backdoor password is simply the month, day and 
hour (based on a 24-hour clock) displayed on your 
telephone display. 

For example, if the display shows MAY 09 10:30AM, the 
backdoor password is 050910 (05 for the month, 09 for 
the day, and 10 for the hour). 

If the display shows Feb 25 3:55PM the backdoor password 
is 022515 (02 for the month, 25 for the day and 15 for 
the hour).

Once you are in the Options List, you can view or change 
your Options password.

Note: The backdoor feature does not work for accessing 
the 9617 Configuration Properties dialog in Personal 
Call Manager.

For more information, refer to Setting the Options 
password using the telephone on page 87.
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Using the computer to customize the 9617 
telephone

The 9617 Configuration Properties dialog box allows 
you to customize the features of the 9617 telephone 
using your computer.

You can access this dialog box several ways. For more 
information, refer to the following topics:

■ Customizing the telephone using the menu bar 
or toolbar on page 90
89



Customizing the telephone using the menu 
bar or toolbar

To customize your telephone features:

1 Click on the Tools menu.

2 Click on the Dial Using menu item.
The Choose a TAPI Line dialog box appears.

3 Click on the Configure Line button.

4 If required, type the Options List password.

5 Click on the OK button. The 9617 Configuration 
Properties dialog box appears.

Tip: Instead of doing steps 1 to 5, click on the 
Configure Telephony button (shown on the 
right) on the toolbar. 

Note: You may also be able to access this dialog box 
from other TAPI applications.

continued...
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6 Move to the tab that has the feature or setting you 
want to change. For more information on the features 
of each tab, refer to The M9617 Configuration 
Properties dialog box on page 92.

The settings you specify on the Configuration Prop-
erties dialog box are made in the Options List of the 
telephone automatically.

7 Customize the settings as desired.

8 Click the Apply button to apply your settings.

9 If desired, move to another tab and repeat steps 7 and 
8.

10 When you are finished, click on the OK button.
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The 9617 Configuration Properties dialog 
box

To see how to access this dialog box, refer to Using the 
computer to customize the M9617 telephone on 
page 89.

The 9617 Configuration Properties dialog box consists 
of six tabs. Each tab groups together related features. 
These tabs include all of the features in the telephone’s 
Options List. The settings you specify in this dialog box are 
stored in the telephone’s Options List automatically.

Note: There are a few exceptions. The Pager Notification, 
Call Blocking and Ring Configuration options can only be 
set using Personal Call Manager, although these settings 
are still stored in the telephone itself.

For more information, refer to the following topics:

■ The Line tab on page 93

■ The General tab on page 95

■ The Phone Display tab on page 99

■ The Feature tab on page 101

■ The Security tab on page 106

■ The Memory Keys Assignment tab on page 110
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The Line tab

This tab on the 9617 Configuration Properties dialog 
box allows you to specify line features for both Line 1 and 
Line 2 independent of each other.

For information on how to access this dialog box, refer to 
Using the computer to customize the M9617 
telephone on page 89.

Options For – Select the telephone line (Line 1 or Line 2) 
you want to set options for. The settings (listed in detail 
below) that you make on this tab only affect the line that 
is selected when you make them.

Enable Line Cord Check – With this option enabled, the 
9617 telephone checks to ensure that your telephone 
lines are connected properly. If a line cord is not 
connected properly, is malfunctioning, or is not present, 
the 9617 telephone displays the “Check line cord” 
message.

Enable Pager Notification – This option enables the 
Pager Notification feature. When this feature is enabled, 
the telephone numbers of the incoming calls you specify 
are forwarded to the pager number you have specified on 
the Feature tab. Refer to Sending your calls to your 
pager on page 306.

Note: The Pager Notification option is not visible in the 
9617 telephone Options List. However, it still works when 
Personal Call Manager is not running or the computer is 
off.

continued...
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The Line tab (continued)

Ring Volume – This slider determines the ring volume of 
the phone.

Ring Tone – Select from one of four ring tones for the 
phone. Setting different tones for each line can help you 
identify which line incoming calls are on.

Call Waiting ID – This option enables the display of Call 
Waiting ID. If you subscribe to Call Waiting ID from your 
local telephone company, turn this option on to have Call 
Waiting ID appear on the 9617 telephone and in the You 
have a new call dialog box in Personal Call Manager. If 
you do not subscribe to this service, turn this option off. 
(The name of this service may vary from area to area.)

Callers Display – This option determines which calls are 
logged in the Callers List. You can select All Calls, No 
Calls, or Unanswered Calls. If you are going to use the 
Pager feature, you must set up the Callers List in a 
particular way. For more information, refer to About the 
Callers List and the Pager feature on page 337 and 
Sending your calls to your pager on page 306.
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The General tab

This tab on the 9617 Configuration Properties dialog 
box allows you to specify general telephone features.

For information on how to access this dialog box, refer to 
Using the computer to customize the M9617 
telephone on page 89.

Enable Headset – Select this option if you are going to 
attach a headset to the 9617 telephone.

Enable Fax Switch – Enabling this option is one of the 
steps you must complete to allow the 9617 telephone to 
route fax or modem calls to the fax machine or modem 
connected to Jack 2. For more information on setting up 
this feature, refer to Connecting a fax machine or 
modem to the telephone on page 387.

Enable Live Dialpad – With Live Dialpad enabled, the 
9617 telephone begins dialing as soon as you enter a 
number on the keypad. If this option is not selected, the 
telephone does not dial the telephone number you have 
entered until you lift the handset or press ∂, 
©, or ¬.

Enable Call Timer – When this option is selected, a timer 
appears on the 9617 telephone display for incoming and 
outgoing calls. If this option is not selected, the timer 
does not appear; however, call times still appear in the 
Calls Log Window in Personal Call Manager and in the 
Report view of the Calls and Conference boxes.

continued...
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The General tab (continued)

Set List Mode to be – This option determines how 
callers are tracked; callers can be split by line, or 
combined into a single list.

Note: List Mode affects only the Callers List on the 9617 
telephone, not on Personal Call Manager. The Personal 
Call Manager Callers List is always combined.

Set Prime Line to be – This option sets the default line 
for the 9617 telephone. The prime line is the line that is 
activated when you pick up the handset.

Set Language to be – The language for the 9617 
telephone display can be set to English, French, or 
Spanish with this option.

Note: The Set Language to be option affects only the 
9617 telephone. You cannot change the language of 
Personal Call Manager.

Answer Preference – If both lines are ringing at the 
same time, this option determines which line is answered 
first when you pick up the handset or press  © 
on the telephone.

“Answer Longest” answers the line that has been ringing 
the longest. “Answer Prime” answers the line that has 
been designated the prime line (see the Set Prime Line 
to be option above).

continued...
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The General tab (continued)

Note: The following four features are not visible on the 
M9716 telephone Options List. However, they still work 
when Personal Call Manager is not running or the 
computer is off.

Suppress First Ring – Many of the 9617 telephone’s 
features require Caller Identification (Caller ID) 
information to work. (For example, see Block Private 
Call and Block Unknown Call, below.) However, Caller 
ID information isn’t received by the 9617 telephone until 
after the first ring.

When you enable the Suppress First Ring option, the 
9617 telephone does not ring until after it has received 
the Caller ID information. (While the telephone won’t 
ring, the line indicator light will flash and the call 
information will be displayed for a few moments before 
the phone rings). This allows you to more effectively 
screen your calls. (See Screening your telephone calls 
on page 312.)

Block Private Call – Enabling this option prevents the 
9617 telephone from ringing for all calls that have a 
Caller ID of “private.” Callers can request that their ID be 
listed as “private” by the telephone company. Blocked 
calls ring once, unless Suppress First Ring is enabled.

Block Unknown Call – Enabling this option prevents the 
9617 telephone from ringing for all calls that have a 
Caller ID of “unknown.” A caller is listed as “unknown” if 
the telephone company has no information for that caller. 
Blocked calls ring once, unless Suppress First Ring is 
enabled.

continued...
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The General tab (continued)

Special Ring for Long Distance – With this option 
enabled, the 9617 telephone sounds a special ring 
whenever you receive a long distance call. (Long distance 
calls ring once normally before the special ring is activated 
unless the Suppress First Ring option is enabled.)
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The Phone Display tab

This tab on the 9617 Configuration Properties dialog 
box allows you to set display options for the telephone.

For information on how to access this dialog box, refer to 
Using the computer to customize the M9617 
telephone on page 89.

Display Contrast – Drag the slider to increase or 
decrease the contrast of the phone’s display. Click on the 
Apply button to see the results of a new setting without 
exiting the 9617 Configuration Properties dialog box.

Area Codes – In some areas, the telephone company 
sends the area code of all local calls with the Caller ID 
information. However, you may not be able to dial local 
numbers using the Callers List in the telephone until you 
remove the area code from the number. If this is the case 
in your area, you can use the area code stripping feature.

When you enter an area code or prefix using this feature, 
your 9617 telephone removes that code or prefix from 
numbers stored in the telephone’s Callers List. 

For example, if you enter your area code into this option, 
all calls in your area code will appear in the Callers List 
with the area code stripped off (the area code appears in 
brackets after the number like this: 555-1234 (403)). 

continued...
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You can enter three separate area codes or prefixes, each 
up to seven digits long. 

Note: It is highly recommended that you enter your local 
area code in one of these three fields and in the Area 
Code field on the Dialing Properties dialog box. To 
access this dialog box, click on the Tools menu in 
Personal Call Manager and select the Dialing Properties 
menu item. For more information on Dialing Properties, 
refer to Specifying dialing properties for the location 
you are dialing from on page 125.

For more information on the Area Code feature and the 
telephone, refer to Stripping area codes from 
numbers in the telephone Callers List on page 375.
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The Feature tab

This tab on the 9617 Configuration Properties dialog 
box allows you to specify Automatic Busy Redial, Do Not 
Disturb and Pager Notification options.

For information on how to access this dialog box, refer to 
Using the computer to customize the M9617 
telephone on page 89.

For more information, refer to the following topics:

■ Do Not Disturb Options on page 102

■ Automatic Busy Redial Options on page 103

■ Pager Notification Options on page 104
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Do Not Disturb Options

When the Do Not Disturb (DND) option is enabled, the 
telephone does not ring when someone calls. 

However, the line indicator (the light beside the line key 
on the telephone) still flashes. In Personal Call Manager, 
the You Have a New Call dialog box still appears and 
the Ringing icon for the call appears in the Calls box.

Although the telephone does not ring, you can still 
answer the call.

Enable DND – Select this option on the Feature tab to 
enable Do Not Disturb for the telephone. 

When this option is enabled:

■ the message “Don’t disturb ON” appears on the dis-
play of the telephone

■ the Don’t Disturb icon (shown on the right) 
appears in the task tray on your computer

■ “DND” appears on the Status Bar of Per-
sonal Call Manager

Remember to turn this option off when you want the 
telephone to ring normally when you receive a call.

For information on how to access this dialog box, refer to 
Using the computer to customize the M9617 
telephone on page 89.

For information about this feature, refer to The Don’t 
Disturb feature on page 322.
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Automatic Busy Redial Options

When you make a call and get a busy signal, you can use 
the Busy Redial feature to continue calling that number 
automatically until your call gets through. 

You can set two of the Automatic Busy Redial Options 
using this tab. The options are briefly described below. For 
more information on how to set up this feature, refer to 
Redialing busy telephone numbers automatically on 
page 370.

Number of Tries – This option on the Feature tab sets 
how many times the 9617 telephone will redial a busy 
number automatically, if Autobusy Redial has been 
enabled. The maximum number of tries is 15.

Delay in Seconds between Tries – This option on the 
Feature tab sets the delay between tries, in seconds, for 
the Auto Busy Redial. The maximum delay you can specify 
is 99 seconds.

For information on how to access this dialog box, refer to 
Using the computer to customize the M9617 
telephone on page 89.
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Pager Notification Options

If you have selected the Enable Pager Notification 
option on the Line tab of this dialog box, you should 
enter settings for the following options on the Feature 
tab. For information on how to access this dialog box, 
refer to Using the computer to customize the M9617 
telephone on page 89. Also refer to Sending your calls 
to your pager on page 306.

Pager Number – Enter the pager number that Caller ID 
information should be forwarded to.

Pager Delay in Seconds – The pager delay is the time 
between when the 9617 telephone dials your pager 
number, and when your pager service can accept the 
incoming caller’s number. Enter the length of this delay in 
this box. 

For example, when the 9617 telephone dials your pager 
number, there may be three telephone rings followed by a 
message from your pager service. In this case, you would 
add a few seconds to the time it takes for the three rings 
and the message to play. If it takes 15 seconds for the 
three rings and the message, your pager delay would be 
17 seconds.

Pager On Time – Enter the time that the pager is turned 
on. Before this time, Caller ID information will not be 
forwarded to the pager.

Pager Off Time – Enter a time that the pager is turned 
off. After this time, Caller ID information will not be 
forwarded to the pager.

continued...
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Note: If you want the pager feature to be on all the time, 
set both the Pager On Time and Pager Off Time to 12:00 
PM.
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The Security tab

This tab configures the security options for the 9617 
telephone.

For information on how to access this dialog box, refer to 
Using the computer to customize the M9617 
telephone on page 89.

Security Number Settings – The 9617 is equipped with 
a Security Numbers feature to keep selected numbers 
private when you dial. When you have entered a security 
number using this option, your telephone does not 
display or store the digits that you dial after that security 
number. Instead, the numbers that follow the security 
number are replaced with the * symbol on the display. 
You can secure up to three numbers, each up to 12 digits 
long. This feature is useful, especially for keeping 
numbers like your Voice Mail password private.

Restricted Number Settings – Dialing Restrictions are 
used to prevent certain numbers from being dialed out. 
You can enter up to three dialing restrictions, each up to 7 
digits long. If you attempt to dial a number that matches 
the restricted digits, the message Restricted number 
appears on the telephone display.

For example, if you entered the codes 0, 1, and 411, any 
number beginning with 0, 1 or 411 could not be dialed 
from the telephone. However, the number 555-0411 
could be dialed because it does not begin with any of the 
restricted numbers.

continued...
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The Security tab (continued)

Important: Care must be taken when you are restricting 
numbers that start with 9. If you enter 9, 91, or 911 as 
one of the dialing restrictions, you will not be able to dial 
the emergency services number 911. To make sure this 
doesn’t happen, you can enter 911 as a dialing restriction 
override. For more information, refer to “Override 
Settings” below.

Override Settings – Dialing Restrictions are used to 
prevent certain numbers from being dialed out. You can, 
however, program three Override numbers to override the 
restricted numbers feature.

For example, if you entered the 0, 1, and 411 as restricted 
numbers, any number beginning with 0, 1 or 411 could 
not be dialed from the telephone. However, if you 
entered 1800 as an override number, you could dial the 
number 1-800-555-5555 even though it begins with 1.

You can program up to three overrides, each up to twelve 
digits long. For more information, refer to Overriding 
dialing restrictions on page 381

Option List Password – You can enter a numeric 
password that will be needed to open the TAPI Line 
Configuration dialog box and to access the Options List 
on the 9617 telephone. The current password appears in 
the Existing Password field. If there is no current 
password, this field is blank. For more information, refer 
to Setting the Options Password using Personal Call 
Manager on page 108.
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Setting the Options Password using Personal 
Call Manager

To change the existing Options List password:

1 Click on the Configure Telephony button on 
the toolbar (shown on the right). The 9617 
Configuration Properties dialog box 
appears.

2 Select the Security tab.

3 If no password exists, click on the Disable Password 
box until the checkmark does not appear inside it. If a 
password exists, skip to step 4.

4 Enter a new numeric password in the Enter New 
Password field. 

Note: The password must be numeric. Do not enter 
letters.

5 Enter the new password again in the Confirm New 
Password field. 

6 Click on the Apply button. A dialog box appears con-
firming that the password has been changed. (Click 
the OK button to close the dialog box.)

To remove a password:

1 On the Security tab, click on the Disable Password 
box until a checkmark appears inside it.

2 Click on OK or Apply. The password is deleted.
(If you close and then reopen the dialog box, the pass-
word will no longer appear.)

continued...
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For more information, refer to the following topics:

■ Setting the Options password using the tele-
phone on page 87

■ Using the backdoor feature to access the 
Options list on page 88
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The Memory Keys Assignment tab

This tab on the 9617 Configuration Properties dialog 
box allows you to assign phone numbers and features to 
memory keys. 

For information on how to access this dialog box, refer to 
Using the computer to customize the M9617 
telephone on page 89.

You can also use the telephone to assign phone numbers 
and features (except for the Application feature) to 
memory keys. If numbers or features have already been 
entered using the phone, they will appear here.

The list of features you can program into a memory key is 
given below.

Memory Key Feature List (page 1 of 2)

Feature Description

Empty Clears the memory key (leaving it 
empty).

Do Not 
Disturb

Assigns the Do Not Disturb (DND) 
option to the memory key. Pressing this 
key turns DND on or off. When DND is 
on, the 9617 telephone does not ring 
when you receive a call (unless the call 
is from a contact that has been set to 
the Always Ring option.)

Auto Busy 
Redial

Assigns the Auto Busy Redial feature to 
the memory key.
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For more information, refer to the following topics:

■ Clearing a memory key on page 113

■ Assigning the Do Not Disturb feature to a 
memory key on page 114

continued...

Timer Assigns the Call Timer to the memory 
key.

Application Assigns an application to the memory 
key. When you press the memory key 
the application stored in the memory 
key launches. Launch Pad must be 
running. For more information, refer to 
The Launch Pad application on 
page 394

Phone 
Number

Assigns a contact’s telephone number 
to a memory key. Whey you press this 
key, the number is dialed.

Feature Light 
On

Assigns a feature code provided by the 
telephone company to a memory key. 
When you press this key, the 9617 tele-
phone dials the code and turns the 
feature light on.

Feature Light 
Off

This feature turns off a feature code 
provided by the telephone company, 
and turns the 9617 telephone feature 
light off.

Memory Key Feature List (page 2 of 2)
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■ Assigning the Auto Busy Redial feature to a 
memory key on page 115

■ Assigning the Call Timer feature to a memory 
key on page 116

■ Assigning an application to a memory key on 
page 117

■ Assigning a phone number to a memory key 
using Personal Call Manager on page 119

■ Programming a memory key as a FeatureLight 
On or Off key using Personal Call Manager 
on page 121

■ Labeling memory keys on page 150
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Clearing a memory key

To clear or delete a memory key:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure Line button. (If required, type 
the Options List password and click on the OK but-
ton.) The 9617 Configuration Properties dialog box 
appears.

Tip: You can also display this dialog box by 
clicking on the Configure Telephony button 
(shown on the right) on the toolbar.

4 Click on the Memory Keys Assignment tab.

5 Click on the radio button that corresponds to the key 
you want to clear.

6 Select Empty from the Feature droplist.

7 Click on the Apply button and then click on the OK 
button to close the dialog box.

For more information, refer to Deleting memory keys 
on page 152.
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Assigning the Do Not Disturb feature to a 
memory key

To assign Do Not Disturb to a memory key:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure Line button. (If required, type 
the Options List password and click on the OK but-
ton.) The 9617 Configuration Properties dialog box 
appears.

Tip: You can also display this dialog box by 
clicking on the Configure Telephony button 
(shown on the right) on the toolbar.

4 Click on the Memory Keys Assignment tab.

5 Click on the radio button that corresponds to the key 
you want to program.

6 Select Do Not Disturb from the Feature droplist.

7 Click on the Apply button and then click on the OK 
button to close the dialog box.

For more information, refer to The Don’t Disturb 
feature on page 322.
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Assigning the Auto Busy Redial feature to a 
memory key

To assign Auto Busy Redial to a memory key:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure Line button. (If required, type 
the Options List password and click on the OK but-
ton.) The 9617 Configuration Properties dialog box 
appears.

Tip: You can also display this dialog box by 
clicking on the Configure Telephony button 
(shown on the right) on the toolbar.

4 Click on the Memory Keys Assignment tab.

5 Click on the radio button that corresponds to the key 
you want to program.

6 Select Auto Busy Redial from the Feature droplist.

7 Click on the Apply button and then click on the OK 
button to close the dialog box.

For more information, refer to Redialing busy 
telephone numbers automatically on page 370.
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Assigning the Call Timer feature to a 
memory key

To assign the Call Timer to a memory key:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure Line button. (If required, type 
the Options List password and click on the OK but-
ton.) The 9617 Configuration Properties dialog box 
appears.

Tip: You can also display this dialog box by 
clicking on the Configure Telephony button 
(shown on the right) on the toolbar.

4 Click on the Memory Keys Assignment tab.

5 Click on the radio button that corresponds to the key 
you want to program.

6 Select Timer from the Feature droplist.

7 Click on the Apply button and then click on the OK 
button to close the dialog box.

For more information, refer to Timing the length of 
your calls on page 364.
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Assigning an application to a memory key

To assign an application to a memory key:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure Line button. (If required, type 
the Options List password and click on the OK but-
ton.) The 9617 Configuration Properties dialog box 
appears.

Tip: You can also display this dialog box by 
clicking on the Configure Telephony button 
(shown on the right) on the toolbar.

4 Click on the Memory Keys Assignment tab.

5 Click on the radio button that corresponds to the key 
you want to program.

6 Select Application from the Feature droplist.

7 Click on the Configure button. The Application Key 
dialog box appears.

8 Enter the name of the memory key in the Name field. 

9 Enter the path and name of the application.
OR
If you do not know the path and name, click on the 
Browse button. The Select the Application to Exe-
cute dialog box appears. Locate and select the pro-
gram file (the .exe file) and then click on the Open 
button.

continued...
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10 Select the Run Launch Pad at startup option if you 
want the Launch Pad application to launch at startup. 
Note that Launch Pad must be running for the applica-
tion memory key to work. A check mark appears in 
the checkbox when this option is selected.

11 Click on the OK button.

12 Click on the Apply button and then click on the OK 
button to close the dialog box.

For more information, refer to The Launch Pad 
application on page 394.
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Assigning a phone number to a memory key 
using Personal Call Manager

To assign a phone number to a memory key:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure Line button. (If required, type 
the Options List password and click on the OK but-
ton.) The 9617 Configuration Properties dialog box 
appears.

Tip: You can also display this dialog box by 
clicking on the Configure Telephony button 
(shown on the right) on the toolbar.

4 Click on the Memory Keys Assignment tab.

5 Click on the radio button that corresponds to the key 
you want to program.

6 Select Phone Number from the Feature droplist.

7 Click on the Configure button. The Phone Number 
dialog box appears.

8 Enter the name of the contact.

9 Enter the phone number of the contact. Be sure to 
enter any digits required for dialing.

10 Select the Always Ring option if you want the tele-
phone to ring when this contact calls even if you have 
turned on the Do Not Disturb (DND) feature.

11 Select the Never Ring option if you don’t want the 
telephone to ring when this contact calls.

continued...
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12 Select the Special Ring option if you want to hear a 
special ring when this contact calls.

13 Select the Pager Notification option if you want the 
Caller ID for this contact to be sent to your pager even 
if you have disabled the Pager Notification option. For 
more information on the pager feature, refer to Send-
ing your calls to your pager on page 306.

14 Click on the OK button.

15 Click on the Apply button and then click on the OK 
button to close the dialog box.

For more information, refer to Memory keys and the 
M9617 telephone on page 146.
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Programming a memory key as a 
FeatureLight On or Off key using Personal 
Call Manager

Some custom calling features require a unique On code 
and a unique Off code. Other features use the same code 
for On and Off. (You may have to subscribe to your 
telephone company for Custom Calling Features. Contact 
your telephone company for the appropriate feature 
codes.)

Features that have unique On and Off codes must be 
stored in two feature keys. The On feature key stores the 
On feature code, and the Off feature key stores the Off 
code. Features that use the same code for both On and 
Off only need to be stored in one feature key.

To save a FeatureLight ON or OFF code:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure Line button. (If required, type 
the Options List password and click on the OK but-
ton.) The 9617 Configuration Properties dialog box 
appears.

Tip: You can also display this dialog box by 
clicking on the Configure Telephony button 
(shown on the right) on the toolbar.

4 Click on the Memory Keys Assignment tab.

5 Click on the radio button that corresponds to the key 
you want to program.

continued...
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6 Select FeatureLight On or FeatureLight Off from 
the Feature droplist.

7 Click on the Configure button.

8 Enter the Feature On or Off code. (Contact your tele-
phone company for the appropriate feature codes.)

9 Click the OK button.

10 Click on the Apply button and then click on the OK 
button to close the dialog box.

For more information, refer to Saving a Feature On or 
Off Code using the telephone on page 358.
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Setting up Personal Call Manager

Before you can use Personal Call Manager, you must 
choose the TAPI line it will use and define the dialing 
properties for your location.

For more information, refer to the following topics:

■ Specifying the TAPI line used by Personal Call 
Manager on page 124

■ Specifying dialing properties for the location 
you are dialing from on page 125

■ Personal Call Manager preferences on page 127
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Specifying the TAPI line used by Personal 
Call Manager

A TAPI line is not a physical telephone line; it is a piece of 
software your computer uses to interface with the 
telephone. The TAPI line designed for Personal Call 
Manager is called “9617.” You must select this TAPI line if 
you want the telephone to work with Personal Call 
Manager.

Other TAPI lines available on your computer may not work 
with the 9617 telephone.

To specify the TAPI line used by Personal Call Man-
ager:

1 Click on the Tools menu.

2 Click on the Dial Using menu item.
The Choose a TAPI Line dialog box appears.

3 Click on the drop list arrow beside Address.

4 Choose the telephone line you want Personal Call 
Manager to use as a prime line. You can choose Line 
1, Line 2 or Default. If you choose Default or Line 1, 
Personal Call Manager will use Line 1. If you choose 
Line 2, Personal Call Manager will use Line 2.

5 Click on the drop list arrow next to the TAPI Line field.

6 Click on the 9617 item.

Note: You can set your telephone options by 
configuring this TAPI line. For more information, refer 
to Using the computer to customize the M9617 
telephone on page 89.)

7 Click on the OK button.
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Specifying dialing properties for the location 
you are dialing from

Microsoft® Windows® provides a Dialing Properties 
dialog box that Personal Call Manager uses to let you 
specify dialing requirements unique to your location. For 
example, you may specify your geographic location, area 
code, or the calling card you want to use.

You use this dialog box to create a new dialing location, 
select a dialing location and delete a dialing location.

Note: Personal Call Manager uses the same dialing 
properties for both lines.

To change the dialing properties for a location:

1 Click on the Tools menu.

2 Click on the Dialing Properties menu item.
The Dialing Properties dialog box appears.

3 Make changes as required. You can view context-sen-
sitive help for items on this dialog box by pressing F1. 
For more information, refer to The Dialing Proper-
ties dialog box on page 126.

If you don’t want to use the dialing properties

You can choose not to use the dialing properties specified 
on this dialog box. For more information, refer to The 
Dialing Rule Setting on page 132.
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The Dialing Properties dialog box

The Dialing Properties dialog box is a Microsoft® 
Windows® feature which allows you to specify dialing 
information for your current location.

The dialing properties you can specify for a location 
include:

■ the country you are in

■ your area code

■ dialing rules determining which telephone numbers 
are local and which are long distance

■ numbers needed for accessing outside lines

■ calling card specifications

■ the code that must be dialled before a phone number 
to disable Call Waiting for that call

■ whether you have pulse or tone dialing service

You can press F1 to view context-sensitive help for items 
on this dialog.

If you have any questions about this dialog box, 
refer to Microsoft® Windows® documentation. You 
can also contact the Microsoft Support Network.
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Personal Call Manager preferences

The Personal Call Manager Preferences dialog box allows 
you to specify how the search feature works, whether the 
main window is open or minimized on startup, whether 
dialing rule settings are used and the startup 
synchronization setting for the telephone Directory and 
the Quick Dials folder.

For more information, refer to the following topics:

■ Search preferences on page 128

■ The Startup Option on page 130

■ The Dialing Rule Setting on page 132

■ Changing the Startup synchronization setting 
on page 134
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Search preferences

The Search feature operates in one of two different 
modes: Slow Search and Fast Search. 

In Slow Search mode, you enter the characters you want 
to find and then click on the Find Now button. Personal 
Call Manager then searches through the Address Book to 
find the characters you entered. 

In Fast Search mode, Personal Call Manager starts 
searching through the contacts as soon as you enter 
characters.

For more information, refer to Changing the Search 
mode on page 129.
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Changing the Search mode

To change the Search mode:

1 Click on the Tools menu.

OR

Right-click on the Personal Call Manager icon in the 
task tray. (See The task tray icon on page 55.)

2 Click on the Preferences menu item. The Prefer-
ences dialog box appears.

3 On the Options tab, click on the search option you 
want to use.

4 Click on the OK button.

For more information, refer to Search preferences on 
page 128.
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The Startup Option

The Startup Option determines whether the main 
window is open or minimized when you start Personal 
Call Manager.

In either case, you can still manage calls using Personal 
Call Manager. 

When the main window is open, you can use all the 
features of Personal Call Manager. 

When the main window is minimized, you manage calls 
using the task tray menu. 

To view the tasktray menu when the main window is 
minimized, click on the Personal Call Manager icon in the 
task tray (see The task tray icon on page 55).

For more information, refer to Changing the Startup 
Option on page 131.
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Changing the Startup Option

To change the Startup Option:

1 Click on the Tools menu.

OR

Right-click on the Personal Call Manager icon in the 
task tray. (See The task tray icon on page 55.)

2 Click on the Preferences menu item. The Prefer-
ences dialog box appears.

3 Click on the Options tab if it is not already selected.

4 Click on the Startup Option you want to use.
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The Dialing Rule Setting

The Dialing Rule Setting determines whether Personal Call 
Manager uses the dialing properties entered in the 
Dialing Properties dialog box. This feature is enabled by 
default.

When the Dialing Rule Setting is on, Personal Call 
Manager uses dialing properties, such as the local area 
code and the outside line access code, when making a 
call. 

When the Dialing Rule Setting is disabled, Personal Call 
Manager does not use the dialing properties and you 
must manually enter any additional dialing information, 
such as the outside line access code.

For more information, refer to the following topics:

■ The Dialing Properties dialog box on page 126

■ Changing the Dialing Rule Setting on page 133.
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Changing the Dialing Rule Setting

To change the Dialing Rule Setting:

1 Click on the Tools menu.

OR

Right-click on the Personal Call Manager task tray 
icon. (See The task tray icon on page 55.)

2 Click on the Preferences menu item. The Prefer-
ences dialog box appears.

3 Click on the Options tab if it is not already selected.

4 Click on the Use Rules defined in the Dialing Prop-
erties Dialog checkbox to select or deselect it. A 
checkmark appears in the checkbox when it is 
selected.

For more information, refer to The Dialing Rule Setting 
on page 132.
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Changing the Startup synchronization 
setting

The Startup Synchronization Setting determines how the 
9617 telephone Directory and the Personal Call Manager 
Quick Dials folder are synchronized when the program is 
started.

When the telephone is plugged into the computer and 
Personal Call Manager is running, the 9617 telephone 
Directory and the Quick Dials folder in Personal Call 
Manager synchronize.

The two can become different if:

■ contacts are added to the Quick Dials folder while 
the telephone is unplugged or not connected to the 
computer

■ contacts are added to the telephone Directory when 
Personal Call Manager is not running

To change the Startup Synchronization Setting:

1 Click on the Tools menu.

2 Click on the Preferences menu item. The Prefer-
ences dialog box appears.

3 Click on the Startup Synchronization Setting tab.

4 Select the options you want. For a description of these 
settings, refer to Startup Synchronization settings 
on page 135.

For more information, refer to How the telephone and 
Personal Call Manager work together on page 76.
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Startup Synchronization settings

Make Quick Dials Folder the Same as Phone 
Directory

Choose this option if you want to copy the entire list of 
contacts in the telephone Directory to the Quick Dials 
folder. All Quick Dial contacts that are not stored in 
the telephone Directory will be deleted.

Make Phone Directory the Same as Quick Dials 
Folder

Choose this option if you want to copy the entire list of 
contacts in the Quick Dials folder into the telephone 
Directory. All contacts in the 9617 telephone 
Directory that do not appear in the Quick Dials 
folder will be deleted.

Note: The 9617 telephone Directory only stores one 
telephone number – the default telephone number – for 
each contact.

Do Not Synchronize

If you select this option, Personal Call Manager will not 
synchronize the Directory and Quick Dials folder at 
startup. 

However, any subsequent additions or deletions you 
make are still made in both the Quick Dials folder and 
the telephone Directory.

You can choose to fully synchronize the two at any 
time by clicking on the Synchronize button on the 
toolbar (shown on the right).

continued...
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Show Warning Dialog on Startup

If this option is selected (it is selected by default), a 
warning dialog box appears before the Directory and the 
Quick Dials are synchronized. This dialog box gives you 
the option of changing the synchronization setting, or not 
synchronizing at all.

If this option is not selected, the warning dialog box does 
not appear before synchronization begins. Personal Call 
Manager synchronizes the Directory and Quick Dials 
folder as specified on the Startup Synchronization 
Setting tab of the Preferences dialog box.

A checkmark appears in the checkbox if this option is 
selected.

Note: The name of a contact in the Directory may differ 
from the name that appears in the Quick Dials folder. 
This occurs when a contact entry with the same 
telephone number is stored in the Contacts folder with a 
different name. The name in the Quick Dials folder is 
always the same as the name in the Contacts folder.

For more information, refer to How the telephone and 
Personal Call Manager work together on page 76.
136



Storing your contacts
A contact is any entry (name, number, etc.) you have 
stored in your 9617 telephone or Personal Call Manager. 
By storing contacts, you can easily access them to make 
calls.

In your 9617 telephone, you store contacts in the 
Directory and/or in Memory keys. 

In Personal Call Manager, you store contacts in the 
Address book. The Address Book stores several phone 
numbers, the mailing address, the email address and 
personal notes for each contact name.

For more information, refer to the following topics:

■ Storing contacts in the M9617 telephone on 
page 138

■ The Address Book in Personal Call Manager on 
page 157
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Storing contacts in the 9617 telephone

You can store the name and one telephone number for 
up to 106 contacts – 100 in the Directory and one in each 
of the six memory keys – directly in your 9617 telephone.

For more information, refer to the following topics:

■ The telephone Directory on page 139

■ Memory keys and the M9617 telephone on 
page 146
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The telephone Directory

The 9617 stores the names and telephone numbers of up 
to 100 contacts in the Directory. You can dial these 
numbers by simply selecting them in the Directory.

Names are sorted alphabetically starting with their first 
character. (If you want your Directory sorted by the last 
name, enter the last name first.) If you do not enter a 
name, the item appears at the beginning of the Directory.

Note: When you press the ¢ key on the 
telephone, the Search dialog appears on the computer 
screen when Personal Call Manager is running.

For more information, refer to the following topics:

■ Adding a contact to the telephone Directory on 
page 140

■ Copying a contact from the Callers List, Redial 
List or a memory key to the Directory on 
page 141

■ Adding an active caller to the Directory on 
page 142

■ Editing the telephone Directory on page 143

■ Deleting contacts from the telephone Directory 
on page 144

■ Quick Dials and the M9617 Directory on 
page 145

■ Finding a contact in the telephone Directory on 
page 234
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Adding a contact to the telephone Directory

To add a new number and name:

1 Press ß.

2 Press ¢.

Note: When you press ¢, the Search dialog 
box appears on the computer screen if Personal Call 
Manager is running.

3 Enter the number using the dialpad. You can enter a 
maximum of 24 digits. To backspace and erase digits, 
press “. To add digits, use the dialpad.

Note: You can also save dialing pauses and links to 
network services in telephone numbers. For more 
information, refer to Programming dialing pauses 
and links in telephone numbers on page 175.

4 Press ß.

5 If you do not want a name, go to step 6. To enter a 
name, use the dialpad. (Refer to Entering Names on 
page 153.)

6 Press ß.

7 Press ®.

Note: You can also use the Quick Dials folder in Personal 
Call Manager to add a contact to the telephone Directory. 
For more information, refer to Quick Dials and the 
M9617 Directory on page 145.
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Copying a contact from the Callers List, 
Redial List or a memory key to the Directory

To save to the Directory:

1 Access a contact in the Callers List, Redial List or a 
memory key.

2 Press ß.

3 Press ¢. If the name was stored with the 
number, both are now saved in the Directory and you 
are finished.

4 If no name is displayed, you are prompted to enter 
one. If you don’t want a name, go to step 5. To enter a 
name, use the dialpad. (Refer to Entering Names on 
page 153.)

5 Press ß.

6 Press ®.

Note: When you press ¢, the Search dialog box 
appears on the computer screen (if Personal Call Manager 
is running).
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Adding an active caller to the Directory

To add an active caller:

1 Answer or make a call.

2 Press ß.

3 Press ¢. The name and/or number are saved 
in the Directory. 

You cannot save the name and number of conference 
callers using this method. Instead, wait until the 
conference call is ended, and use the Callers List or the 
Redial List. Refer to Copying a contact from the Callers 
List, Redial List or a memory key to the Directory on 
page 141 for more information.

Note: When you press ¢, the Search dialog box 
appears on the computer screen (if Personal Call Manager 
is running).
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Editing the telephone Directory

When you make changes to the Directory, the same 
changes are made to the Quick Dials folder in Personal 
Call Manager and vice versa.

To edit a number and/or name in the Directory:

1 Press ¢.

Note: When you press ¢, the Search dialog 
box appears on the computer screen (if Personal Call 
Manager is running).

2 Press – or ≠ to find the item you 
want to edit.

3 Press “ to start edit mode.

4 If you do not want to change the number, go to step 
5. To backspace and erase digits, press “. To 
add digits, use the dialpad.

5 Press ß.

6 If you do not want to change the name, go to step 7. 
To backspace and erase digits, press “. To 
add digits, use the dialpad. (For more information, 
refer to Entering Names on page 153.) 

7 Press ß. If you edit the wrong item or want 
to quit without saving changes, press ¢ or 
® before pressing ß.

8 Press ®.
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Deleting contacts from the telephone 
Directory

When you delete items from the Directory, the items are 
also deleted from the Quick Dials folder in Personal Call 
Manager (if the application is running).

To delete individual contacts:

1 Press ¢.

Note: When you press ¢, the Search dialog 
box appears on the computer screen (if Personal Call 
Manager is running).

2 Press ª to find the contact you want to 
delete.

3 Press ∑ twice.

4 Press ®.

To delete all contacts:

1 Press ¢.

2 Press ∑.

3 Press ∑ again to confirm deletion of the 
entire Directory.

4 Press ®.
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Quick Dials and the 9617 Directory

When Personal Call Manager starts, it compares the 
contacts in the 9617 telephone Directory and in the 
Personal Call Manager Quick Dials folder. If there are 
differences (if you have added a contact to the Directory 
on the 9617 telephone before turning on the computer, 
for example), Personal Call Manager synchronizes the lists 
based on the Startup Synchronization Setting.

For more information on how synchronization works, 
refer to Changing the Startup synchronization 
setting on page 134 and Startup Synchronization 
settings on page 135.

When you make changes to the Directory, the same 
changes are made to the Quick Dials folder in Personal 
Call Manager, and vice versa.

Note: Only the name and the default telephone number 
of each contact stored in the Quick Dials folder are 
copied to the telephone Directory.

For more information, refer to the following topics:

■ The Quick Dials folder on page 160

■ How the telephone and Personal Call Manager 
work together on page 76
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Memory keys and the 9617 telephone

You can save the name and telephone number of anyone 
you call frequently in any of the six memory keys on the 
9617 telephone. You can store more names and numbers 
in the Directory. Refer to The telephone Directory on 
page 139 for more information.

You can specify Ring Configuration features such as 
Always Ring, Never Ring, Special Ring and Pager 
Notification for contacts stored in memory keys. (You can 
also specify these features for the contacts stored in the 
Quick Dials folder.)

For more information, refer to the following topics:

■ Adding a contact to a memory key using the 
telephone on page 147

■ Copying a contact from the Callers or Redial 
List to a memory key on page 148

■ Adding a current caller to a memory key on 
page 149

■ Labeling memory keys on page 150

■ Editing memory keys on page 151

■ Deleting memory keys on page 152

■ Specifying Ring Configuration properties for 
contacts stored in memory keys on page 155

■ The Memory Keys Assignment tab on page 110

■ The Launch Pad application on page 394
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Adding a contact to a memory key using the 
telephone

To save a contact name and number:

1 Press ß.

2 Press the memory key you want to save the number 
into.

3 Enter the number using the dialpad. You can enter a 
maximum of 24 digits. To backspace and erase digits, 
press “. To add digits, use the dialpad.

Note: You can also save dialing pauses and links to 
network services in telephone numbers. For more 
information, refer to Programming dialing pauses 
and links in telephone numbers on page 175.

4 Press ß.

5 If you do not enter a name, go to step 6. To enter a 
name, use the dialpad. (For more information, refer to 
Entering Names on page 153.)

6 Press ß.

7 Label the memory key. (Refer to Labeling memory 
keys on page 150.)
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Copying a contact from the Callers or Redial 
List to a memory key

To copy a contact to a memory key:

1 Access a contact in the Redial List or Callers List.

2 Press ß.

3 Press the memory key you want to save the contact 
into. If the name was displayed with the number, both 
are now saved in the memory key and you’re finished.

4 If no name is displayed, you are prompted to enter 
one. If you don’t want a name, go to step 5. To enter a 
name, use the dialpad. (Refer to Entering Names on 
page 153.)

5 Press ß.

6 Label the memory key. (Refer to Labeling memory 
keys on page 150.)
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Adding a current caller to a memory key

To save an active caller:

1 Answer or make a call.

2 Press ß.

3 Press the memory key you want to save the contact 
into. If the name was displayed with the number, both 
are now saved in the memory key.

Note: Do not press ® or else you will hang up on your 
caller. You cannot save the Caller ID of callers in an active 
conference call. You must wait until the conference call is 
completed.
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Labeling memory keys

After programming a memory key, you should label it. 

To label a memory key:

1 Write the name of the contact stored in the memory 
key on one of the supplied blank paper labels.

2 Place the paper label on top of the memory key.

3 Push one of the supplied clear plastic key caps onto 
the memory key as shown below to hold the paper 
label in place.

Warning: Keep loose keys and the sliding panel 
away from small children.
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Editing memory keys

To edit the name and number stored in a memory key, the 
Live Dialpad option must be turned off. Refer to 
Selecting the dialpad option on page 239 for more 
information.

To edit a memory key:

1 To see its contents, press the memory key.

2 Press “.

3 Edit or delete the number. To backspace and erase dig-
its, press “. To add digits, use the dialpad. If 
you don’t want to change the number, skip to step 4.

4 Press ß. 

5 Edit or delete the name. To add letters, use the dial-
pad. To erase letters, press “. (Refer to 
Entering Names on page 153.) If you don’t want to 
change the name, skip to step 6.

6 Press ß.
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Deleting memory keys

The Live Dialpad option must be turned off to delete 
memory keys. Refer to Selecting the dialpad option on 
page 239.

To delete a memory key:

1 To see its contents, press the memory key.

2 To erase, press ∑ twice.

Exceptions

You can’t delete a memory key using the steps above if 
you have assigned a software application or the Don’t 
Disturb feature to it.

To delete a memory key linked to a software application, 
refer to Clearing a memory key on page 113.

To delete a memory key with the Don’t Disturb feature, 
refer to Deleting the Don’t Disturb key on page 326.
152



Entering Names

You can use the telephone dialpad to enter the names of 
contacts into the 9617 telephone. 

Before you can use the dialpad to enter a name, you must 
first save or edit a number in the Directory or memory key. 

After you have entered the telephone number, the 
telephone display prompts you to enter a name. To enter 
a letter, press the corresponding key on the dialpad until 
the letter you want appears. Once you see the character 
you want, wait two seconds for the cursor to shift to the 
right, or press ‘ . Repeat this process for the rest 
of the letters.To insert a space, press ‘. 

If you want to erase a letter (or a mistake), press 
“.

The first letter of each word is automatically capitalized. 
To display upper case letters elsewhere, press ˙, 
then press the appropriate dialpad key until you see the 
letter you want.

For example, to enter the name Ruth, press the following 
dialpad keys, waiting for 2 seconds where indicated: ‡ 
‡ ‡ [2 sec pause] ° ° [2 sec pause] ° [2 sec 
pause] › ›. 

For more information, refer to the following topic:

■ The characters each dialpad key can produce on 
page 154
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The characters each dialpad key can produce

You can use the 12 dialpad keys to enter names or words 
that appear in the Directory or a memory key in the 9617 
telephone.

Dialpad 
key Display characters it can produce

⁄ ,  -  ’  &  .  (  ) 1

¤ a  A  b  B  c  C  2

‹ d  D  e  E  f  F  3

› g  G  h  H  i  I  4

fi j  J  k  K  l  L  5

fl m  M  n  N  o  O  6

‡ p  P  q  Q  r  R  s  S  7

° t  T  u  U  v  V  8

· w  W  x  X  y  Y  z  Z  9

• *

‚ 0

£ #
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Specifying Ring Configuration properties for 
contacts stored in memory keys

You can specify Ring Configuration features for memory 
key contacts just as you can for the contacts stored in the 
Quick Dials folder. These features are described below.

Always Ring – When you select this option, you are 
overriding the Do Not Disturb setting for the contact 
stored in the memory key. (When you activate the Do Not 
Disturb (DND) feature, the telephone does not ring when 
you receive a call.) For more information, refer to 
Overriding DND for some contacts on page 329.

Never Ring – When you select this option for a contact 
stored in a memory key, the telephone does not ring 
when this contact calls. (Note that if you haven’t turned 
on the Suppress First Ring option, the telephone will ring 
once.) For more information, refer to Screening your 
telephone calls on page 312.

Special Ring – When you select a special ring for a 
contact stored in a memory key, you will hear a telephone 
ring that is different from the normal ring when this 
contact calls. (Note that if you haven’t turned on the 
Suppress First Ring option, the telephone will ring once 
normally.) For more information, refer to Screening your 
telephone calls on page 312.

Pager Notification – When you select this option for a 
memory key contact, the pager feature will work for this 
contact even if you disable pager notification on both of 
your telephone lines. For more information, refer to 
Pager Notification for Quick Dial and memory key 
contacts on page 310.

continued...
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A note about Quick Dials and memory keys

You can set ring configuration features for contacts 
stored in the telephone Directory or Quick Dials folder 
AND for contacts stored in memory keys. For more 
information, refer to About Ring Configuration 
settings for Quick Dials contacts on page 161.

If you store the same contact (i.e., the same telephone 
number) in the telephone Directory or Quick Dials folder 
AND a memory key, the ring configuration settings for the 
memory key take precedence.

To set the Ring Configuration for a memory key con-
tact:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure button. The 9617 Configura-
tion Properties dialog box appears.

4 Click on the Memory Keys Assignment tab.

5 Click on the memory key that stores the contact you 
want to override DND.

6 Click on the Configure button. A dialog box appears.

7 Select the checkboxes for the options you want to 
activate. When a checkbox is selected, a checkmark 
appears inside it.

8 Click the OK button on each dialog box to save your 
changes.
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The Address Book in Personal Call Manager

You store the telephone numbers and addresses of your 
contacts in the Address Book. A contact is normally the 
telephone number of a person or business, but can be 
any number you want to keep track of or store in Personal 
Call Manager. 

The Address Book has two views, the Tree View and the 
List View. Each view displays information in the address 
book differently.

For more information, refer to the following topics:

■ The Tree View section of the Address Book on 
page 158

■ The List View section of the Address Book on 
page 164

■ Entering contacts on page 169

■ Importing and exporting contacts on page 191

■ Editing contact information on page 195

■ Organizing the Address book on page 197
157



The Tree View section of the Address Book

On the left side of the 
Address Book is the Tree 
View, which shows how 
your folders are 
organized. To open or 
close a folder, click on it. 
A sample Tree View is 
shown on the right.

Contacts are stored in 
two main areas, the My 
Contacts folder and the 
Quick Dials folder. 

For more information, refer to the following topics:

■ The My Contacts folder on page 159

■ The Quick Dials folder on page 160
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The My Contacts folder

You can add both contacts and folders to the My 
Contacts folder. (You can only add contacts to the Quick 
Dials folder.)

Folders help you organize your contacts. By grouping 
contacts into folders, contacts are easier to find and view 
on the screen.

You can change which folders are shown by clicking on 
certain portions of the Tree View. 

Clicking on a box with “+” in it expands the folder beside 
it, showing the contacts and folders it contains.

Clicking on a box with “-” in it collapses the folder beside 
it, hiding the contacts and folders it contains. 

Clicking on a folder opens or closes the folder. When a 
folder is open, its contents are shown in the List View 
section (the right side) of the Address Book.
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The Quick Dials folder

The Quick Dials folder can hold 100 contacts. Contacts 
you add to the Quick Dials folder appear on the Calls 
menu and the Personal Call Manager task tray menu. (See 
The task tray icon on page 55.) You can only add 
contacts to the Quick Dials folder; you cannot add 
folders.

You should add contacts to this folder if:

■ you use them frequently, or

■ you want to specify special features for them. 

For information about the special features you can assign 
to Quick Dial contacts, refer to About Ring 
Configuration settings for Quick Dials contacts on 
page 161.

The Quick Dials folder synchronizes with the telephone 
Directory. For more information, refer to Quick Dials and 
the M9617 Directory on page 145.

For more information, refer to Adding a new contact to 
the Address Book on page 170.
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About Ring Configuration settings for Quick 
Dials contacts

You can specify the following special Ring Configuration 
features for the contacts stored in your Quick Dials 
folder:

Always Ring – When you select this option for a Quick 
Dials contact, you are overriding the Do Not Disturb 
setting for that contact. (When you activate the Do Not 
Disturb (DND) feature, the telephone does not ring when 
you receive a call.) For more information, refer to 
Overriding DND for some contacts on page 329.

Never Ring – When you select this option for a Quick 
Dial contact, the telephone does not ring when this 
contact calls. (Note that if you haven’t turned on the 
Suppress First Ring option, the telephone rings once.) 
For more information, refer to Screening your 
telephone calls on page 312.

Special Ring – When you select a special ring for a Quick 
Dial contact, you will hear a telephone ring that is 
different from the normal ring when this contact calls. 
(Note that if you haven’t turned on the Suppress First 
Ring option, the telephone will ring once normally.) For 
more information, refer to Screening your telephone 
calls on page 312.

Pager Notification – When you select this option for a 
Quick Dials contact, the pager feature will work for this 
contact even if you disable pager notification on both of 
your telephone lines. For more information, refer to 
Pager Notification for Quick Dial and memory key 
contacts on page 310.
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A note about Quick Dials and memory keys

You can set ring configuration features for contacts 
stored in the telephone Directory or Quick Dials folder 
AND for contacts stored in memory keys. For more 
information, refer to Specifying Ring Configuration 
properties for contacts stored in memory keys on 
page 155.

If you store the same contact (i.e., the same telephone 
number) in the telephone Directory or Quick Dials folder 
AND a memory key, the ring configuration settings for the 
memory key take precedence.

For more information, refer to the following topic:

■ Setting the Ring Configuration for Quick Dials 
contacts on page 163
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Setting the Ring Configuration for Quick 
Dials contacts

Using the right mouse button:

1 Right-click on a contact.

2 Point to the 9617 Options menu item. A submenu 
appears.

3 Click on the 9617 Properties menu item. The 9617 
Property dialog box appears.

4 Select the checkboxes next to the options you want to 
set. When an option is selected, a checkmark appears 
in the check box.

Using the toolbar:

1 Click on a contact.

2 Click on the Properties button on the toolbar 
(shown on the right). The 9617 Property dia-
log box appears.

3 Select the checkboxes next to the options you want to 
set. When an option is selected, a checkmark appears 
in the check box.

Tip: You can use the Quick Dials Manager to view and/
or change the Ring Configuration settings for all of your 
Quick Dials on one dialog box. For more information, 
refer to Using the Quick Dial Manager on page 331.

You can also specify these features for contacts stored in 
the telephone’s memory keys. For more information, refer 
to Specifying Ring Configuration properties for 
contacts stored in memory keys on page 155.

For more information, refer to Adding a new contact to 
the Address Book on page 170.
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The List View section of the Address Book

The List View is on the right side of the Address Book. The 
List View displays the contacts and folders stored in the 
folder selected in the Tree View (the left side).

The List View of the Address Book can be viewed in four 
different formats: large icons, small icons, list, and report.

For more information, refer to the following topics:

■ Displaying the Address Book as large icons on 
page 165

■ Displaying the Address Book as small icons on 
page 166

■ Displaying the Address Book as a list view on 
page 167

■ Displaying the Address Book as a report view 
on page 168
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Displaying the Address Book as large icons

When you choose the large icon view, each contact is 
shown with the name of the contact below the icon. 

To view large icons:

■ Click on , or click on the Views menu then click 
on the Large Icon menu item.
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Displaying the Address Book as small icons

When you choose the small icon view, each contact is 
shown with the name of the contact to the right of the 
icon, and the contacts are arranged horizontally. 

To view small icons:

■ Click on , or click on the Views menu then click 
on the Small Icon menu item.
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Displaying the Address Book as a list view

In list view, each contact is shown with the name of the 
contact to the right of the icon, and the contacts are 
arranged vertically. 

To view your contacts as a list:

■ Click on , or click on the Views menu then click 
on the List menu item.
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Displaying the Address Book as a report 
view

A report view displays detailed information, including the 
contact’s last name, first name, telephone numbers and 
extensions, Fax number and Email Address. 

To view the details of your contacts:

■ Click on , or click on the Views menu then click 
on the Report menu item.
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Entering contacts

A contact is any entry in the Address Book. A contact can 
be a person, business, or any number or address you 
want stored in Personal Call Manager.

The Address Book is divided into two main sections: My 
Contacts and Quick Dials. The My Contacts folder is 
used to store your contacts. The Quick Dials folder is 
used to store contacts that you use frequently.

The contacts that you add to the Quick Dials folder 
appear in the Quick Dials menu item in the Calls menu 
or the Personal Call Manager task tray menu. (See The 
task tray icon on page 55.)

The Quick Dials folder is synchronized with the Directory 
in the 9617 telephone. A change to either one is reflected 
in the other (refer to Quick Dials and the M9617 
Directory on page 145).

For more information, refer to the following topics:

■ Adding a new contact to the Address Book on 
page 170

■ Adding a caller to the Address Book on 
page 189

■ Copying a contact from the Calls Log to the 
Address Book on page 190

■ Importing and exporting contacts on page 191

■ Editing contact information on page 195

■ Quick Dials and the M9617 Directory on 
page 145

■ The Memory Keys Assignment tab on page 110
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Adding a new contact to the Address Book

Contacts are added to the Address Book using the 
Address Properties dialog box. You add contacts to the 
My Contacts folder and the Quick Dials folder the same 
way.

Note: When you add contacts to the Quick Dials folder, 
they are also added to the telephone Directory.

Using the menu or toolbar:

1 Click on the folder you want to add the contact to.

2 Click on the File menu.

3 Point to the New menu item. A submenu appears.

4 Click on the Contact menu item. The Address Prop-
erties dialog box appears.

Tip: Instead of doing steps 2, 3 and 4, click on 
the New Contact button on the toolbar (shown 
on the right).

5 Enter the contact information on each tab. For more 
information, refer to The Address Properties dialog 
box on page 172.

Using the right mouse button:

1 Right-click on the folder in the Tree View (i.e., the left 
side of the Address Book) that you want to add a con-
tact to, OR right-click on an open area in the List View 
(i.e., the right side of the Address Book).

2 Point to the New menu item. A submenu appears.
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3 Click on the Contact menu item. The Address Prop-
erties dialog box appears.

4 Enter the contact information on each tab. For more 
information, refer to The Address Properties dialog 
box on page 172.
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The Address Properties dialog box

The Address Properties dialog box consists of four tabs. 
Each tab is used to enter a different type of contact 
information.

To use the Address Properties dialog box, select each 
tab and fill out the information as desired. (The tabs are 
described in more detail below). When you are finished, 
click on the OK button.

Click on one of the following topics to find out more 
information about it.

■ Business – Use this tab to enter the name, address, 
and telephone numbers of the contact.

■ Email Address – Use this tab to enter the Email 
address and type.

■ Settings – Use this tab to define the default tele-
phone number used, and to specify the Call 
Announce Voice file path and Image file path (used 
to identify the contact when he or she calls).

■ Note – Use this tab to enter any other information 
about the contact.
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Business

The Business tab is used to enter the name, address, and 
telephone number of a contact, as well as other contact 
information. 

Note: Do not press the Enter key (to create line breaks) in 
the Address field. If you enter hard returns in this field, 
you may have problems importing and exporting 
contacts.

Information that you must fill in

You must enter the first name, last name and at least one 
phone number before you can successfully add a contact 
to the Address Book.
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The name you enter into the Last Name and First Name 
fields appears in the Calls box when you are on a call to 
this contact.

The Phone number field is a drop list that allows you to 
enter four different telephone numbers. You can enter 
the Business (with an extension number), Home, Mobile, 
and Fax telephone numbers for the contact. 

The numbers you enter can be dialed from the task tray or 
the Personal Call Manager main window. (See The task 
tray icon on page 55.)

Important: DO NOT enter dashes in telephone numbers.

You can also program dialing pauses and links to network 
services in telephone numbers you store in Personal Call 
Manager. For more information, refer to Programming 
dialing pauses and links in telephone numbers on 
page 175.

Information you can choose to fill in

If you want, you can enter the contact’s address, title, 
Company, Department, Office, and Assistant.
174



Programming dialing pauses and links in 
telephone numbers

You can program dialing pauses and links to network 
services in telephone numbers you store in the telephone 
or in Personal Call Manager.

Saving dialing pauses in a telephone number

You might want to enter a pause after a seven-digit 
telephone number so that the call is answered before 
Personal Call Manager dials an access code. 

If you are saving a telephone number in the telephone 
Directory, press the ˙ key where you want to 
enter a pause. For example, if you entered 555-
5555˙ ˙ ˙ 123 into the 
Directory, the telephone would dial the first seven digits, 
wait about five seconds, then dial the last three digits.

If you are saving a telephone number in the Personal Call 
Manager Address Properties dialog box, add a comma 
(,) to the number where you want the pause. For 
example, if you saved the number 555-5555,,,123, 
Personal Call Manager would dial the first seven digits, 
wait about five seconds, then dial the last three digits.

Accessing telephone network services

To access network services using your telephone, you 
press the ˚ key. For example, to make a Three 
Way call, you need to press this key to conference two 
callers together.
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175



When you save a telephone number in the telephone 
Directory or Personal Call Manager, you can program the 
Link key into the number so that it is automatically dialed 
out. 

If you are saving a telephone number in the telephone 
Directory, press the ˚ key to enter a Link press. 
For example, if you saved the number 555-5555,,, 
˚ 444-4444, the 9617 telephone would dial the 
first seven digits, pause for a few seconds to allow the call 
to be answered, dial the ̊  key, and then dial the 
last seven digits. 

Note: The commas are dialing pauses. Refer to the 
previous page for more information.

If you are saving a telephone number in the Personal Call 
Manager Address Properties dialog box, enter an 
exclamation mark (!) into the number to enter a Link 
press. For example, if you saved the number 555-
5555,,,!444-4444, Personal Call Manager would dial the 
first seven digits, pause for a few seconds to allow the 
first call to be answered, dial the ˚ key, and 
then dial the last seven digits. 

Note: The commas are dialing pauses. Refer to the 
previous page for more information.
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Email Address

The Email Address tab allows you to store email 
information for your convenience. Note that you can’t 
send email using Personal Call Manager. 

Use the Email address field to enter the contact’s E-mail 
address. 

Use the Email type field to enter a description of the 
email address. For example, “Personal email account.”
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Settings

The Settings tab allows you to specify which telephone 
number is dialed by default when you make a call by:

■ double-clicking on a contact icon in the Address 
Book;

■ dragging a contact icon from the Address Book to 
the Calls box; or

■ using the Quick Dials menu item in the Calls and 
task tray menus. 

You can also specify the Call Announce Voice file path 
and Image file path.

For more information, refer to the following topics:

■ Setting the default telephone number on 
page 179

■ Call Announcements that tell you who is call-
ing on page 180

■ Using graphics to identify callers on page 184
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Setting the default telephone number

You specify which telephone number–Business, Home, or 
Mobile–is the default telephone number. The default 
telephone number is the number that is dialed 
automatically unless you specify otherwise.

The Default Dial setting you specify here applies to this 
contact only.

You can override this setting when making a call. For 
more information, refer to Making a call using 
Personal Call Manager on page 241.
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Call Announcements that tell you who is 
calling

Personal Call Manager lets you specify Call 
Announcements for the contacts in your Address Book so 
you can hear who is calling.

If you subscribe to a Caller ID service, Personal Call 
Manager compares the number sent by the telephone 
company with the numbers stored in the Address Book. If 
a match is found and you have specified a Call 
Announcement for the matching contact, you will hear 
the Call Announcement through your computer speakers.

There are two steps to using Call Announcements. 

1 Record a Call Announcement using a sound recording 
program that produces .WAV files, or locate a suitable 
existing .WAV file.

2 Select the contact in the Address Book and then spec-
ify the location of the Call Announcement sound file.

Note: To record and use a Call Announcement, you 
need a microphone, a sound card, computer speakers 
and sound recording software. You can use pre-
recorded wave (.wav) files if you cannot record 
sounds.

For more information, refer to the following topics:

■ Specifying Call Announcements using the 
menu bar on page 181

■ Specifying a Call Announcement using the 
right mouse button on page 182

■ Using graphics to identify callers on page 184
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Specifying Call Announcements using the 
menu bar

To specify a Call Announcement:

1 Find the contact in the Address Book. You can find the 
contact manually or by using the Personal Call Man-
ager Search feature. Refer to Finding a contact in 
the Address Book on page 254 for more informa-
tion.

2 Click on the contact.

3 Click on the File menu.

4 Click on the Properties menu item. The Address 
Properties dialog box appears.

Tip: Instead of doing steps 3 and 4, click on the 
Properties button on the toolbar (shown on the 
right).

5 Click on the Settings tab.

6 Click on the Browse button (shown on the 
right) to the right of the Voice Announce File 
Path field. The Open dialog box appears.

7 Navigate to and select the sound file. 

8 Click on the Open button

9 Click on the OK button. 

Note: Click on  to remove a Voice Announce File 

Path.
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Specifying a Call Announcement using the 
right mouse button

To specify a Call Announcement:

1 Find the contact in the Address Book. You can find the 
contact manually or by using the Personal Call Man-
ager Search feature. Refer to Finding a contact in 
the Address Book on page 254 for more informa-
tion.

2 Right-click on the contact.

3 Click on the Properties menu item. The Address 
Properties dialog box appears.

4 Click on the Settings tab.
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5 Click on the Browse button (shown on the 
right) to the right of the Voice Announce File 
Path field. The Open dialog box appears.

6 Navigate to and select the sound file. 

7 Click on the Open button

8 Click on the OK button. 

Note: Click on  to remove a Voice Announce File 
Path.
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Using graphics to identify callers

You can identify incoming callers that are stored in your 
Address Book using graphics. When you specify a graphic 
for a caller, the graphic appears in the You Have a New 
Call dialog box when that contact calls.

There are two steps to using graphics. 

1 Create a graphic in the .BMP (bitmap) file format.

2 Select the contact in the Address Book and then spec-
ify the location of the graphic file.

For more information, refer to the following topics:

■ Specifying a graphic using the menu bar or 
toolbar on page 185

■ Specifying a graphic using the right mouse but-
ton on page 186
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Specifying a graphic using the menu bar or 
toolbar

To specify a graphic:

1 Find the contact in the Address Book. You can find the 
contact manually or by using the Personal Call Man-
ager Search feature. Refer to Finding a contact in 
the Address Book on page 254 for more informa-
tion.

2 Click on the contact.

3 Click on the File menu.

4 Click on the Properties menu item. The Address 
Properties dialog box appears.

Tip: Instead of doing steps 3 and 4, click on the 
Properties button on the toolbar (shown on the 
right).

5 Click on the Settings tab.

6 Click on the Browse button (shown on the 
right) to the right of the Image File Path field. 
The Open dialog box appears.

7 Navigate to and select the image file. 

8 Click on the Open button

9 Click on the OK button. 

Note: Click on the Delete button (shown on the 
right) to delete an Image File Path.
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Specifying a graphic using the right mouse 
button

To specify a graphic:

1 Find the contact in the Address Book. You can find the 
contact manually or by using the Personal Call Man-
ager Search feature. Refer to Finding a contact in 
the Address Book on page 254 for more informa-
tion.

2 Right-click on the contact.

3 Click on the Properties menu item. The Address 
Properties dialog box appears.

4 Click on the Settings tab.
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5 Click on the Browse button (shown on the 
right) to the right of the Image File Path field. 
The Open dialog box appears.

6 Navigate to and select the image file. 

7 Click on the Open button

8 Click on the OK button. 

Note: Click on the Delete button (shown on the 
right) to delete an Image File Path.
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Note

You use the Note tab to record miscellaneous 
information about a contact. You can enter significant 
dates, recent orders, meeting locations or any information 
you want handy when you call the contact.

If you right-click on a caller in the Calls box and then click 
on the Properties menu item, the Address Properties 
dialog box appears showing the Note tab if that caller is 
already stored in the Address Book. When the Note tab 
appears, you can click in the text area and begin typing 
notes. 

If the caller is not in the Address Book, you are given the 
option of adding the caller to the Address Book, so you 
can add notes.
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Adding a caller to the Address Book

When you receive a call, you can add that caller to your 
Address Book. The Personal Call Manager main window 
must be open before you add a caller.

To add a caller:

1 Right-click on the caller’s icon in the Calls box.

2 Click on the Save menu item. The Address Proper-
ties dialog box appears. If you subscribe to the Caller 
ID service, the telephone number, and name if avail-
able, are automatically entered into the dialog box.
(If the caller has already been saved into the Address 
Book, a dialog box appears asking you if you want to 
modify the contact entry.)

Tip: Instead of doing steps 1 and 2, point to the 
call in the Calls menu and click on the Save or 
Properties menu item, or click on the call icon 
and click on the Properties toolbar button.

3 Enter the address information for this contact.
For descriptions of the address fields refer to The 
Address Properties dialog box on page 172.

4 Click on the OK button.

The contact is added to the folder that is selected in the 
Tree View (the left side) of the Address Book. The contact 
appears in the List View (the right side of the Address 
Book).
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Copying a contact from the Calls Log to the 
Address Book

To copy contacts:

1 Click on the View menu.

2 Click on the Show Call Log Window menu item. 
Either the Incoming Calls Log Window or the Out-
going Calls Log Window appears.

3 Click on the View menu.

4 Click on either the Incoming Calls Log or Outgoing 
Calls Log menu items to display the log that contains 
the contact you want to copy to the Address Book.

5 Click on the contact and then click on the Edit menu.
OR
Right-click on the contact.

6 Click on the Copy menu item.

7 Click on the folder you want to copy the contact into 
in the Tree View (i.e., the left side) of the Address 
Book, and click on the Edit menu.
OR
Right-click on the folder you want to copy the contact 
into.

8 Click on the Paste menu item.
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Importing and exporting contacts

You can import and export contact information into and 
out of Personal Call Manager. Information is imported 
from and exported to comma delimited text files. 

The text files you import can be created in a text editor, 
spreadsheet or a database. 

The files you export can be used by a text editor, spread 
sheet or database. You can also export your Address Book 
so that you can print it out.

For more information, refer to the following topics:

■ Importing contacts from a text file on page 192

■ Exporting contacts to a text file on page 194

■ Printing your Address Book on page 386
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Importing contacts from a text file

The text files you import can be created in a text editor, 
spreadsheet or a database. 

Whatever the case, make sure your file only includes data 
that corresponds to the fields on the tabs of the Address 
Properties dialog box. (To access this dialog box, right-
click on a contact in the Address Book and click on the 
Properties menu item.)

To make it easy to sort the data fields correctly when 
importing, make sure the first record in the text file is 
complete (i.e., has data for each field you want to 
import).

The text fields in the text file you are importing must be 
separated by commas, and there must be a line return at 
the end of each contact’s information (record). When 
creating the text file using a spreadsheet or database 
application, be sure to choose the “comma delimited 
text” file format. 

Note: If necessary, change the file extension of the file 
you are importing from to “.txt” so that Personal Call 
Manager can recognize it. For example, some programs 
save comma delimited text files with the extension “.csv”.

If you are importing a file that has been exported by 
Personal Call Manager, you should ensure that the 
Default Dial field is assigned properly. This field 
determines the default number for an imported contact.
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The possible values for the Default Dial field are: “B” 
(for business number), “H” (for home number), ”M” (for 
mobile number) and “E” (for extension number). The 
import feature ignores other letters and characters. Be 
sure to assign data with one of these values to this import 
field.

If the file was not exported by Personal Call Manager (i.e., 
if it was exported by database or spreadsheet program), 
there may not be a field that matches this description. In 
this case, set this field to “none”. You can set the 
Default Dial field later in the contact's Address 
Properties dialog box.

To import contacts:

1 Click on the File menu.

2 Click on the Import Contact menu item. The Import 
contact from text file dialog box appears.

3 Click on the Browse button to the right of the 
Source Text File field. The Open dialog box 
appears.

4 Select the text file you are importing and click on the 
Open button. The information for the first record 
appears in the Fields Assignment area.

5 If the information appears in the Fields Assignment 
area in the correct order, then go to step 6. If the 
information does not appear in the Fields Assign-
ment area in the correct order, click on the drop list 
arrow to the right of each test field and choose the 
correct information. 

6 Click on the Import button. The imported addresses 
are placed in a folder called “Imported Contacts.”
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Exporting contacts to a text file

When exporting information to a text file, you can choose 
how that the data is exported.

To export contact information:

1 Click on the File menu.

2 Click on the Export Contact menu item. The Export 
contact into text file dialog box appears.

3 Click on the Browse button to the right of the 
Source Text File field. The Save As dialog box 
appears.

4 Select the location where you want to save the text file 
and specify a filename.

5 Click on the Save button.

6 If the information is in the order you want to export it, 
go to step 7. If not, click on the drop list arrow to the 
right of each test field and choose information until 
the data appears in the correct order. 

7 Click on the Export button.

Tip:If you are exporting your contacts for import by 
another Personal Call Manager user, it is recommended 
that you use the default field order for both the import 
and export operation. This will ensure that data fields are 
correctly assigned.
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Editing contact information

The information stored with a contact can be easily 
updated as required. Contact information can be edited 
on the contact’s Address Properties dialog box.

To change the properties of a contact:

1 Find the contact in the Address Book. You can find the 
contact manually or by using the Personal Call Man-
ager Search feature. Refer to Finding a contact in 
the Address Book on page 254 for more informa-
tion.

2 Right-click on the contact and then click on the Prop-
erties menu item.

OR

Click on the contact, click on the File menu and then 
click on the Properties menu item.

OR

Click on the contact and then click on the 
Properties button on the toolbar (this button 
is black).
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The Address Properties dialog box appears.

3 Select the tab that has the information you want to 
change.

4 Make the required changes. For more information on 
the information that you can change, refer to The 
Address Properties dialog box on page 172.
Note: Do not press Return while entering information 
in the Address field.

5 If necessary, select another tab and repeat step 4.

6 Click on the OK button.

Note: When you make changes to the name or number 
of contacts in the Quick Dials folder, the same changes 
are made to the telephone Directory, and vice versa.
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Organizing the Address book

Personal Call Manager makes it easy for you to copy, 
move or delete contacts.

You can organize the contacts in the Address Book into 
folders. For example, you may want to add two folders, 
one named Personal and the other named Business. You 
could then store all of your business contacts in one 
folder and all of your personal contacts in the other. 

Note: You can’t add folders to the Quick Dials folder.

For more information, refer to the following topics:

■ Copying a contact on page 198

■ Moving a contact on page 207

■ Deleting a contact on page 211

■ Using folders to organize contacts on page 212 
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Copying a contact

By copying an existing contact, you can create a new 
contact based on the existing one. Personal Call Manager 
allows you to make two kinds of copies, a linked copy 
and a template copy. 

When you make a linked copy, all of the information 
about the contact is copied, and the copied information 
remains linked to the original information. A change to 
one contact is also made in the other(s).

When you make a template copy, all of the contact’s 
information except the name is copied. The information is 
not linked to the original.

In both methods of copying, the original contact remains 
in the original folder.

For more information, refer to the following topics:

■ Deciding which copy method to use on 
page 199

■ Using the linked copy method on page 200

■ Using the template copy method on page 204
198



Deciding which copy method to use

The copy method you choose depends on what you want 
to do. (See page 198 for a description of each.)

The Linked copy method

Use the linked copy method when you want to have 
identical copies of a single contact in several different 
folders so the contacts are easier to find and organize. 

A linked copy remains linked to the entry it was copied 
from. When you change one of the properties of the 
contact (either in the original or the copy), Personal Call 
Manager automatically updates the original contact and 
all of its copies. This ensures that all of your copies of the 
contact are updated.

Note: When you delete a linked copy of a contact, other 
linked copies are not affected.

For information, refer to Using the linked copy method 
on page 200.

The Template copy method

When you create a template copy, Personal Call Manager 
does not link the new contact to the original contact. 

The most common use of the template copy feature is to 
create a new contact that is similar, but not identical to, 
an existing contact. For example, a new person joins a 
company you deal with. The address and telephone 
number of the new contact is the same as it was for the 
old one, but the name is different. 

For information, refer to Using the template copy 
method on page 204.
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Using the linked copy method

Use this method when you want to create a copy of a 
contact that is linked to an original contact. For 
information about the two different methods of copying 
a contact, refer to Deciding which copy method to use 
on page 199.

For more information, refer to the following topics:

■ Using the template copy method on page 204

■ Making a linked copy of a contact using drag 
and drop on page 202

■ Making a linked copy of a contact using the 
right mouse button on page 203
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Making a linked copy of a contact using the 
menu or toolbar

To make a linked copy of a contact:

1 Click on the contact you want to copy.

2 Click on the Edit menu. 

3 Click on the Copy menu item.

Tip: Instead of doing steps 2 and 3, click on the 
Copy button on the toolbar (shown on the right).

4 Open the folder you want to copy the contact into. 
The contents of the folder appear in the List View box.

5 Click on the Edit menu. 

6 Click on the Paste menu item. The contact is copied 
to the new folder.

Tip: Instead of doing steps 5 and 6, click on the 
Paste button on the toolbar (shown in the right).
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Making a linked copy of a contact using drag 
and drop

To copy a contact using drag and drop, both the contact 
you are copying and the destination folder must be 
visible. 

To make a linked copy of a contact:

1 Press and hold the Ctrl key on your computer key-
board.

2 Drag the contact to the folder you want the contact 
copied to.
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Making a linked copy of a contact using the 
right mouse button

To make a linked copy of a contact:

1 Right-click on the contact you want to copy.

2 Click on the Copy menu item.

3 Open the folder you want to copy the contact into. 
The contents of the folder appear in the List View box.

4 Right-click on an open area in the folder.

5 Click on the Paste menu item. The contact is copied 
to the new folder.
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Using the template copy method

Use this method when you want to create a new contact 
that is similar to an existing contact. All of the contact 
information except the contact name is copied to the new 
contact. 

For example, you could quickly make Directory entries for 
five people who work at the same company. Their 
business addresses would all be the same; only the names 
would change. 

For more information, refer to the following topics:

■ Deciding which copy method to use on 
page 199

■ Making a template copy of a contact using the 
menu bar on page 205

■ Making a template copy of a contact using the 
right mouse button on page 206
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Making a template copy of a contact using 
the menu bar

To copy a contact:

1 Click on the contact you want to copy.

2 Click on the Edit menu.

3 Click on the Copy menu item.

4 Open the folder you want to copy the contact into. 
The contents of the folder appear in the List View box.

5 Click on the Edit menu. 

6 Click on the Paste Special menu item. The address 
properties dialog box appears. All of the information is 
the same as the original contact except the name field 
is blank.

7 Enter the name of the contact. You can also change 
any of the other information on the dialog box.

8 Click on the OK button.

After the contact is copied into the folder, you can open 
the contact properties and change any properties that are 
required. Refer to Editing contact information on 
page 195 for more information.
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Making a template copy of a contact using 
the right mouse button

To copy a contact:

1 Right-click on the contact you want to copy.

2 Click on the Copy menu item.

3 Open the folder you want to copy the contact into. 
The contents of the folder should be showing in the 
List View box.

4 Right-click anywhere in the List View box (the right 
side of the Address Book).

5 Click on the Paste Special menu item. The Address 
Properties dialog box appears. All of the information 
is the same as the original contact except the name 
field is blank.

6 Enter the name of the contact. You can also change 
any of the information on the dialog box.

7 Click on the OK button.

After the contact is copied into the folder, you can open 
the contact properties and change any properties that are 
required. Refer to Editing contact information on 
page 195 for more information.
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Moving a contact

Contacts can be moved from one folder to another to 
help organize the Address Book. When you move a 
contact, it does not remain in the original folder.

For more information, refer to the following topics:

■ Moving a contact using the menu bar on 
page 208

■ Moving a contact using drag and drop on 
page 209

■ Moving a contact using the right mouse button 
on page 210
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Moving a contact using the menu bar

To move a contact:

1 Click on the contact you want to move.

2 Click on the Edit menu. 

3 Click on the Cut menu item. The icon for the contact 
dims.

Tip: Instead of doing steps 2 and 3, click on the Cut 
button on the toolbar (shown on the right). The 
icon for the contact dims.

4 Open the folder you want to move the contact into. 
The contents of the folder appear in the List View box.

5 Click on the Edit menu. 

6 Click on the Paste menu item. The contact is moved 
to the new folder.

Tip: Instead of doing steps 5 and 6, click on the 
Paste button on the toolbar. The contact is moved 
to the new folder.

Note: After you have used the Cut command (indicated 
by the contact icon dimming), you must use the Paste 
command to move the contact before using the Cut or 
Copy commands again. If you use the Cut or Copy 
command before pasting the contact, the contact you cut 
first remains in its original folder.
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Moving a contact using drag and drop

To move a contact using drag and drop, both the contact 
and the folder you are moving it to must be visible in the 
address book. 

To move a contact:

1 Drag the contact you want to move to the folder you 
want the contact moved to.
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Moving a contact using the right mouse 
button

To move a contact:

1 Right-click on the contact you want to move.

2 Click on the Cut menu item. The icon for the contact 
dims.

3 Open the folder you want to move the contact into. 
The contents of the folder appear in the List View box.

4 Right-click on an open area in the folder.

5 Click on the Paste menu item. The contact is moved 
to the new folder.

Note: After you have used the Cut command (indicated 
by the contact icon dimming), you must use the Paste 
command to move the contact before using the Cut or 
Copy commands again. If you use the Cut or Copy 
command before pasting the contact, the contact you cut 
first remains in its original folder.
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Deleting a contact

Using the menu bar:

1 Click on the contact you want to delete.

2 Click on the Edit menu. 

3 Click on the Delete menu item.

Using the right mouse button:

1 Right-click on the contact you want to delete.

2 Click on the Delete menu item.

Using the keyboard:

1 Click on the contact you want to delete.

2 Press the Delete key on the keyboard.

Note: You can restore a deleted contact if you select the 
Edit menu Undo menu item immediately after you delete 
it.
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Using folders to organize contacts

Personal Call Manager allows you to easily organize your 
contacts using folders.

For more information, refer to the following topics:

■ Creating a new folder in the Address Book on 
page 213

■ Copying and pasting a folder on page 216

■ Moving a folder on page 220

■ Renaming a folder on page 225

■ Deleting a folder on page 226
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Creating a new folder in the Address Book

You can create a new folder in which to store contacts. 
When you add a new folder, it is always placed inside the 
folder selected in the Tree View (on the left) of the 
Address Book.

Note: You cannot add folders to the Quick Dials folder.

For more information, refer to the following topics:

■ Creating a new folder using the menu bar or 
toolbar on page 214

■ Creating a new folder using the right mouse 
button on page 215

■ Copying and pasting a folder on page 216
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Creating a new folder using the menu bar or 
toolbar

To create a new folder:

1 In the Tree View of the Address Book (the left side), 
click on the folder you want to put the new folder 
into. 
Note: You cannot add folders to the Quick Dials 
folder in the Address Book.

2 Click on the File menu.

3 Point to the New menu item. A submenu appears.

4 Click on the Folder menu item. The Create New 
Folder dialog box appears.

Tip: Instead of doing steps 2, 3 and 4, click on 
the New Folder button on the toolbar (shown on 
the right). 

5 Type the name of the new folder.

6 Click on the OK button. The new folder is added to 
the selected folder.

Note: When naming the new folder, you must use a 
name that is not used by another folder. 
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Creating a new folder using the right mouse 
button

To create a new folder:

1 In the Tree View of the Address Book (the left side), 
click on the folder you want to put the new folder 
into. 
Note: You cannot add folders to the Quick Dials 
folder in the Address Book.

2 Right-click on an open area in the List View (the right 
side of the Address Book).

Tip: Instead of doing steps 1 and 2, you can right-click 
on the folder in the Tree View (left side of the Address 
Book) you want to add the new folder to.

3 Point to the New menu item. A submenu appears.

4 Click on the Folder menu item. The Create New 
Folder dialog box appears.

5 Type the name of the new folder and then click on the 
OK button. The new folder is added inside the 
selected folder. When naming the new folder, you 
must use a name that does not already exist in the 
selected folder.
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Copying and pasting a folder

You copy a folder so that you can paste it into another 
folder. When you copy a folder, you copy the folder and 
all of its contents, including contacts and sub-folders.

When you copy and paste a folder of contacts, each new 
copy of a contact is linked to its original. If you make a 
change to the copy, the original is also changed. (Refer to 
Using the linked copy method on page 200.)

For more information, refer to the following topics:

■ Copying and pasting a folder using the menu 
bar on page 217

■ Copying and pasting a folder using the toolbar 
on page 218

■ Copying and pasting a folder using the right 
mouse button on page 219
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Copying and pasting a folder using the 
menu bar

To paste a copy of a folder into another folder:

1 Click on the folder you want to copy.

2 Click on the Edit menu. 

3 Click on the Copy menu item.

4 Open the folder you want to copy the folder into.
The contents of the folder appear in the List View box.

5 Click on the Edit menu. 

6 Click on the Paste menu item.
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Copying and pasting a folder using the 
toolbar

To paste a copy of a folder into another folder:

1 Click on the folder you want to copy.

2 Click on the Copy button on the toolbar (shown 
on the right).

3 Open the folder you want to copy the folder into.
The contents of the folder appear in the List View box.

4 Click on the Paste button on the toolbar (shown 
on the right).
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Copying and pasting a folder using the right 
mouse button

To paste a copy of a folder into another folder:

1 Right-click on the folder you want to copy. The folder 
must be in the List View box.

2 Click on the Copy menu item.

3 Open the folder you want to copy into.
The contents of the folder appears in the List View 
box.

4 Right-click on an open area in the folder.

5 Click on the Paste menu item.
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Moving a folder

Folders can be moved from one enclosing folder to 
another. When you move a folder, all of the contacts and 
folders it contains move with it.

For more information, refer to the following topics:

■ Moving a folder using the menu bar on 
page 221

■ Moving a folder using the toolbar on page 222

■ Moving a folder using drag and drop on 
page 223

■ Moving a folder using the right mouse button 
on page 224
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Moving a folder using the menu bar

To move a folder:

1 Click on the folder you want to move.

2 Click on the Edit menu. 

3 Click on the Cut menu item. The folder dims.

4 Open the destination folder. The contents of the folder 
appear in the List View box.

5 Click on the Edit menu. 

6 Click on the Paste menu item.
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Moving a folder using the toolbar

To move a folder:

1 Click on the folder you want to move.

2 Click on the Cut button on the toolbar (shown 
on the right). The folder dims.

3 Open the destination folder. The contents of the folder 
appear in the List View box.

4 Click on the Paste button on the toolbar (shown 
on the right).
222



Moving a folder using drag and drop

To move a folder using drag and drop, both the folder you 
are moving and the folder you are moving it to must be 
visible in the Address Book. 

To move a folder:

1 Drag the folder you want to move to the new destina-
tion folder.
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Moving a folder using the right mouse 
button

To move a folder:

1 Right-click on the folder you want to move. The folder 
must be in the List View box.

2 Click on the Cut menu item. The folder dims.

3 Open the destination folder. The contents of the folder 
appear in the List View box.

4 Right-click on an open area in the folder.

5 Click on the Paste menu item.
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Renaming a folder

Using the menu bar:

1 Click on the folder you want to rename.

2 Click on the File menu.

3 Click on the Properties menu item. The Folder Prop-
erty dialog box appears.

4 Type the new name of the folder.

5 Click on the OK button.

Using the right mouse button:

1 Right-click on the folder you want to rename.

2 Click on the Properties menu item. The Folder Prop-
erty dialog box appears.

3 Type the new name of the folder.

4 Click on the OK button.

Using the toolbar:

1 Click on the folder you want to rename.

2 Click on the Properties button on the toolbar 
(shown on the right - this button is black). The 
Folder Property dialog box appears.

3 Type the new name of the folder.

4 Click on the OK button.
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Deleting a folder

When you delete a folder, all the contacts and folders it 
contains are also deleted.

Note: You can restore a deleted folder if you select Undo 
from the Edit menu immediately after you delete the 
contact.

Using the menu bar:

1 Click on the folder you want to delete.

2 Click on the Edit menu. 

3 Click on the Delete menu item.

4 Click on the OK button to confirm deleting the folder 
and its contents.

Using the right mouse button:

1 Right-click on the folder you want to delete.

2 Click on the Delete menu item.

3 Click on the OK button to confirm deleting the folder 
and its contents.

Using the keyboard:

1 Click on the folder you want to delete.

2 Press the Delete key on the keyboard.

3 Click on the OK button to confirm deleting the folder 
and its contents.
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Looking up contacts
It’s easy to find your contacts whether they are saved in 
the telephone Directory or in the Address Book in 
Personal Call Manager.

For more information, refer to one of the following 
topics.

■ Finding a contact in the telephone Directory on 
page 234

■ Finding a contact in the Address Book on 
page 254 
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Making, answering and holding calls
You can use either the 9617 telephone or Personal Call 
Manager to make, answer and hold calls.

For more information, refer to the following topics:

■ Making calls on page 229

■ Answering calls on page 263

■ Holding and unholding calls on page 284

■ Hanging up on page 289
--------------------

■ Conference calls on page 291
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Making calls

You can make a call using the telephone or Personal Call 
Manager.

For more information, refer to the following topics:

■ Making a call using the telephone on page 230

■ Making a call using Personal Call Manager on 
page 241

■ Handsfree calls on page 261
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Making a call using the telephone

There are several ways to make a telephone call using the 
9617 telephone.

For more information, refer to the following topics:

■ Dialing a call on page 231

■ Making a second call on your other line on 
page 232

■ Using the telephone Directory to make a call on 
page 233

■ Using a memory key to make a call on page 235

■ Using the Callers List to return a call on 
page 236

■ Using the Redial List to make a call on page 237

■ Redialing busy telephone numbers automati-
cally on page 370

--------------------

■ Selecting the dialpad option on page 239

■ Changing the prime line on page 240
--------------------

■ Finding a contact in the telephone Directory on 
page 234
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Dialing a call

You can use the 9617 to simply dial a regular call, or you 
can predial a telephone number to ensure it is correct 
before it is dialed out.

To dial a call:

1 Lift the handset or press ©, ∂ or 
¬.

2 Enter the number using the dialpad.

To predial a call, the Live Dialpad option must be off. For 
more information, refer to Selecting the dialpad option 
on page 239.

To predial a call:

1 Enter the number using the dialpad. Check the display 
to ensure you entered the number correctly.

2 Lift the handset or press ©, ∂ or 
¬.

When you use ©, ∂ or lift the handset 
rather than using a line key to make a call, the prime line 
is automatically selected. The default prime line is Line 1. 
If you want to change the prime line to Line 2, refer to 
Changing the prime line on page 240.
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Making a second call on your other line

You may want to make a call on your other line without 
hanging up your first call.

To make a call on your other line:

1 Press the other line key. The original line is put on 
hold.

2 Dial the telephone number.

Switching between callers

To switch to the caller that is on hold, press the 
appropriate Line key (¬) for that caller. The other 
caller is automatically put on hold.

For more information, refer to Answering a call on the 
other line on page 265.
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Using the telephone Directory to make a call

To make a call from the Directory, the Directory must 
contain contacts. For information on storing contacts into 
the Directory, refer to The telephone Directory on 
page 139.

To dial a number using the Directory:

1 Press ¢.

2 Press – or ≠ or use the dialpad to 
find the item you want to dial out. Refer to Finding a 
contact in the telephone Directory on page 234.

3 Lift the handset or press ©, ∂, or 
¬.

To end the call, press ® or hang up.

Note: To leave the Directory at any time, press 
¢.
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Finding a contact in the telephone Directory

To scroll through the Directory:

1 Press ¢.

2 To move up and down the list, press – or 
≠. If you want to scroll steadily, press and 
hold – or ≠.

To find contacts beginning with a particular letter:

1 Press ¢.

2 Press the dialpad key with the letter you’re looking for 
printed on it, then press –. (For example, to 
see the contacts starting with “J”, press fi, then press 
– to scroll through the J listings. Refer to the 
letter chart shown under Entering Names on 
page 153.

To go directly to a particular contact:

1 Press ¢.

2 Spell out the contact’s name using the dialpad. As you 
enter the letters of the name, the telephone narrows 
down the number of contacts that match the letters 
you enter until only the name you have entered 
remains. Press – at any time to view all the 
contacts that match the characters you entered. For 
example, to find “Steve”, press ‡ ° ‹ ° ‹.

Note: To leave the Directory at any time, press 
¢.
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Using a memory key to make a call

Once you store a contact in a memory key, you can use 
that memory key to make a call. For more information on 
storing contacts in memory keys, refer to Adding a 
contact to a memory key using the telephone on 
page 147.

To call from a memory key:

1 Lift the handset or press ©, ¬ or 
∂.

2 Press the memory key with the number you want to 
dial out.

Note: If the Live Dialpad option is turned on, you do not 
have to lift the handset or press any other button. 
Pressing the memory key automatically dials the number 
and puts the telephone in Handsfree mode.

To predial a call, the Live Dialpad option must be off. For 
more information, refer to Selecting the dialpad option 
on page 239.

To predial from a memory key:

1 Press the memory key with the number you want to 
dial out.

2 Lift the handset or press ∂, ©, or 
¬.
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Using the Callers List to return a call

You must subscribe to Caller ID from your telephone 
company to make calls from the Callers List. Contact your 
local telephone company to subscribe to this service. For 
more information on the Callers List, refer to The Callers 
List on page 335.

To dial a number in the Callers List:

1 Press ≈.

2 Press ¬. This step is not necessary if the Call-
ers List Mode is set to the Combined option. For more 
information about the Callers List Mode, refer to Set-
ting the Callers List mode on page 338.

3 Use ª to find the contact you want to dial 
out.

4 Lift the handset or press ©, ∂, or 
¬.

5 To end the call, press ® or hang up.

If you have trouble making a call from the Callers List, you 
may have to edit the number (for example, the number 
may be long distance and you may have to add “1” 
before the number). Refer to Editing in the Callers List 
on page 341 for more information.

You may also have to strip area codes from local numbers 
to make local calls using the Callers List. For more 
information, refer to Stripping area codes from 
numbers in the telephone Callers List on page 375.
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Using the Redial List to make a call

The Redial List stores the last ten numbers you dialed. 
When you press µ, the last number you called 
appears on the screen. You can then scroll through the list 
to view the other numbers. 

Note: The 9617 telephone Redial List synchronizes with 
the Personal Call Manager Calls menu Redial List.

To make a call from the Redial List:

1 Press µ. The telephone display shows the last 
number you dialed.

2 If you want to select a different redial number, find 
that number by pressing ª.

3 When the number is displayed, lift the handset or 
press ©, ∂, or ¬.

Note that if you press µ when the Live Dialpad 
option is turned on, after lifting the handset or after 
pressing ©, ∂, or ¬, your 
telephone automatically dials the last number in the 
Redial List without first displaying it.

For more information, refer to Deleting the Redial List 
on page 347.
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Using a headset 

To use a headset instead of the handset receiver:

1 Disconnect the handset and attach the headset cord 
to the jack labeled .

2 Turn on the headset mode.

To turn the headset mode on or off:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 12, or 
press ⁄ ¤.

4 Press • to change the headset mode. (By default, the 
headset mode is turned off.)

Note: When the headset mode is enabled, the 
handset must remain in the cradle. 

To answer a call:

Press ©.

To make a call:

Press ¬.

(You cannot use the Handsfree speakerphone when the 
headset mode is enabled.)

To end a call:

Press ®.

To return to using the handset, you must reconnect 
the handset and disable the headset mode.
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Selecting the dialpad option

When you select the dialpad option, you are turning the 
Live Dialpad option on or off. When the Live Dialpad 
option is turned on, the telephone is in Live dial mode. 
When you dial, the telephone chooses the prime line and 
automatically dials in Handsfree mode as soon as you 
press a dialpad key or a memory key. 

When Live Dialpad is off, the telephone is in pre-dial 
mode. This means that after you dial the telephone 
number, you must lift the handset or press ∂, 
¬, or © before the telephone number 
is dialed.

To select the dialpad mode using the 9617 tele-
phone:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 5 or press 
‚ fi.

4 Press • to change the dialpad mode.

5 Press ®.

For information on how to select the dialpad mode using 
Personal Call Manager, refer to The General tab on 
page 95. 
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Changing the prime line

The prime line is the line that is automatically selected 
when you lift the handset or press © or 
∂. The default setting for prime line is Line 1. 
You can select either line as your prime line.

To change the prime line:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 3 or press 
‚ ‹. The current prime line is displayed.

4 Press • to change the prime line.

5 Press ®.
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Making a call using Personal Call Manager

There are several ways to make a telephone call in 
Personal Call Manager (refer to the topics below). 

When you make a call, the large Active Call icon 
(shown on the right) appears in the Calls box, 
and the small Active Call icon appears in the 
Personal Call Manager task tray menu, and Calls 
menu. (For more information on the icons that appear in 
the task tray menu and Calls menu, refer to The task 
tray menu on page 56.

Note: All calls made using Personal Call Manager are in 
Handsfree mode. Do not pick up the handset before 
making a call with Personal Call Manager. Pick up the 
handset only after the telephone number has been dialed 
(unless you are already on a call – in this case Personal 
Call Manager dials using the free line). For information on 
Handsfree, refer to Handsfree calls on page 261.

For more information, refer to the following topics:

■ Making a call using the Address Book on 
page 242

■ Making a call using the task tray or Calls menu 
on page 246

■ Making a call using the Memory Key dialog 
box on page 253

■ Making a call using the Calls Log Window on 
page 350

■ Finding a contact in the Address Book on 
page 254
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Making a call using the Address Book

The Address Book provides you the most flexibility for 
making calls. For example, it allows you to dial a contact’s 
non-default telephone numbers.

Before you can call a contact using the Address Book, it 
must contain the contact’s telephone number (see 
Adding a new contact to the Address Book on 
page 170).

When you make a call using the Address Book, the name 
in the Address Book appears in the Calls box. 

When you manually dial a telephone number, Personal 
Call Manager compares the dialed number to the 
numbers stored in the Address Book. If a match is found, 
the name from the Address Book appears in the Calls 
box. If no match is found, the number dialed appears in 
the Calls box.

There are several ways to make a call using the Address 
Book. For more information, refer to the following topics:

■ Right-clicking to make a call on page 243

■ Using the drag and drop method to dial a con-
tact’s default number on page 244

■ Using the drag and drop method to dial a con-
tact’s non-default number on page 245
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Right-clicking to make a call

To make a call by right-clicking in the Address Book:

1 Find the icon of the person you want to call in the 
Address Book. You can use contacts in either the My 
Contacts folder or the Quick Dials folder.

2 Right-click on the icon.

3 Point to the Dial menu item. A submenu appears.

4 Click on the telephone number you want to dial for 
this person (i.e., the Business (or Business extension), 
Home or Mobile number).

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.
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Using the drag and drop method to dial a 
contact’s default number

You may have entered more than one telephone number 
for some of the contacts in the Address Book (for 
example, a business number and a home number). If so, 
you can define one of those numbers as a default 
number. The default number is set on the contact’s 
Address Properties dialog box Settings tab. The 
Business number is selected by default. A default 
telephone number is the number that is dialed out 
automatically unless you specify otherwise. For more 
information, refer to Adding a new contact to the 
Address Book on page 170.

To dial the default telephone number:

1 Find the icon of the person you want to call in the 
Address Book. You can look either in the My Con-
tacts folder or the Quick Dials folder.

2 Double-click on the icon or drag it to the Calls box.

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.
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Using the drag and drop method to dial a 
contact’s non-default number

You may have entered more than one telephone number 
for some of the contacts in the Address Book. If so, you 
can define one of those numbers as a default number. A 
default telephone number is the number that is dialed out 
automatically unless you specify otherwise (i.e., 
specifically select a non-default number). For more 
information, refer to Adding a new contact to the 
Address Book on page 170.

To call a non-default telephone number using the 
drag and drop method:

1 Find the icon of the person you want to call in the 
Address Book. You can look either in the My Con-
tacts folder or the Quick Dials folder.

2 Use the right mouse button to drag the icon into the 
Calls box. A menu appears.

3 Click on the telephone number you want to dial for 
this person (i.e., the Business (or Business Extension), 
Home or Mobile number).

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.
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Making a call using the task tray or Calls 
menu

The task tray menu and the Calls menu are identical. You 
have four menu items to choose from when making a call 
using the task tray menu or Calls menu. You can use 
Quick Dials, Redial List, Callers List or Manual Dial.

For more information, refer to the following topics:

■ Returning a call using the Callers List in Per-
sonal Call Manager on page 247

■ Redialing a call using the Redial List in Personal 
Call Manager on page 248

■ Making a call using the Quick Dials menu item 
on page 249

■ Dialing using the Dial dialog box on page 250

■ The task tray icon on page 55
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Returning a call using the Callers List in 
Personal Call Manager

The Callers List contains a list of the last ten calls you 
received. Each call is identified by the name or telephone 
number sent by the telephone company (if you subscribe 
to Caller ID from your local telephone company), or by 
the name stored in the Address Book.

To make a call using the Callers List:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to the Callers List menu item. A submenu 
appears.

3 Click on the contact you want to call.

If you have trouble making a call from the Personal Call 
Manager Callers List, you may have to dial the number 
using the Callers List in the 9617 telephone instead. Refer 
to Editing in the Callers List on page 341 for more 
information.

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.

You can also return a call using the Calls Log window. For 
more information, refer to Making a call using the Calls 
Log Window on page 350.
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Redialing a call using the Redial List in 
Personal Call Manager

The Redial List contains a list of the last ten calls you 
made. Each call is identified by telephone number, or if 
the contact you called is stored in the Directory, by the 
name you have stored there.

To make a call using the Redial List:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to the Redial List menu item. A submenu 
appears.

3 Click on the contact you want to call.

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.
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Making a call using the Quick Dials menu 
item

There are two ways to make a call using the Quick Dials 
menu item – you can use the task tray menu or the Calls 
menu. 

You can choose a contact from the Quick Dials menu 
item. The Quick Dials menu item lists the contacts you 
have stored in the Quick Dials folder in the Address 
Book.

To make a call:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to the Quick Dials menu item.

3 Click on the contact you want to call.

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.
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Dialing using the Dial dialog box

To make a call using the Manual Dial menu item:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Click on the Manual Dial menu item. The Dial dialog 
box appears.

Tip: You can also open the Dial dialog box 
by pressing the F3 key on your keyboard or 
by clicking on the Dial button on the toolbar 
(shown on the right.

3 Enter a telephone number in the text field in the upper 
left corner of the dialog box. (You can also search for a 
contact by name or number. For more information on 
searching, refer to Making a call by searching for a 
contact using the Dial dialog box on page 251.)

4 Click on the Dial button.

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.
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Making a call by searching for a contact 
using the Dial dialog box

You can search for a contact by name or number using 
the Dial dialog box. The search method differs depending 
on the Search Option you are using.

If you have the Search Option set to Fast Search, Personal 
Call Manager compares the name or number you enter in 
the Call field to the contacts stored in the Address Book 
as you enter it.

If you have the Search Option set to Slow Search, 
Personal Call Manager only searches for your contact 
when you click on the Find Now button. In either case, 
contacts that match your criteria appear in the bottom 
area of the dialog box.

To use the Dial dialog box:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Click on the Manual Dial menu item. The Dial dialog 
box appears. (You can also open the Dial dialog box 
by pressing the F3 key.)

3 Enter the telephone number as it appears in the 
Address Book (e.g., +1 (403) 5551234...) or name (in 
the format: last name, first name) of the person you 
want to call in the upper left text field. If you are doing 
a Slow Search, click on the Find Now button when 
you want the search to begin. If you are doing a Fast 
search, matching contacts appear as you enter charac-
ters.

continued...
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4 Click on the contact you want to call from the list of 
matches found.

5 If it is not grayed out, click on the Phone Number list 
box then click on Business, Home, Mobile or Extension 
to select the number you want to call.

6 Click on the Dial button.

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.

For more information, refer to the following topics:

■ Search preferences on page 128

■ Searching based on a contact’s first or last 
name on page 259 

■ Searching using wildcard characters on 
page 260
252



Making a call using the Memory Key dialog 
box

You can call contacts assigned to Memory Keys using the 
Memory Key dialog box.

To make a call using the Memory Key dialog box:

1 Click on the 9617 Options menu.

2 Click on the Memory Key menu item. The Memory 
Key dialog box appears.

Tip: You can also open the Memory Key 
dialog box by clicking on the Memory Key 
button on the toolbar (shown on the right.)

3 Click on the contact you want to call.

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.
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Finding a contact in the Address Book

The Address Book has a search feature to help you find a 
contact. You can search for a contact using the contact’s 
name or telephone number.

The Search feature operates in two different modes, Slow 
and Fast.

In Slow Search mode, you enter the characters you want 
to find and then click on the Find Now button. Personal 
Call Manager only begins searching after you have clicked 
on the Find Now button. For more information refer to 
Slow Search on page 255.

In Fast Search mode, Personal Call Manager starts 
searching through the contacts as soon as you enter 
characters. For more information, refer to Fast Search on 
page 257.

To change the Search mode used, refer to Search 
preferences on page 128.

When entering search criteria, you usually search based 
on last name since names are stored in the format “Last 
Name, First Name.” However, you can also search by the 
first name, or using wildcard characters. Refer to 
Searching based on a contact’s first or last name on 
page 259 and Searching using wildcard characters on 
page 260 for more information.
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Slow Search

Personal Call Manager performs a slow search if you have 
chosen the Slow Search option in the Search Preferences. 
Refer to Search preferences on page 128 for more 
information.

To find a contact:

1 Click on , or click on the Tools menu and then 
click on the Find Person menu item. The Search dia-
log box appears.

2 Enter the last name or telephone number of the con-
tact you want to find exactly as it is in the Address 
Book (including the plus sign and brackets, e.g., “+1 
(555) 5551234”). You can also search based on a con-
tact’s first name (refer to the topic listed below.)

3 Click the Find Now button. A list of the contacts that 
match the name or number you enter appears in the 
bottom of the Search dialog box.

4 Click on the name of the contact you want.

continued...
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5 Click on the OK button. The folder containing the 
contact opens and the selected contact is highlighted.

For more information, refer to the following topics:

■ Fast Search on page 257

■ Searching based on a contact’s first or last 
name on page 259

■ Searching using wildcard characters on 
page 260
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Fast Search

Personal Call Manager does a fast search if you have 
chosen the Fast Search option in the Search Preferences. 
Refer to Search preferences on page 128 for more 
information.

To find a contact:

1 Click on , or click on the Tools menu and then 
click on the Find Person menu item. The Search dia-
log box appears.

2 Enter the first character of the last name or telephone 
number of the contact you want to find exactly as it is 
in the Address Book (including the plus sign and 
brackets, e.g., “+1 (555)”). Personal Call Manager 
compares the letter or number you entered to the 
contacts stored in the Address Book. Any contacts that 
match the character you entered appear in the bottom 
area of the Search dialog box. 

continued...
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If you have several contacts starting with that 
character, enter the next character in the name or 
telephone number. Personal Call Manager then 
displays only the contacts that match both of those 
characters. 

3 Continue entering characters or use the scroll bar to 
find the contact in the Search dialog box.

4 Click on the name of the contact you want.

5 Click on the OK button. The folder containing the 
contact opens and the selected contact is highlighted.

For more information, refer to the following topics:

■ Slow Search on page 255

■ Searching based on a contact’s first or last 
name on page 259

■ Searching using wildcard characters on 
page 260
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Searching based on a contact’s first or last 
name

There are times when you know only part of the name or 
telephone number of the contact you want to find. When 
this happens, you can enter the letters or digits you know 
and the Search feature will find all of the contacts that 
match the information you entered. You can then select 
the contact you were looking for from a list. 

Names are stored in the format, “last name, first name”. 
If you know the starting letter of the last name, simply 
enter it into the field below the “Enter Phone Number or 
Name (Last Name, First Name)” label. (If you are using the 
Slow Search option, click on the Find Now button.) 
Personal Call Manager finds all of the contacts that start 
with the letters or digits you entered.

If you only remember the contact’s first name, enter a 
comma followed by the contact’s first name. For example, 
if you are looking for a contact named Tom, enter 
“,Tom”. All of the contacts whose first name is Tom 
appear.
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Searching using wildcard characters

If the portion you know is not at the start of the first or 
last name, you can use “wild card” characters at the start 
of the name or number. There are two wild card 
characters you can use.

For example, the following names were added to the 
Address Book:

Chatterton, Jones, Mason, Smith, Stanley, Steward, 
Washington

■ If you enter “S” the names that are found are Smith, 
Stanley and Steward.

■ If you enter “Ste” the only name that is found is 
Stewart.

■ If you enter “?a” the names that are found are 
Mason and Washington.

■ If you enter “??a” the names that are found are 
Chatterton and Stanley.

■ If you enter “*a” the names that are found Chatter-
ton, Mason, Stanley, Steward, and Washington.

? Use the question mark to represent any single 
character.

* Use the asterisk to represent any characters that 
precede the characters you entered.
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Handsfree calls

You can use the Handsfree speaker instead of the handset 
to make or answer a call. You can also switch to 
Handsfree while a call is in progress.

To make a Handsfree call:

1 Press © or ¬.

2 Enter the number using the dialpad.

When the call is over, press ®.

To answer a call in Handsfree mode, press © or 
the applicable line key (¬).

To switch to Handsfree mode when you are on a call, 
press © and return the handset to the handset 
cradle (i.e., hang up the handset).

To turn off the Handsfree speaker, lift the handset.

All calls you make or answer using Personal Call Manager 
are automatically in Handsfree mode.

You can use a headset instead of using the handset or the 
Handsfree speaker. For more information, refer to Using 
a headset on page 238.

For more information, refer to Muting a Handsfree call 
on page 262.
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Muting a Handsfree call

You can turn off the Handsfree microphone when you are 
in Handsfree mode so that the caller can’t hear you but 
you can still hear the caller. Muting a call only works 
when you are in Handsfree mode.

To mute a Handsfree call:

1 Press ©. The light beside © flashes 
and the telephone display shows Microphone muted. 
You can hear your caller but your caller cannot hear 
you.

2 To speak to your caller, press © again. Each 
time you press ©, you turn the microphone 
on or off.

For more information, refer to Handsfree calls on 
page 261.
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Answering calls

You can answer a call using either the 9617 telephone or 
Personal Call Manager.

For more information, refer to the following topics:

■ Answering a call using your telephone on 
page 264

■ Answering a call using Personal Call Manager 
on page 271

■ Handsfree calls on page 261
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Answering a call using your telephone

Caller ID information is sent from the telephone company 
to your 9617 telephone between the first and second ring 
(if you subscribe to the Caller ID service from your 
telephone company).

If you want the name and number of the incoming call to 
appear on the display and in the Callers List, answer the 
telephone after the second ring.

There are several ways to answer a call using the 9617 
telephone depending on the type of call.

To answer a telephone call:

1 Lift the handset, press © or press the 
¬ key for the line you want to answer.

If you lift the handset or press © when both lines 
are ringing, the line that is answered depends on the 
answer mode option you have chosen. To change which 
line is answered first, refer to Selecting the answer 
mode on page 270.

For more information, refer to the following topics:

■ Answering a call on the other line on page 265

■ Answering a Call Waiting call using the tele-
phone on page 266

■ Selecting the answer mode on page 270
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Answering a call on the other line

If you are on one telephone line and a call comes in on 
the other line, the following will happen:

■ you will hear the telephone ring

■ the line indicator light will flash beside the line that is 
ringing

■ an arrow (->) will appear on the telephone display

To see the Caller ID of the incoming call, press ‘.

To answer the call, press the line key of the line that is 
ringing (the current call is put on hold).

For more information, refer to the following topics:

■ Answering a call using your telephone on 
page 264

■ Answering a Call Waiting call using the tele-
phone on page 266
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Answering a Call Waiting call using the 
telephone

The 9617 telephone can display Call Waiting ID for Call 
Waiting calls. (You must subscribe to your telephone 
company for the Call Waiting ID service.) 

Note: The Call Waiting ID option must be turned on for 
Call Waiting ID information to appear on the telephone 
display. This option is enabled by default. For more 
information, refer to Choosing the Call Waiting ID 
option on page 268.

When you receive a Call Waiting call:

■ you hear the Call Waiting beep, and

■ Call Waiting ID appears as shown below (if you sub-
scribe to your telephone company to the Call Waiting 
ID service).

continued...

Original caller's 
identification 
is displayed.



CALLER ONE555-1234

CALLER ONE555-1234

 

When you hear the 
Call Waiting tone, the 
Call Waiting caller's 
identification is displayed.

CALLER ONE555-1234

CALLER TWO555-5678
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To speak to the Call Waiting caller:

■ Press ˚. (Your first call will not be discon-
nected.) 

To switch between callers:

■ Press ˚. (You may switch between callers as 
often as you want.)

Note: When you press ˚ and see a caller’s 
Identification information but only hear a dial tone, it 
means that the caller has hung up.

If you decide not to answer the Call Waiting call, the 
caller’s ID is stored in the Callers List.

Call Waiting and Personal Call Manager

In Personal Call Manager, Call Waiting calls appear the 
same as normal calls. You answer them both the same 
way. For more information, refer to Answering a call 
using Personal Call Manager on page 271.

Note: After you answer a Call Waiting call, you will see 
two calls in the Calls box, one for the original call, and 
one for the Call Waiting call. When you are finished 
talking to one caller, simply select the other caller by 
double-clicking on his/her icon. Do not try to release the 
caller you are finished with. If you right-click on either call 
icon and choose the Release menu item, both callers 
disappear.

For more information, refer to the following topics:

■ Answering a call using your telephone on 
page 264

■ Answering a call on the other line on page 265
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Choosing the Call Waiting ID option

You use the Call Waiting ID option to turn the display of 
Call Waiting ID on or off. You choose the Call Waiting 
Option for Line 1 and Line 2 independently.

When Call Waiting ID is on

When you receive a Call Waiting call and the Call Waiting 
ID option is on, you’ll see the name and number of the 
Call Waiting caller on the telephone display and in 
Personal Call Manager. (In Personal Call Manager, Call 
Waiting callers appear in the Calls box the same way 
regular calls do.)

Note: You will not receive Call Waiting ID when an 
extension telephone (another telephone in your house or 
business) is using the same telephone line.

When Call Waiting ID is off

You can also choose to suppress the display of Call 
Waiting ID by turning the Call Waiting ID option off. 
When the Call Waiting display is turned off, you still hear 
the Call Waiting tone when a Call Waiting call comes in, 
but the identification information for the Call Waiting 
caller does not appear on your telephone display screen. 

Note: Turning the Call Waiting ID option on or off does 
not turn the Call Waiting feature itself on or off. It only 
determines whether Call Waiting ID information appears 
on the telephone display. To unsubscribe from the Call 
Waiting feature, contact your telephone company.

continued...
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To turn the display of Call Waiting ID on or off using 
the telephone: 

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 8 or press 
‚ °.

4 Press •.

5 Press ¬.

6 Press • to turn Call Waiting ID on, or press £ to 
turn it off. 

7 Press ®.

You can also turn the display of Call Waiting ID on or off 
using Personal Call Manager. For more information, refer 
to The Line tab on page 93.

Disabling the Call Waiting feature for a single call

To disable the Call Waiting feature temporarily before 
making a call, contact your telephone company to obtain 
the code that must be dialed. You can specify this code in 
the Dialing Properties dialog box. Refer to The Dialing 
Properties dialog box on page 126 for more 
information.
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Selecting the answer mode

When you select the answer mode, you are choosing 
which line will be answered when both lines are ringing 
and you lift the handset or press ©.

Select Answr prime (default setting), if you want the 
telephone to automatically answer the prime line first 
when both lines are ringing and you lift the handset or 
press ©. Refer to Changing the prime line on 
page 240 for information on how to choose which line is 
the prime line.

Select Answr longest, if you want the telephone to 
automatically answer the line that began ringing first 
when both lines are ringing and you lift the handset or 
press ©.

To select the answer mode:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 11 or press 
⁄ ⁄.

4 Press • to change the answer mode.

5 Press £ to choose to answer the Prime line, or • to 
choose to answer the longest ringing line. A check-
mark indicates the current selection.

6 Press ®.
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Answering a call using Personal Call 
Manager

Personal Call Manager simplifies multiline interactions. It 
treats Call Waiting callers as if they had their own line, 
and allows you to answer them without pressing 
˙ or ˚ on the telephone.

Note: Calls answered using Personal Call Manager are 
always in Handsfree mode.

For more information, refer to the following topics:

■ Caller ID and Personal Call Manager on 
page 272

■ Answering a call using the You Have a New 
Call dialog box on page 276

■ Displaying who is calling from the task tray on 
page 274

■ Answering a call using the task tray or Calls 
menu on page 283

■ Handsfree calls on page 261
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Caller ID and Personal Call Manager

When someone calls you, the You Have a 
New Call dialog box appears at the bottom 
right of your computer screen, and one of the 
Ringing icons (shown on the right) appears in 
the Calls box, the Personal Call Manager task 
tray menu and the Calls menu. (See 
Answering a call using the You Have a New Call 
dialog box on page 276.)

When you make or receive a call, an icon appears in the 
Calls box, Calls menu, and Personal Call Manager task 
tray menu. You may also see the name of the contact, 
hear an audible Call Announcement, or see a picture of 
the contact.

■ Caller ID and name match on page 273

■ Call Announcements that tell you who is call-
ing on page 180.

■ Using graphics to identify callers on page 184.
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Caller ID and name match

If you subscribe to a Caller ID service, Personal Call 
Manager compares the number it receives from the 
telephone company with the numbers stored in the 
Address Book when you receive a call.

What appears 

■ beside the call icon

■ in the You Have a New Call dialog box, and

■ on the telephone display

depends on whether a number match is found.

When a match is found - Address Book name 
matching

The name matching feature allows you to identify your 
contacts with a name or nick name you prefer, rather 
than with the name provided by the telephone company. 
If a match is found, the name from the Address Book 
appears.

Note: If you want name matching to work, do not enter 
dashes in the telephone numbers saved in your Address 
Book.

When a match is not found

If a match is not found, the name or number of the caller 
supplied by the telephone company appears.

If no Caller ID is available or you do not subscribe to the 
Caller ID service from your telephone company, then the 
word “Unknown” appears in Personal Call Manager. In 
this case, the telephone display only tells you which line is 
calling.
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Displaying who is calling from the task tray

When you click on the Personal Call Manager icon in the 
task tray, the current calls appear in the top half of the 
menu. (See The task tray icon on page 55.)

If you subscribe to the Caller ID and Call Waiting ID 
service, the name or number of the caller appears beside 
the icon. To perform a function on one of the current 
calls, point at the name or number of the caller and a 
menu appears.

If you point to a call in this menu, a submenu appears 
allowing you to control it (i.e., answer, hold or release it). 
For more information, refer to The task tray menu on 
page 56.
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Answering a call from the main window

In Personal Call Manager, regular calls and Call Waiting 
calls appear the same in the Calls box. You also answer 
them both the same way. If you answer a call while you 
are on another call, the original call will be put on hold.

To answer a regular or Call Waiting call:

1 Double-click on the Ringing icon (both ver-
sions are shown on the right) in the Calls 
box. The call icon changes to the Active Call 
icon and the call is answered.

OR

1 Right-click on the Ringing icon in the Calls box. 

2 Click on the Answer menu item.

Tip: If you right-click on a caller in the Calls box and then 
click on the Properties menu item, the Address 
Properties dialog box appears showing the Note tab if 
that caller is already stored in the Address Book. When 
the Note tab appears, you can click in the text area and 
begin typing notes. If the caller is not stored in the 
Address Book, you are given the option of adding the 
caller to the Address Book. For more information, refer to 
Note on page 188.

Note: After you answer a Call Waiting call, you will see 
two calls in the Calls box, one for the original call, and 
one for the Call Waiting call. When you are finished 
talking to one caller, simply select the other caller by 
double-clicking on his/her icon. Do not try to release the 
caller you are finished with. If you right-click on either call 
icon and choose the Release menu item, both callers will 
disappear.
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Answering a call using the You Have a New 
Call dialog box

Personal Call Manager displays the You Have a New Call 
dialog box when you receive a call. This dialog box 
displays the available caller information. It also displays a 
picture if you have specified the location of one for that 
caller in the Directory. For more information, refer Using 
graphics to identify callers on page 184.

To answer a call using the You Have a New Call 
dialog box, click on the Answer button on the 
toolbar (shown on the right).

Note: The Close Window button (on the top right corner 
of the window) only closes the You Have a New Call 
dialog box, it does not hang up the call. 

To view this dialog box after you have closed it:

1 Right-click on the icon of the call in the Calls box you 
want to see the dialog box for.

2 Click on the Monitor menu item.

continued...
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Tip: If you right-click on a caller in the Calls box and then 
click on the Properties menu item, the Address 
Properties dialog box appears showing the Note tab if 
that caller is already stored in the Address Book. When 
the Note tab appears, you can click in the text area and 
begin typing notes. If the caller is not stored in the 
Address Book, you will be given the option of adding the 
caller (see Note on page 188).

For more information, refer to the following topics:

■ Using the You Have a New Call dialog box on 
page 278

■ Caller ID and name match on page 273
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Using the You Have a New Call dialog box

The toolbar on this dialog box allows you to manage your 
telephone calls. Each toolbar button applies to the call 
displayed in the dialog box. To perform an action, click on 
its corresponding toolbar button.

To view this dialog box after you have closed it:

1 Right-click on the icon of the call you want to see the 
dialog box for.

2 Click on the Monitor menu item.

You Have A New Call toolbar buttons  (page 1 of 2)

Button Feature Description

Answer Answers the incoming call.

Release Hangs up (releases) the tele-
phone call.

Hold Puts the telephone call on 
hold.

Unhold Takes the held telephone call 
off hold.
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Properties Displays the Address Proper-
ties dialog box for the call. It 
allows you to add an entry for 
the caller to the Address Book, 
or modify an existing entry for 
the caller.

You Have A New Call toolbar buttons  (page 2 of 2)

Button Feature Description
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Switching calls using Personal Call Manager

Personal Call Manager can control four calls at once, two 
calls – one regular call and one Call Waiting call – on each 
line. In Personal Call Manager, there is no apparent 
difference between regular calls and Call Waiting calls. 
They are both handled the same.

Note: If you subscribe to your telephone company for the 
Three Way Calling service, you will be able to conference 
two regular callers on one line.

All current calls appear on the Personal Call Manager task 
tray menu, the Calls menu, and the main window. (See 
The task tray icon on page 55.)

Although four calls can be controlled, only one call can be 
active at any time, unless you have a conference call, in 
which case you can have two active calls. (Refer to 
Conference calls on page 291.)

When you answer a held call, the currently active call is 
automatically put on hold. This allows you to switch 
between held calls simply by answering the caller you 
want to talk to.

For more information, refer to the following topics:

■ Switching between calls on the main window 
on page 281

■ Switching between calls using the task tray 
and Call menus on page 282
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Switching between calls on the main 
window

On the main window, the currently connected 
calls are shown in the Calls box. The currently 
active call shows the Active Call icon (shown on 
the right), while the rest of the calls show the 
Held Call icon.

To switch to a different call:

1 Double-click on the icon of the caller you want to talk 
to. The call you clicked on becomes the active call and 
the other call is put on hold.

OR

1 Right-click on the icon of the caller you want to talk 
to. 

2 Click on the UnHold menu item. The call you clicked 
on becomes the active call and the other call is put on 
hold.
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Switching between calls using the task tray 
and Call menus

On the Personal Call Manager task tray menu 
and the Calls menu, the currently connected calls 
appear at the top of the menu. The currently 
active call shows the Active Call icon (shown on 
the right), while the rest of the calls show the Held Call 
icon. 

To switch to a different call:

1 Click on the task tray icon or Calls menu. (See The 
task tray icon on page 55.)

2 Point to the caller you want to talk to. A submenu 
appears.

3 Click on the UnHold menu item. The call you clicked 
on becomes the active call and the other call is put on 
hold.
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Answering a call using the task tray or Calls 
menu

To answer a call:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to the call. A submenu appears.

3 Click on the Answer menu item.

Tip: If you right-click on a caller in the Calls box and then 
click on the Properties menu item, the Address 
Properties dialog box appears showing the Note tab if 
that caller is already stored in the Address Book. When 
the Note tab appears, you can click in the text area and 
begin typing notes. If the caller is not stored in the 
Address Book, you are given the option of adding the 
caller. For more information, refer to Note on page 188.
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Holding and unholding calls

You can hold and unhold calls using either the telephone 
or Personal Call Manager.

For more information, refer to the following topics:

■ Putting a call on hold using your telephone on 
page 285

■ Unholding a call using your telephone on 
page 286

■ Putting a call on hold using Personal Call Man-
ager on page 287

■ Unholding a call using Personal Call Manager 
on page 288
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Putting a call on hold using your telephone

To put a call on hold:

1 Make or answer a call.

2 Press ˙. The telephone display shows that 
the call is on hold on line x and that line indicator light 
flashes.

3 Return the handset to the handset cradle (i.e., hang 
up the handset).

You won’t lose the call if you hang up the handset.

Note: The 9617 automatically takes a held call off hold 
when a person on an extension telephone answers it. If 
you don’t hang up the handset after you have put a call 
on hold and that call is picked up by someone at another 
extension, the call is taken off hold but remains 
connected to your telephone. If this happens, any 
background noise from your area will be heard by the 
caller and the person at the other extension.
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Unholding a call using your telephone

To retrieve a held call:

1 Press ¬. If you don’t retrieve the call within 
15 minutes, the call is automatically dropped.

Note: The 9617 automatically takes a held call off hold 
when a person on an extension telephone answers it.
286



Putting a call on hold using Personal Call 
Manager

When a call is put on hold, the icon for the call changes 
from the Active Call icon to the Held Call icon. For 
information about the various icons, refer to The task 
tray menu on page 56 and Current Calls icons on 
page 69.

Using the main window:

1 Make or answer the call.

2 Right-click on the icon of the call in the Calls box. A 
menu appears.

3 Click on the Hold menu item.

Using the task tray or Calls menu:

1 Make or answer the call.

2 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

3 Point to the call you want to put on hold. A submenu 
appears.

4 Click on the Hold menu item.

Tip: You can also put a call on hold by clicking 
the Hold button on the toolbar (shown on the 
right) on the You Have A New Call dialog box.

For information on putting a conference call on hold, 
refer to Putting a conference call on hold on 
page 299.
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Unholding a call using Personal Call Manager

To retrieve a held call using the main window:

1 Right-click on the icon of the call in the Calls box.

2 Click on the UnHold menu item.

To retrieve a held call using the task tray or Calls 
menu:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to the caller you want to talk to. A submenu 
appears.

3 Click on the UnHold menu item.

Tip: You can also double-click the call to take it off hold.

OR

You can take a call off hold by clicking the Unhold 
button on the toolbar (shown on the right) on the 
You Have A New Call dialog box.

For information on taking a conference call off hold, refer 
to Taking a conference call off hold on page 300.
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Hanging up

Using the 9617 telephone

Press ® or hang up the handset.

Using the main window in Personal Call Manager:

1 Right-click on the icon of the call in the Calls box. A 
menu appears

2 Click on the Release menu item.

Using the task tray or Calls menu in Personal Call 
Manager:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to the call you want to disconnect. A submenu 
appears.

3 Click on the Release menu item.

Using the keyboard and Personal Call Manager:

To hang up a call using the keyboard, the Personal Call 
Manager main window must be visible.

1 Click on the icon of the call in the Calls box. (Ensure a 
contact in the Address Book is not selected or it will be 
deleted when you do step 2.

2 Press the Delete key on your PC keyboard.

Note: If you accidently delete a contact (instead of a call), 
click on the Edit menu and then on the Undo menu 
item.

Tip: You can also hang up a call by clicking on the 
Release button (shown on the right) on the You 
Have a New Call dialog box toolbar, or on the 
Calls box toolbar.
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continued...

When you have Call Waiting calls

If you receive a Call Waiting call, you will see two calls in 
the Calls box, one for the original call, and one for the 
Call Waiting call. When you are finished talking to one 
caller, simply select the other caller by double-clicking on 
his/her icon. Do not try to release the caller you are 
finished with. If you right-click on either call icon and 
choose the Release menu item, both callers disappear.
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Conference calls

You can create a conference call using the 9617 
telephone or Personal Call Manager.

When you subscribe to Three Way Calling from your 
telephone company, you can have conference calls with 
up to three other callers (refer to Telephone network 
services you should subscribe to on page 22).

For more information, refer to the following topics:

■ Making conference calls on page 292

■ Making a Three Way Call on page 297

■ Putting a conference call on hold on page 299

■ Taking a conference call off hold on page 300

■ Splitting a three-call conference call on 
page 301

■ Hanging up conference calls on page 304
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Making conference calls

You can make two kinds of conference calls, a three-call 
conference (you plus two other callers) and a four-call 
conference (you plus three other callers).

When you make a three-call conference, you are 
connecting yourself with one caller on Line 1 and another 
caller on Line 2.

When you make a four-call conference, you are 
connecting yourself with two callers on one line, and one 
caller on the other line. To have two callers on one line, 
you must subscribe to the Three Way Calling service from 
your telephone company.

You can create either kind of conference using the 9617 
telephone or using Personal Call Manager.

For details on the icons that appear in the Conference 
box, refer to Current Calls icons on page 69.

For more information, refer to the following topics:

■ Making a conference call using your telephone 
on page 293

■ Making a conference call in Personal Call Man-
ager on page 295
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Making a conference call using your 
telephone

A three-call conference

When you make a three-call conference, you are 
connecting yourself with one caller on Line 1 and another 
caller on Line 2.

To make a three call conference:

1 Make or answer a call on one line.

2 Make or answer a call on the second line.

3 Once you have callers on both lines, press ç.

A four-call conference

When you make a four-call conference, you are 
connecting yourself with two callers on one line, and one 
caller on the other line. To have two callers on one line, 
you must subscribe to the Three Way Calling service from 
your telephone company.

To make a four-call conference:

1 Make a Three Way call on one line by following these 
steps:

■ Call one person on one line.

■ After that person answers, press the ˚ key.

■ Call another person by dialing their number and then 
press the ˚ key again. You now have a 
Three Way call.

2 Make a call on the other line.

continued...
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3 Press the ç key to conference the two lines 
together. You can now talk to all three callers at once.
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Making a conference call in Personal Call 
Manager

A three-call conference

When you make a three-call conference, you connect 
yourself with one caller on Line 1 and another caller on 
Line 2.

To make a three-call conference:

1 Make or answer two calls you want to connect in a 
conference call.

2 Drag the icon of the first call from the Calls box to the 
Conference box.
OR
Right-click on the icon of the first call in the Calls box 
and then click on the New Conf menu item.

3 Drag the icon of the second call in the Calls box on 
top of the icon in the Conference box.
OR
Right-click on the icon of the second call in the Calls 
box and click on the Conference menu item. The 
icons for the two calls change to the Conference 
icons.

A four-call conference

When you make a four-call conference, you connect 
yourself with two callers on one line, and one caller on 
the other line. To have two callers on one line, you must 
subscribe to the Three Way Calling service from your 
telephone company. It does not matter what order you 
make the calls in.

continued...
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To make a four-call conference:

1 First, make a Three Way call on one line by following 
these steps:

■ Either drag a call icon from the Calls box to the Con-
ference box, or if you don’t have an active call, drag a 
contact from the Address Book to the Conference 
box.

■ Drag another contact from the Address Book on top 
of the icon in the Conference box. You now have a 
Three Way call.

2 Make a call on the other line by dialing manually or 
dragging a contact from the Address Book into the 
Calls box. The call icon appears in the Calls box.

3 Right-click on the call in the Calls box.

4 Click on the Add to Conf 1 menu item. The call icon 
moves to the Conference box and joins the confer-
ence.
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Making a Three Way Call

Three Way Calling

When you subscribe to the Three Way Call service from 
your telephone company, you can create a telephone 
network conference call with two callers on one line of 
the 9617 telephone.

When attempting to make a Three-Way call, make sure 
you use the line that has the Three-Way call service.

Tip: You can conference a Three-Way call on one line 
with a call on your other line to create a four-call 
conference. For more information, refer to Making 
conference calls on page 292.

Using the 9617 telephone

1 Call one person on one line.

2 After that person answers, press the ˚ key.

3 Call another person by dialing their number and then 
press the ˚ key again. You now have a Three 
Way call.

Using Personal Call Manager

1 Either drag a call icon from the Calls box to the Con-
ference box, or if you don’t have an active call, drag a 
contact from the Address Book to the Conference 
box. Wait until the call is answered.

continued...
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2 Drag another con-
tact from the 
Address Book on 
top of the call 
icon in the Con-
ference box. The 
Add to Confer-
ence dialog box 
appears.

3 When the contact answers, click on the OK button to 
complete the Three Way call. 
Note: If the contact does not answer, click on the 
Drop button to cancel the Three Way call and return 
to your first call.
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Putting a conference call on hold

You put any type or size of conference call on hold in the 
same way. 

Using the 9617 telephone:

1 Press ˙ on the 9617 telephone. The line indi-
cator lights flash to indicate that the calls are on hold.

Using the main window in Personal Call Manager:

1 Right-click one of the calls in the Conference box. A 
menu appears.

2 Click on the HoldConf menu item. All calls are put on 
hold and the call icons change to Held Conference 
icons.

Using the task tray or Calls menu in Personal Call 
Manager:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to one of the calls in the conference. A submenu 
appears.

3 Click on the HoldConf menu item. All calls are put on 
hold and the call icons change to the Held Conference 
icons.

For more information, refer to Taking a conference call 
off hold on page 300.
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Taking a conference call off hold

Using the 9617 telephone:

1 Press ç.

Using the main window in Personal Call Manager:

1 Right-click one of the calls in the Conference box. A 
menu appears.

2 Click on the UnHoldConf menu item.

All calls in the conference become active and the icons 
change to the Conference icons.

Using the task tray or Calls menu in Personal Call 
Manager:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to one of the calls in the conference. A submenu 
appears.

3 Click on the UnHoldConf menu item.

All calls in the conference become active and the icons 
change to the Conference icons.

For more information, refer to Putting a conference call 
on hold on page 299.
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Splitting a three-call conference call

When you split a three-call conference, one of the callers 
becomes the active call and the other caller is put on 
hold.

Using the 9617 telephone

1 Press the line key ¬ of the caller you want to 
speak to. The conference call is split and the other 
caller is put on hold. 

Using Drag and Drop in Personal Call Manager:

1 Drag one of the icons out of the Conference box. The 
call whose icon you removed from the Conference box 
becomes active, and the other call moves to the Calls 
box and is put on hold.

Using the right mouse button in Personal Call Man-
ager:

1 Right-click on the icon of the caller you want to speak 
to in the Conference box. A menu appears.

2 Click on the Split Conf menu item.The icons for both 
calls are moved to the Calls box.The caller you selected 
becomes the active call while the other caller is put on 
hold. 

Using the task tray or Calls menu in Personal Call 
Manager:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to the icon of the caller you want to speak pri-
vately to. A submenu appears.
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3 Click on the Split Conf menu item. The icons for both 
callers are moved to the Calls box. The caller you 
selected becomes the active call while the other caller 
is put on hold.
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Splitting a four-call conference call

When you are on a four-call conference, one line has two 
callers and the other has just one caller. When you split a 
conference, the caller(s) on one line remain active so you 
can still talk to them, and the other caller(s) is (are) put on 
hold.

Using the 9617 telephone:

1 Press the line key of the caller(s) you want to speak pri-
vately to.

Using Personal Call Manager:

1 Drag the call icon of the single caller (the caller that is 
alone on one line) to the Calls box.

OR

1 Right-click on the single caller and click on the 
Release from Conf menu item. The single caller’s 
icon moves to the Calls box and becomes active and 
the icon of the other callers changes to the held con-
ference icon.
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Hanging up conference calls

Using the 9617 telephone:

1 Press ®.

Using the main window in Personal Call Manager:

1 Right-click on one of the icons in the Conference box. 
A menu appears.

2 Click on the Release Conf menu item. The confer-
ence is ended.

Using the task tray or Calls menu in Personal Call 
Manager:

1 Click on the Personal Call Manager task tray icon or 
Calls menu. (See The task tray icon on page 55.)

2 Point to the icon of one of the calls in the conference. 
A submenu appears.

3 Click on the Release Conf menu item. The confer-
ence is ended.

Tip: You can also click on the conference and use 
the Delete key on the computer keyboard to hang 
up a conference call, or the Release Conference 
Call button on the Conference box toolbar (shown on the 
right).
304



Advanced features
■ Sending your calls to your pager on page 306

■ Screening your telephone calls on page 312

■ The Don’t Disturb feature on page 322

■ Using the Quick Dial Manager on page 331

■ Using Calls Logs and lists on page 333

■ Using feature keys for network telephone ser-
vices on page 356

■ Timing the length of your calls on page 364

■ Redialing busy telephone numbers automati-
cally on page 370

■ Stripping area codes from numbers in the tele-
phone Callers List on page 375

■ Restricting the telephone numbers that can be 
dialed on page 378

■ Preventing the telephone numbers you dial 
from appearing on the M9617 telephone dis-
play on page 383

■ Printing your Address Book on page 386

■ Importing and exporting contacts on page 191

■ Connecting a fax machine or modem to the 
telephone on page 387

■ Uninstalling Personal Call Manager on page 391
--------------------

■ The Voice Mail Assistant on page 392

■ The Launch Pad application on page 394
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Sending your calls to your pager

The Pager feature sends the Caller ID of your calls to your 
Pager service, if you have one.

How it works once it is set up

When your telephone receives a call, it sends the 
telephone number of that call (supplied by Caller ID) to 
your pager. The telephone number will be proceeded by 
three zeros. You are paged even if the telephone call is 
answered by someone using an extension telephone or by 
an answering machine. (Note that if the call is answered 
using the 9617 telephone, the Caller ID won’t be sent to 
your pager.)

Note: If the Caller ID of the caller is “unknown” or 
“private” (i.e., no telephone number is provided), only 
three zeros are sent to your pager.

Setting up the Pager feature

There are three steps to setting up the Pager feature:

1 Log all calls for the line you want to activate the Pager 
feature for in the Callers List. For more information, 
refer to About the Callers List and the Pager fea-
ture on page 337 or the “Callers Display” option 
under the topic, The Line tab on page 93.

2 Enter your Pager settings. For more information, refer 
to Entering your Pager settings on page 307.

3 Enable the Pager feature by turning on the Enable 
Pager Notification option (refer to Enabling the 
Pager feature on page 308). You can also enable the 
pager for certain contacts only (refer to Pager Notifi-
cation for Quick Dial and memory key contacts on 
page 310).
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Entering your Pager settings

Note: Before following the steps on this page, make sure 
you have read Sending your calls to your pager on 
page 306.

To configure the Pager feature:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure button. The 9617 Configura-
tion Properties dialog box appears.

4 Click on the Feature tab.

5 Enter your pager settings in the Pager Notification 
Options box. For more information on these options, 
refer to Pager Notification Options on page 104.
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Enabling the Pager feature

By enabling the pager feature, you are specifying which 
incoming calls you want sent to your pager. 

Note: Before following the steps on this page, make sure 
you have read Sending your calls to your pager on 
page 306.

Turning on the Enable Pager Notification option

You need to specify which calls you want sent to your 
pager. You can specify the incoming calls on Line 1, on 
Line 2, on both Line 1 and Line 2, or calls from certain 
contacts in memory keys or the Directory/Quick Dials 
folder.

To enable the Pager feature for a line:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure button. The 9617 Configura-
tion Properties dialog box appears.

4 Click on the Line tab.

5 Select the Line you want to enable Pager notification 
for.

6 Select the Enable Pager Notification checkbox. A 
checkmark appears in the checkbox when it is 
selected. To enable Pager Notification for another line, 
repeat steps 5 and 6.

7 Click on the OK button.
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Refer to Pager Notification for Quick Dial and 
memory key contacts on page 310 for instructions on 
how to enable the Pager feature for certain contacts.
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Pager Notification for Quick Dial and 
memory key contacts

If you have disabled Pager notification on both lines, you 
can still have calls from specified contacts stored in your 
Directory/Quick Dials folder or memory keys sent to your 
pager.

To be paged by contacts in memory keys or the Quick 
Dials folder, you must set the Callers List in the telephone 
to the “All Calls” option for the line(s) you expect the 
calls to come in on. (If you are going to use this approach, 
it is recommended that you select the “All Calls” option 
for both lines 1 and 2.) For more information, refer to 
Setting up the Callers List on page 336.

Note: Before following the steps on this and the next 
page, refer to Sending your calls to your pager on 
page 306.

For your contacts stored in the Quick Dials folder:

1 Right-click a contact in the Quick Dials folder.

2 Point to the 9617 Options menu item. A submenu 
appears.

3 Click on the 9617 Properties menu item. The 9617 
Property dialog box appears.

4 Select the Pager Notification checkbox. A check-
mark appears in the checkbox when it is selected.

5 Click on the OK button.
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Tip: You can use the Quick Dials Manager to view and/
or change the Ring Configuration settings for all of your 
Quick Dials on one dialog box. For more information, 
refer to Using the Quick Dial Manager on page 331.

For contacts stored in memory keys:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure button. The 9617 Configura-
tion Properties dialog box appears.

4 Click on the Memory Keys Assignment tab.

5 Select the contact you want to set Pager Notification 
for.

6 Click the Configure button.

7 Select the Pager Notification checkbox. A check-
mark appears in the checkbox when it is selected.

8 Click on the OK button.
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Screening your telephone calls

There are several ways to screen your calls. You can 
prevent your telephone from ringing for certain calls, or 
specify a special ring for certain calls so you can more 
easily identify them.

Regardless of the method you choose, it is highly 
recommended that you enable the Suppress First Ring 
option. For information about this option, refer to About 
the Suppress First Ring option on page 313.

For information on the ways you can screen your calls, 
choose a topic below.

■ Using a Special Ring to identify callers on 
page 314

■ Blocking “Unknown” callers on page 315

■ Blocking “Private” callers on page 316

■ Blocking specified Quick Dial contacts on 
page 317

■ Blocking specified Memory key contacts on 
page 319

■ Accepting calls only from specified contacts on 
page 320

■ Identifying long distance calls with a special 
ring on page 321
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About the Suppress First Ring option

It is recommended that you enable the Suppress First 
Ring option if you intend to screen your calls.

The call screening features of the 9617 telephone and 
Personal Call Manager require Caller Identification (Caller 
ID) information to work. However, Caller ID information 
isn’t sent to your telephone until after the first ring.

When you enable the Suppress First Ring option, the 
9617 telephone does not ring until it has received the 
Caller ID information. (While the telephone doesn’t ring, 
the call light still flashes and the call information is 
displayed for a few moments before the phone rings).

For information on how to enable this option, refer to the 
“General tab” subtopic on The M9617 Configuration 
Properties dialog box on page 92.
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Using a Special Ring to identify callers

You can assign a special ring tone to identify certain 
callers stored in the Quick Dials folder and in Memory 
keys.

For information on how to enable this option, refer to 
About Ring Configuration settings for Quick Dials 
contacts on page 161 and Specifying Ring 
Configuration properties for contacts stored in 
memory keys on page 155.
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Blocking “Unknown” callers

Enabling the Block Unknown Call option blocks all calls 
that have a Caller ID of “unknown.” A caller will be listed 
as “unknown” if the telephone company has no 
information for them. Blocked calls rings once, unless you 
have enabled the Suppress First Ring option.

For information on how to enable this option, refer to the 
“General tab” subtopic on The M9617 Configuration 
Properties dialog box on page 92.
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Blocking “Private” callers

Callers can request that their ID be listed as “private” by 
the telephone company. 

When you enable the Block Private Call option, Personal 
Call Manager blocks all calls that have a Caller ID of 
“private.” Blocked calls ring once, unless you have 
enabled the Suppress First Ring option.

For information on how to enable this option, refer to the 
“General tab” subtopic on The M9617 Configuration 
Properties dialog box on page 92.
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Blocking specified Quick Dial contacts

Calls may be blocked using the Personal Call Manager 
Quick Dial Manager window.

To block specified Quick Dial contacts:

1 Click on the 9617 Options menu and click on the 
Quick Dial Manager... menu item.

OR

Click on the Quick Dial Manager button on the 
toolbar (shown on the right). The Quick Dial 
Manager appears.

2 Click on the contact you want to block.

3 Click on the Edit menu.

4 Click on the Properties menu item. The 9617 Prop-
erty dialog box appears.

5 Select the Never Ring option. (This option is selected 
when a check mark appears in the checkbox beside it.)

6 Click the OK button. Changes to contacts are 
reflected in the Quick Dial Manager window.

Tip: You can access the 9617 Property dialog box in 
several other ways:

1 In the Personal Call Manager main window, right-click 
on the Quick Dial contact you want to change. A 
menu appears.

2 Click on 9617 Options menu item.

3 Click on the 9617 Properties menu item.

OR

continued...
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1 Click on the Quick Dial contact you want to change.

2 Click on the 9617 Property Page button on 
the toolbar (shown on the right).
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Blocking specified Memory key contacts

Once you have saved a contact into a memory key, you 
can prevent the telephone from ringing when that 
contact calls. To see how to save a contact into a memory 
key, refer to Memory keys and the M9617 telephone 
on page 146.

To block calls from contacts stored in memory keys:

1 Click on the Tools menu.

2 Click on the Dial Using menu item.The Choose a 
TAPI Line dialog box appears.

3 Click on the drop list arrow beside the TAPI Line field.

4 Click on 9617.

5 Click on the Configure Line button.

6 If required, type the Options List password.

7 Click on the OK button. The 9617 Configuration 
Properties dialog box appears.

8 Click on the Memory Keys Assignment tab.

9 Click on the radio button that corresponds to the con-
tact you want to block.

10 Click on the Configure button. The Auto Dial dialog 
box appears.

11 Select the Never Ring option. 

12 Click on the OK button.

13 Click on the Apply button. The telephone won’t ring 
when this contact calls.

For more information, refer to The Don’t Disturb 
feature on page 322.
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Accepting calls only from specified contacts

You can have the 9617 telephone ring only when certain 
contacts call. This method involves the Don’t Disturb 
feature.

When you turn on the Don’t Disturb feature, the 9617 
telephone won’t ring when you receive a call. However, 
you can override the Don’t disturb feature for certain 
contacts you have stored in memory keys or in the Quick 
Dials folder in Personal Call Manager by using the 
Always Ring option.

To use this method, follow these steps:

1 Turn on the Don’t Disturb feature (refer to The Don’t 
Disturb feature on page 322).

2 Enable the Always Ring option for the contacts you 
want the telephone to ring for (refer to Overriding 
DND for some contacts on page 329).
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Identifying long distance calls with a special 
ring

If you only want to accept long distance calls, you can 
program the 9617 telephone to sound a special ring 
whenever you receive a long distance call. (Long distance 
calls ring once normally before the special ring is activated 
unless the Suppress First Ring option has been 
enabled.)

To identify long distance calls with a special ring:

1 Click on the Tools menu.

2 Click on the Dial Using menu item.The Choose a 
TAPI Line dialog box appears.

3 Click on the drop list arrow beside the TAPI Line field.

4 Click on 9617.

5 Click on the Configure Line button.

6 If required, type the Options List password.

7 Click on the OK button. The 9617 Configuration 
Properties dialog box appears.

8 Click on the General tab.

9 Click on the radio button beside the Special Ring for 
Long Distance option.

10 Click on the OK button.

Note: The long distance icon (shown on the right) 
also appears on the 9617 telephone display to 
identify long distance calls.
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The Don’t Disturb feature

You can take advantage of the Don’t Disturb feature to 
stop your 9617 telephone from ringing. 

Although the telephone won’t ring, you can still answer 
the call.

You can set this feature using either the 9617 telephone 
or Personal Call Manager.

For more information, refer to the following topics:

■ Don’t Disturb and the M9617 telephone on 
page 323

■ Adding and using a Don’t Disturb key on 
page 325

■ Deleting the Don’t Disturb key on page 326

■ Don’t Disturb and Personal Call Manager on 
page 327

■ Turning DND on or off on page 328

■ Overriding DND for some contacts on page 329
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Don’t Disturb and the 9617 telephone

You can suppress the ringing on your telephone by using 
the Don’t Disturb (DND) feature. When this feature is on, 
the telephone does not ring; however, the line indicator 
and set indicator lights still flash when you receive a call. 
When this feature is on, Don’t disturb ON appears on the 
telephone display.

Note: Although the telephone does not ring, you can still 
answer the call.

Overriding DND for some contacts

When you use the DND setting, it applies to all incoming 
calls. However, you can override the DND setting for 
contacts saved in Memory keys and in the Quick Dials 
folder (which is the same as your 9617 telephone 
Directory). For more information, refer to Overriding 
DND for some contacts on page 329.

To turn Don’t Disturb on or off:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 19 or press 
⁄ ·. The telephone display tells you whether the 
feature is on or off.

4 Press • to turn the feature on or off.

5 Press ®.

continued...
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You can also program the Don’t Disturb key into a 
memory key so you can quickly turn it on and off, even 
while your telephone is ringing. 

For more information, refer to the following topics:

■ Adding and using a Don’t Disturb key on 
page 325

■ Deleting the Don’t Disturb key on page 326

■ Turning DND on or off on page 328
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Adding and using a Don’t Disturb key

You can program the Don’t Disturb key into a memory 
key so you can quickly turn it on and off, even while your 
telephone is ringing. 

To program a memory key as a Don’t Disturb key:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 21 or press 
¤ ⁄.

4 Press •.

5 Press the desired memory key.

6 Press ß.

7 Label the memory key as a Don’t Disturb key. Refer to 
Labeling memory keys on page 150.

8 Press ®.

Using the Don’t Disturb key

To turn the Don’t Disturb feature on or off, simply press 
the Don’t Disturb memory key on the telephone. When 
the feature is on, Don’t disturb ON appears on the 
telephone display.
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Deleting the Don’t Disturb key

To delete a Don’t Disturb key, you must follow two steps. 
First reprogram the Don’t Disturb key to be a memory key, 
then delete the memory key.

To delete a Don’t Disturb key:
First, reprogram the key to be a memory key:

1 Press ß.

2 Press the memory key that contains the Don’t Disturb 
feature.

3 Press ‡ to begin re-programming the key as a mem-
ory key.

4 Press ß two times to skip the number and 
name prompts. The Don’t Disturb key has been 
changed to a memory key.

Second, clear the contents of the memory key:

1 Press the memory key.

2 Press ∑ twice.
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Don’t Disturb and Personal Call Manager

The Don’t Disturb feature works the same whether you 
activate it with the 9617 telephone or with Personal Call 
Manager. 

When DND is enabled, the telephone does not ring when 
someone calls, but the line indicator still flashes. 

In Personal Call Manager, when you receive a call the You 
Have a New Call dialog box still appears and the Ringing 
icon appears in the Calls box.

When this option is enabled:

■ the message “Don’t disturb ON” appears on the dis-
play of the telephone

■ the Don’t Disturb icon (shown on the right) 
appears in the task tray on your computer

■ “DND” appears on the Status Bar of Per-
sonal Call Manager

You can turn the Do Not Disturb (DND) feature on or off 
from the Calls menu or the Personal Call Manager task 
tray menu. (See The task tray icon on page 55.)

Overriding DND for some contacts

When you use the DND setting, it applies to all incoming 
calls. However, you can override the DND setting for 
contacts saved in Memory keys and in the Quick Dials 
folder (which contains the same contacts as your 9617 
telephone Directory). For more information, refer to 
Overriding DND for some contacts on page 329.
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Turning DND on or off

To turn Don’t Disturb (DND) on or off:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Click on the DND menu item. A checkmark appears 
next to the menu item when DND is enabled.

Other ways to turn DND on or off

You can turn DND on and off using the Feature tab on 
the 9617 Configuration Properties dialog box (see The 
Feature tab on page 101). You can also turn DND on 
and off using a DND memory key. For more information, 
refer to Adding and using a Don’t Disturb key on 
page 325.
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Overriding DND for some contacts

You can specify the contacts you want to override the 
Don’t Disturb (DND) feature. When one of these contacts 
calls, the telephone rings even if DND is turned on.

Contacts stored in memory keys

To specify that a contact’s call override DND:

1 Click on the Tools menu.

2 Click on the Dial Using menu item. The Choose a 
TAPI Line dialog box appears.

3 Click on the Configure button. The 9617 Configura-
tion Properties dialog box appears.

4 Click on the Memory Keys Assignment tab.

5 Click on the memory key that stores the contact you 
want to override DND.

6 Click the Configure button.

7 Select the Always Ring check box.

8 Click the OK button on each dialog box until they are 
gone.

Contacts stored in the Quick Dials folder

To specify that a contact’s call override DND:

1 Right-click on a contact in the Quick Dials folder.

2 Point to the 9617 Options menu item. A submenu 
appears.

3 Click on the 9617 Properties menu item. The 9617 
Property dialog box appears showing the Ring Con-
figuration tab.

continued...
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4 Select the Always Ring check box.

5 Click on the OK button.

Tip: You can also specify that a Quick Dial contact 
override DND using the Quick Dial Manager window. 
This window also allows you to quickly review the ring 
configuration of all of your Quick Dials at once. For more 
information, refer to Using the Quick Dial Manager on 
page 331.
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Using the Quick Dial Manager

You can use the Quick Dials Manager to view and/or 
change the Ring Configuration settings for all of your 
Quick Dials on one dialog box.

You can set the Always Ring, Never Ring, Special Ring 
or Pager Notification options.

To set Ring Configuration settings for contacts stored in 
the Quick Dials folder:

1 Click on the 9617 Options menu.

2 Click on the Quick Dial Manager menu item. The 
Quick Dials Manager appears.

3 Click on a contact
OR
Select several contacts by Ctrl-clicking on them.
OR
Select a range of contacts by clicking on the first con-
tact in the range and shift-clicking on the last contact 
in the range.

continued...
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4 Click on the Edit menu and click on the Prop-
erties menu item.
OR
Click on the Quick Dial Manager button on the toolbar 
(shown on the right). The 9617 Property dialog box 
appears showing the Ring Configuration tab.

5 Select the options you want. An option is selected 
when a check mark appears in the check box. For 
information on the options available, refer to About 
Ring Configuration settings for Quick Dials con-
tacts on page 161.
Note: If you have selected several contacts, some set-
tings may appear greyed out in the Properties dialog 
box. This greying out occurs because the settings are 
not the same for all contacts. To turn the setting on 
for all the selected contacts, click once. To turn the 
setting off for all the selected contacts, click again.

6 Click the OK button.

For more information, refer to The Quick Dials folder on 
page 160.
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Using Calls Logs and lists

Both Personal Call Manager and the 9617 telephone have 
Calls Logs which store phone numbers and allow you to 
easily return calls and redial numbers. 

Personal Call Manager also contains a Calls Log Window 
which logs complete records of your incoming and 
outgoing calls. 

For more information, refer to the following topics:

■ The Callers and Redial Lists in your M9617 tele-
phone on page 334

■ Calls Logs and lists in Personal Call Manager on 
page 348
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The Callers and Redial Lists in your 9617 
telephone

The 9617 telephone features two lists to keep track of 
your calls. The Callers List logs your incoming calls, and 
the Redial list logs the calls you have made.

For more information, refer to the following topics:

■ The Callers List on page 335

■ Setting up the Callers List on page 336

■ About the Callers List and the Pager feature on 
page 337

■ Setting the Callers List mode on page 338

■ Finding an item in the Callers List on page 339

■ Making calls from the Callers List on page 340

■ Editing in the Callers List on page 341

■ Copying Callers List numbers to the Directory 
or a Memory key on page 344

■ Deleting from the Callers List on page 345
--------------------

■ Making a call from the Redial List on page 346
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The Callers List

The 9617 stores up to 100 calls in the Callers List. Your 
telephone logs the number (and name if available) of the 
caller and when he or she called. (You must subscribe to 
your telephone company for the Caller ID service.)

If the telephone number of the incoming call matches a 
number that you have saved in a memory key or the 
Directory, the Callers List shows the name you have saved 
in the memory key or Directory instead of the name sent 
with the Caller ID.

You can choose to record all of your incoming calls, only 
unanswered calls, or no calls in the Callers List. Setting 
the Callers List to record no calls turns the Callers List off.

Note: The 9617 telephone Callers List also appears in the 
Personal Call Manager Calls menu.

For more information, refer to the following topics:

■ Setting up the Callers List on page 336

■ About the Callers List and the Pager feature on 
page 337

■ Setting the Callers List mode on page 338

■ Callers List telephone display messages on 
page 44
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Setting up the Callers List

The Callers List records up to 100 incoming calls. You can 
program the telephone to record unanswered calls, all 
incoming calls, or no calls.

To change the Callers List:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use – to scroll to option number 7 or press 
‚ ‡.

4 Press • to change the Callers List.

5 Press ¬.

6 Press – until you see the option you want 
(Unanswered, All calls, or No calls). The current 
option is indicated with a check mark.

Unanswered - Records only your unanswered calls

All calls - Records all calls

No calls - Records no calls

7 Press • to select the option. 

8 After two seconds, repeat steps 4 to 7 to set the call-
ers list for the other line.

9 Press ®.

For more information, refer to About the Callers List 
and the Pager feature on page 337 and Setting the 
Callers List mode on page 338.
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About the Callers List and the Pager feature

If you are going to use the Pager feature, you must log all 
calls for the telephone line you want to activate the Pager 
feature on.

If you have enabled the Pager feature on Line 1, select the 
“All Calls” option for Line 1.

If you have enabled the Pager feature on Line 2, select the 
“All Calls” option for Line 2.

If you have enabled the Pager feature on Line 1 and Line 
2, select the “All Calls” option for both Line 1 and Line 2.

If you want the Pager feature to work for contacts stored 
in memory keys or the Quick Dials folder even if you 
have disabled the Pager feature on both lines, select the 
“All Calls” option for the line(s) you expect the calls from 
these contacts to come in on. (If you are going to use this 
approach, it is recommended that you select the “All 
Calls” option for both lines.)

For more information, refer to Setting up the Callers 
List on page 336.
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Setting the Callers List mode

You can program the Callers List to be split by line or 
combined. If the Callers List is combined, it contains all of 
the calls for both lines combined (100 item maximum). If 
the Callers List is split by line, there is a separate list for 
each line. 

The total number of calls in the two Callers Lists cannot 
exceed 100. The Callers List for one line can exceed 50 
calls, as long as the list for the other line has less than 50 
calls. 

To set the Callers List mode:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 9 or press 
‚ ·.

4 Press • .

5 Press • if you want to see the calls for both lines at 
the same time. Press £ if you want to see the calls for 
each line separately. A checkmark indicates the current 
selection.

6 Press ®.

You can also change the Callers List mode using the 
General tab on the 9617 Configuration Properties 
dialog box in Personal Call Manager. For more 
information, refer to The General tab on page 95.
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Finding an item in the Callers List

To find items in the Callers List:

1 To see the Callers List heading, press ≈.

2 Press ¬. This step is not necessary if the Call-
ers List Mode is set to the “Combined” option. For 
more information about the Callers List Mode, refer to 
Setting the Callers List mode on page 338.

3 To see the first caller in the list, press –. To 
move down and up the list, press ª. If you 
want to scroll steadily, press and hold ª. 

Tip: To see the last caller you viewed when you were 
last in the Callers List, press • after you press 
≈.

4 To leave the Callers List at any time, press ≈.
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Making calls from the Callers List

You must subscribe to Caller ID from your telephone 
company to make calls from the Callers List. Contact your 
local telephone company to subscribe to this service. For 
more information on the Callers List, refer to The Callers 
List on page 335.

To dial a number in the Callers List:

1 Press ≈.

2 Press ¬. This step is not necessary if the Call-
ers List Mode is set to the “Combined” option. For 
more information about the Callers List Mode, refer to 
Setting the Callers List mode on page 338.

3 Find the contact/number you want call.

4 Lift the handset or press ©, ∂, or 
¬.

5 To end the call, press ® or hang up.

If you call a number from the Callers List and you don’t 
get connected, you may have to edit the number (for 
example, the number may be long distance and you may 
have to add “1” in front of it). Refer to Editing in the 
Callers List on page 341 for more information.
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Editing in the Callers List

If you call a number from the Callers List and you don’t 
get connected, you may have to edit the number (for 
example, the number may be long distance and you may 
have to add “1” in front of it). 

To edit a number in the Callers List:

1 Press ≈.

2 Press ¬.
Note: This step is not necessary if the Callers List 
Mode is set to the “Combined” option. For more 
information about the Callers List Mode, refer to Set-
ting the Callers List mode on page 338.

3 Find the item you want to edit.

4 Press any key on the dialpad to begin editing. This may 
be required if you have tried to dial the number and 
there is no connection.

5 To add digits, use the dialpad. To erase one digit to the 
right of the cursor, press ‘. To erase one digit 
to the left of the cursor, press “.
Caution: The Callers List does not save changes. If you 
plan to call the number again, copy it to the Directory 
or a memory key. For more information, refer to 
Copying a contact from the Callers List, Redial 
List or a memory key to the Directory on page 141 
or Copying a contact from the Callers or Redial 
List to a memory key on page 148

6 To dial the edited number, lift the handset or press 
©, ∂, or ¬.

continued...
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For more information, refer to the following topics:

■ Stripping area codes from numbers in the tele-
phone Callers List on page 375.

■ Dialing back a long distance number in the 
Callers List using the telephone on page 343.
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Dialing back a long distance number in the 
Callers List using the telephone

To dial back a long distance number in the Callers 
List:

1 Press ≈.

2 Use ª to find the item you want to edit.

3 Using the dialpad, press ⁄ and the area code if nec-
essary.

4 To dial the edited number, lift the handset or press 
©, ∂ or ¬. 

5 If you want to save the number to the directory, press 
ß. Refer to Copying a contact from the 
Callers List, Redial List or a memory key to the 
Directory on page 141.
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Copying Callers List numbers to the 
Directory or a Memory key

To copy a number from the Callers List to the Direc-
tory or to a memory key:

1 Press ≈.

2 Press ¬. This step is not necessary if the Call-
ers List Mode is set to the combined option. For more 
information about the Caller List Mode, refer to Set-
ting the Callers List mode on page 338. 

3 Find the item you want to copy.

4 Press ß.

5 Press ¢ or the memory key where you want 
to store the number.

6 If no name is displayed, you are prompted to enter 
one. To enter a name, use the dialpad. (Refer to 
Entering Names on page 153.) If you don’t want a 
name, go to step 7.

7  Press ß.

8 To leave the Callers List at any time, press ≈ 
or ®.
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Deleting from the Callers List

You can delete one entry from the Callers List, or you call 
delete the entire list. 

To delete one number in the Callers List:

1 Press ≈.

2 Press ¬.
Note: This step is not necessary if the Callers List 
Mode is set to the “Combined” option. For more 
information about the Callers List Mode, refer to Set-
ting the Callers List mode on page 338. 

3 Find the item you want to delete.

4 Press ∑ twice.

5 Press ®.

To delete all numbers in the Callers List:

1 Press ≈.

2 Press ¬. This step is not necessary if the Call-
ers List Mode is set to the “Combined” option. For 
more information about the Callers List Mode, refer to 
Setting the Callers List mode on page 338.

3 Press ∑ twice while the Callers header (“Call-
ers List = xx”) is showing to delete the entire list.
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Making a call from the Redial List

The Redial List stores the last ten numbers you dialed. 
When you press µ,the last number you called 
appears on the screen. You can scroll through the list to 
view the other numbers.

Note: The 9617 telephone Redial List synchronizes with 
the Personal Call Manager Calls menu Redial List.

To make a call from the Redial List:

1 Press µ. The telephone display shows the last 
number you dialed.

2 If you want to redial a different number, find that 
number by pressing ª.

3 When the number is displayed, lift the handset or 
press ©, ∂, or ¬.

Note: If you press µ when the Live Dialpad 
option is turned on, after lifting the handset or after 
pressing ©, ∂, or ¬, your 
telephone automatically dials the last number in the 
Redial List without first displaying it.

For more information, refer to Deleting the Redial List 
on page 347.
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Deleting the Redial List

There may be times when you want to delete the 
contents of the Redial List. For example, if you have dialed 
a personal number such as a password or your calling 
card number, you may not want it to appear in the list 
where anyone can see it.

To delete the Redial List:

1 Press µ.

2 Press ∑ twice. The entire Redial List is 
deleted.

Note: You cannot delete individual entries in the Redial 
List.

You can program security numbers that will not appear 
on the 9617 telephone display or in the Redial List when 
they are dialed. For more information, refer to 
Preventing the telephone numbers you dial from 
appearing on the M9617 telephone display on 
page 383.
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Calls Logs and lists in Personal Call Manager

Personal Call Manager stores your incoming and outgoing 
calls so you can easily access them. Calls that you have 
received are stored in the Callers List and the Incoming 
Calls Log. Calls that you have made are stored in the 
Redial List and the Outgoing Calls Log. 

While the Callers List and Redial List have a limit of 10 
calls, the Calls Logs are unlimited in size.

You can use these lists to return calls, redial numbers or 
store contacts.

For more information, refer to the following topics:

■ Viewing the Incoming and Outgoing Calls Log 
Window on page 349

■ Making a call using the Calls Log Window on 
page 350

■ Deleting entries in the Incoming and Outgoing 
Calls Log on page 351

■ Using the Callers List and Redial List in Personal 
Call Manager on page 352

■ The Callers List in Personal Call Manager on 
page 353

■ The Redial List in Personal Call Manager on 
page 354

■ Returning a call or redialing a number on 
page 355
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Viewing the Incoming and Outgoing Calls 
Log Window

To view the Calls Log Window:

1 Click on the View menu, or click on the Calls 
Log Window button on the toolbar (shown on 
the right).

2 Click on the Show Call Log Window menu item. The 
Incoming Calls Log Window or the Outgoing Calls 
Log Window appears. To toggle between these win-
dows, use the View menu or the toolbar buttons 
described below.

For more information, refer to Making a call using the 
Calls Log Window on page 350.

Calls Log Toolbar Buttons 

Button Feature Description

Incoming 
Calls Log

Displays the Incoming Calls 
Log window.

Outgoing 
Calls Log

Displays the Outgoing Calls 
Log window.

Delete Deletes the selected contacts.
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Making a call using the Calls Log Window

You can return a call from the Incoming Calls Log 
Window by viewing the Log and choosing the call you 
want to return. 

You can redial a number form the Outgoing Calls Log 
Window by viewing the Log and choosing the number 
you want to redial.

To return a call or redial a number using the Calls 
Log Window:

1 Click on the View menu.

2 Click on the Show Call Log Window menu item. The 
Calls Log you last viewed appears by default. 
To view the Outgoing Calls Log Window, click on 
the View menu and choose the Outgoing Calls Log 
menu item. To view the Incoming Calls Log Win-
dow, click on the View menu and choose the Incom-
ing Calls Log menu item.

3 Double-click the item in the Log that you want to dial.

Tip: You can display the Calls Log window by 
clicking the Calls Log button on the toolbar 
(shown on the right).

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.

For more information, refer to the following topics:

■ Copying a contact from the Calls Log to the 
Address Book on page 190
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Deleting entries in the Incoming and 
Outgoing Calls Log

The Calls Logs in Personal Call Manager do not have a 
size limit. As a result, they can become so large that 
they take a minute or so to appear on your screen. It is a 
good idea to delete log entries occasionally.

Note: If the Calls Logs are very large, deleting them may 
take a few minutes.

To delete one entry:

1 Click on the contact you want to delete.

2 Click on the Edit menu.

3 Click on the Delete menu item.

Tip: You can also right-click on the contact and then click 
on the Delete menu item.

To delete a range of Log entries:

1 Click on the first contact in the range you want to 
delete.

2 Shift-click the last contact in the range (you may have 
to scroll down). The range appears selected.

Tip: You can select more that one contact by 
Ctrl-clicking on each one you want to select.

3 Click on the Edit menu.

4 Click on the Delete menu item.

Tip: You can also right-click on the selected range and 
then click on the Delete menu item.
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Using the Callers List and Redial List in 
Personal Call Manager

Personal Call Manager keeps two telephone lists that you 
can use to make calls. 

The Callers List contains the telephone numbers of the 
last ten people who called you. 

The Redial List contains the last ten telephone numbers 
you called.

These lists synchronize with the lists in the 9617 
telephone.

For more information, refer to the following topics:

■ The Callers List in Personal Call Manager on 
page 353

■ The Redial List in Personal Call Manager on 
page 354
352



The Callers List in Personal Call Manager

Personal Call Manager keeps a list of the telephone 
numbers of the last ten people who called you while 
Personal Call Manager was running. The Callers List 
shows both the calls you answered and the calls you were 
unable to answer. You can use this list to return the calls.

This list may differ from the Callers List in the 9617 
telephone if Personal Call Manager was not running 
when some calls came in.

The calls shown on the Callers List are numbered from 
one to ten. Call number ten is the most recent call and is 
stored at the bottom of the list. Call number one is the 
oldest call and is stored at the top of the list. 

When there are already ten calls on the list and you 
receive another call, the new call is added to the bottom 
of the list and the oldest call is deleted.

Telephone numbers are only shown on the Callers List if 
you subscribe to a Caller ID service.

For more information, refer to the following topics:

■ The Redial List in Personal Call Manager on 
page 354

■ Returning a call or redialing a number on 
page 355.
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The Redial List in Personal Call Manager

Personal Call Manager keeps a list of the last ten 
telephone numbers you called while Personal Call 
Manager was running. 

This list may differ from the Redial List in the 9617 
telephone if Personal Call Manager was not running 
when you made some calls.

The most recent call is at the top of the list (number one) 
the oldest call is at the bottom (number 10). When there 
are already ten calls on the list and you make another call, 
the new call is added to the top of the list and the oldest 
call is deleted. 

For more information, refer to the following topics:

■ The Callers List in Personal Call Manager on 
page 353

■ Returning a call or redialing a number on 
page 355.
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Returning a call or redialing a number

You use the Callers List to return a call. You use the Redial 
List to redial a number.

To return a call or redial a number:

1 Click on the Personal Call Manager task tray icon or 
the Calls menu. (See The task tray icon on page 55.)

2 Point to the Callers List menu item or the Redial List 
menu item. A submenu appears.

3 Click on the number you want to call.

Note: All calls made using Personal Call Manager are in 
Handsfree mode. To turn off Handsfree, lift the handset 
after the call has been dialed. For information on 
Handsfree, refer to Handsfree calls on page 261.
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Using feature keys for network telephone 
services

Some network features such as Call Forwarding or Call 
Return provided by your telephone company are turned 
on and off by feature codes. A feature code usually looks 
something like this: *76.

To turn a feature on, you dial the feature code provided 
by the telephone company. To turn a feature off, you dial 
the same or a different code depending on the feature.

You can store feature codes in the Directory of your 
telephone or in the Address Book in Personal Call 
Manager. 

For greater convenience, you can store feature codes in 
the Memory keys of your 9617 telephone. You can also 
store FeatureLight keys that turn the set indicator light on 
to remind you that you have activated a feature.

You delete Feature keys the same way you delete Memory 
keys. For more information, refer to Deleting memory 
keys on page 152.

For more information, refer to the following topics:

■ Saving features in memory keys on page 357

■ Saving FeatureLight On and Off keys on 
page 360
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Saving features in memory keys

Some custom calling features require a unique On code 
and a unique Off code. Other features use the same code 
for On and Off. (You must subscribe to your telephone 
company for Custom Calling Features. Contact your 
telephone company for the appropriate feature codes.)

Features that have unique On and Off codes must be 
stored in two feature keys. The On feature key stores the 
On feature code, and the Off feature key stores the Off 
code. Features that use the same code for both On and 
Off only need to be stored in one feature key. The 
procedures for storing an On code and an Off code are 
the same. 

For more information, refer to the following topic:

■ Saving a Feature On or Off Code using the tele-
phone on page 358

■ Using feature keys on page 359

■ Programming a memory key as a FeatureLight 
On or Off key using Personal Call Manager 
on page 121
357



Saving a Feature On or Off Code using the 
telephone

To save a Feature On or Off code:

1 Press ß.

2 Press the memory key you want to save the number 
into.

3 If you are saving a feature On code, enter the On 
code. If you are saving a feature Off code, enter the 
Off code. (You must subscribe to your telephone com-
pany for Custom Calling Features. Contact your tele-
phone company for the appropriate feature codes.)

4 Press ß.

5 Enter the feature name (e.g., Call Forward) using the 
dialpad. (Refer to Entering Names on page 153.)

6 Press ß.

7 Label the memory key as a Feature Key. Refer to 
Labeling memory keys on page 150 for more infor-
mation.
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Using feature keys

When a memory key is programmed with a feature code, 
you can use it to turn the feature on or off.

To turn a feature on or off:

1 Press the memory key where you stored the desired 
feature On or Off code. The telephone display shows 
the feature name and code.

2 Lift the handset or press ©, ∂, or 
¬. The feature code is dialed out on that line, 
which turns the feature on or off for that line.

Note: If the Live Dialpad option is turned on, you do not 
have to lift the handset or press any other button. 
Pressing the feature key automatically dials the feature 
code and puts the telephone in Handsfree mode.

The active feature applies only to the line you selected or 
to the prime line if you did not press a line key. For 
example, if you want to forward all incoming calls, you 
must turn the feature on for each line.
359



Saving FeatureLight On and Off keys

You can make the set indicator light come on when you 
turn a feature on and go off when you turn that same 
feature off. You can only do this with one feature.

For example, you may want the light to remind you that 
you have turned Call Forwarding on. To do this, use one 
key to turn the indicator light on when you activate the 
feature. Use the second key to turn the indicator light off 
when you deactivate that same feature.

Note: If you save a FeatureLight On key, you must also 
save a Feature Light Off key to turn the set indicator light 
off when you turn the feature off.

For more information, refer to the following topics:

■ Saving a FeatureLight On key using the tele-
phone on page 361

■ Saving a FeatureLight Off key using the tele-
phone on page 362

■ Programming a memory key as a FeatureLight 
On or Off key using Personal Call Manager 
on page 121

■ Using FeatureLight keys on page 363
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Saving a FeatureLight On key using the 
telephone

To save a FeatureLight On key:

1 Press ß.

2 Do NOT select a memory key yet. To program the light 
on, press ⁄.

3 Press the desired memory key.

4 Enter the telephone company feature code for turning 
the feature on. Contact your telephone company for 
the appropriate feature codes.

5 Press ß.

6 Label the memory key. Refer to Labeling memory 
keys on page 150.

Note: If you save a FeatureLight On key, you must also 
save a Feature Light Off key to turn the set indicator light 
off when you turn the feature off.
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Saving a FeatureLight Off key using the 
telephone

To save a FeatureLight Off key:

1 Press ß.

2 Do NOT select a memory key yet. To program the light 
off, press ‚.

3 Press the desired memory key.

4 Enter the telephone company feature code for turning 
the feature off. Contact your telephone company for 
the appropriate feature codes.

5 Press ß.

6 Label the memory key. Refer to Labeling memory 
keys on page 150.
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Using FeatureLight keys

To turn a feature and light on or off:

1 Press the memory key where you stored the Feature-
Light. The telephone display shows FeatureLight ON 
or FeatureLight OFF.

2 Lift the handset or press ©, ∂, or 
¬. The feature turns on or off for that line, 
and the light turns on or off accordingly. (When the 
feature and light are on and you’re not using the tele-
phone, the telephone display shows Feature ON and 
the line that it applies to as a reminder.)

Note: If you see an arrow (->) on the right of the 
telephone display, you may have to press ‘ to 
view the Feature message and light.

Also note that if the Live Dialpad option is turned on, you 
do not have to lift the handset or press any other button. 
Pressing the feature key automatically dials the feature 
code and puts the telephone in Handsfree mode.
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Timing the length of your calls

There are two ways to time the length of your calls. 

You can choose to have the Call Timer automatically 
displayed on the third line of the telephone display 
instead of the date and time when you are on a call.

Or, if you don’t want the call timer to display 
automatically when you are on a call, you can program 
the call timer to appear only when you press a Call Timer 
memory key. 

Both lines are timed separately. 

Note: Telephone calls are always timed in Personal Call 
Manager.

For more information, refer to the following topics:

■ The automatic Call Timer feature on page 365

■ The Call Timer key on page 366
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The automatic Call Timer feature

You can choose to have the Call Timer automatically 
displayed on the third line of the telephone display 
instead of the date and time when you are on a call.

To turn the automatic Call Timer on or off:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 18 or press 
⁄ °.

4 Press • to turn the automatic Call Timer on or off.

5 Press ®.
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The Call Timer key

If you don’t want the call timer to automatically appear 
when you are on a call, you can program the call timer to 
appear only when you press a Call Timer memory key. 
Both lines are timed separately. 

For more information, refer to the following topics:

■ Adding a Call Timer key on page 367

■ Using the Call Timer key on page 368

■ Deleting a Call Timer key on page 369
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Adding a Call Timer key

If you don’t want the call timer to automatically appear 
when you are on a call, you can program the call timer to 
appear only when you press a call timer memory key. Both 
lines are timed separately. 

To program a memory key as a timer key:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 20 or press 
¤ ‚.

4 Press • to add a Timer key.

5 Press a memory key.

6 Press ß.

7 Label the timer key. Refer to Labeling memory keys 
on page 150.

8 Press ®.

You can also program a memory key as a timer key in 
Personal Call Manager. For more information, refer to 
Assigning the Call Timer feature to a memory key on 
page 116.
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Using the Call Timer key

The timer key is used to display the length of a call when 
you don’t have the automatic call timer turned on. 

If you press the timer key when on a call, the timer for 
that call appears on the third line of the telephone display. 
If you press the timer key when you are not on a call, the 
timer for the last call on each of your telephone lines 
appears. 

To turn off the display of the call timer, simply press the 
timer key again.

For information on adding a Call Timer key, refer to 
Adding a Call Timer key on page 367.

To show the timer on the display:

1 Make or answer a call. The timer starts running auto-
matically.

2 Once on the call, press the timer key. The telephone 
display shows the running time of the active call on 
the third line of the telephone display.
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Deleting a Call Timer key 

To delete a Call Timer key

1 Press the timer key.

2 Press ∑ twice.
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Redialing busy telephone numbers 
automatically

When you make a call and get a busy signal, you can use 
the Busy Redial feature to continue calling that number 
automatically until your line gets through. 

To set up this feature, you have to program a Busy Redial 
key, enter the number of redial attempts you want your 
9617 telephone to make before it stops, and enter the 
delay time between attempts.

For more information, refer to the following topics:

■ Creating an Automatic Busy Redial key on 
page 371

■ Specifying the time delay between redial 
attempts on page 372

■ Specifying the number of redial attempts on 
page 373

■ Using the Automatic Busy Redial Feature on 
page 374
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Creating an Automatic Busy Redial key

To create a Busy Redial key:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 22 or press 
¤ ¤.

4 Press •.

5 Press a memory key.

6 Press ß.

7 Press ®.

8 Label the Busy Redial key. Refer to Labeling memory 
keys on page 150.

You can also program a memory key as a Busy Redial key 
in Personal Call Manager. For more information, refer to 
Assigning the Auto Busy Redial feature to a memory 
key on page 115.
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Specifying the time delay between redial 
attempts

To specify the time delay between redial attempts:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 23 or press 
¤ ‹.

4 Press • .

5 Enter the time delay in seconds (99 seconds maxi-
mum.)

6 Press ß.

7 Press ®.
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Specifying the number of redial attempts

To specify the number of redial attempts:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 24 or press 
¤ ›.

4 Press • .

5 Enter the number of redial attempts you want your 
telephone to make (maximum 15).

6 Press ß.

7 Press ®.
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Using the Automatic Busy Redial Feature

There are two ways to use the Automatic Busy Redial 
feature. When you make a call and get a busy signal, 
hang up the call and press the Busy Redial key. Your 
telephone begins automatically redialing the last number 
in the Redial List using the line that you used to make the 
original call. 

Or, you can predial a number (the live dialpad option must 
be off - refer to Selecting the dialpad option on 
page 239) and then press the Busy Redial key. In this case, 
your telephone begins automatically redialing the number 
using the Prime line.

To stop the redial attempts, simply press the Busy Redial 
or any other key, or perform any other function on your 
telephone.

Note: When your call gets through, you can begin talking 
after you pickup the handset or press © to 
unmute the Handsfree microphone.

For more information, refer to Redialing busy 
telephone numbers automatically on page 370.
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Stripping area codes from numbers in the 
telephone Callers List

In some areas, the telephone company sends the area 
code of all local calls with the Caller ID information. 
However, you may not be able to dial local numbers using 
the telephone Callers List until you remove the area code 
from the numbers stored there. If this is the case in your 
area, you can use the area code stripping feature.

When you enter an area code or prefix using this feature, 
your 9617 telephone removes that code or prefix from 
numbers stored in the telephone Callers List. You can 
enter three separate area codes or prefixes, each up to 
seven digits long. 

For example, if you enter your area code into this option, 
all calls in your area code appear in the Callers List with 
the area code stripped off – the area code appears in 
brackets following the rest of the telephone number (see 
The Callers List on page 43). 

Note: It is highly recommended that you enter your local 
area code(s) using this option and in the Area Code field 
on the Dialing Properties dialog box in Personal Call 
Manager. To access this dialog box, click on the Tools 
menu and select the Dialing Properties menu item.

For more information, refer to the following topics:

■ Entering area codes and prefixes you want 
stripped off incoming calls on page 376

■ Editing or deleting area codes and prefixes on 
page 377

■ Using the Callers List to return a call on 
page 236
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Entering area codes and prefixes you want 
stripped off incoming calls

To enter area codes and prefixes:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 14 or press 
⁄ ›.

4 Press •.

5 Enter the area code or prefix using the dialpad and 
press ß. Repeat this step for each area code 
or prefix you want to enter, for up to three codes.

6 Press ®.

You can also enter area codes to be stripped from 
telephone numbers in the telephone Callers List using 
Personal Call Manager. For more information, refer to the 
Area Codes paragraph under the topic, The Phone 
Display tab on page 99.
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Editing or deleting area codes and prefixes

To delete or edit an area code or prefix:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 14 or press 
⁄ › to go directly to the item.

4 Press •.   The first area code is displayed. If this is not 
the number you want to delete or change, go to step 
5. If it is, go to step 6.

5 Press ß until you see the number you want 
to edit or delete.

6 Edit or delete the area code (press “ to 
backspace).

7 Press ß. 

8 Press ®.
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Restricting the telephone numbers that can 
be dialed

Dialing Restrictions are used to prevent certain numbers 
from being dialed out. You can enter three 7-digit dialing 
restrictions. If you attempt to dial a number that matches 
the restricted digits, the message Restricted number 
appears on the telephone display. 

For example, if you entered the codes 0, 1, and 411, any 
number beginning with 0, 1 or 411 could not be dialed 
from the telephone. However, the number 555-0411 
could be dialed because it does not begin with the 
restricted digits.

For more information, refer to the following topics:

■ Entering dialing restrictions on page 379

■ Editing or deleting dialing restrictions on 
page 380

■ Overriding dialing restrictions on page 381

■ Editing or deleting dialing restriction overrides 
on page 382
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Entering dialing restrictions

To enter Dialing Restrictions:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 15 or press 
⁄ fi.

4 Press •.

5 Enter the digits you want restricted and press 
ß. Repeat this step for each dialing restric-
tion you want to enter.

6 Press ®.

Important: Care must be taken when you are restricting 
numbers that start with 9. If you enter 9, 91, or 911 as 
one of your dialing restrictions, you will not be able to dial 
the emergency services number 911. To make sure this 
does not happen, enter 911 as a dialing restriction 
override. For more information, refer to Overriding 
dialing restrictions on page 381.
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Editing or deleting dialing restrictions

To delete or edit dialing restrictions:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 15 or press 
⁄ fi.

4 Press •. The telephone display shows 1st code>. If 
this is the number you want to delete or change, go to 
step 6. If not, go to step 5.

5 Press ß until you view the code you want to 
edit or delete.

6 Edit or delete the dialing restriction (press “ 
to backspace).

7 Press ß. 

8 Repeat steps 5 and 6 for the restricted digits that you 
want to delete or edit.

9 Press ®.

Important: Care must be taken when you are restricting 
numbers that start with 9. If you enter 9, 91, or 911 as 
one of the dialing restrictions, you will not be able to dial 
the emergency services number 911. To make sure this 
doesn’t happen, enter 911 as a dialing restriction 
override. For more information, refer to Overriding 
dialing restrictions on page 381.
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Overriding dialing restrictions

Dialing Restrictions are used to prevent certain numbers 
from being dialed out. You can, however, program three 
numbers to override the restricted numbers feature.You 
can program three 7-digit overrides.

For example, if you entered the 0, 1, and 411 as restricted 
numbers, any number beginning with 0, 1 or 411 could 
not be dialed from the telephone. However, if you 
entered 4118 as an override number, you could dial the 
number 411-8679.

To enter dialing restrictions overrides:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 16 or press 
⁄ fl.

4 Press •.

5 Enter the digits you want to override the dialing 
restrictions and press ß. Repeat this step for 
each dialing restriction override you want to enter.

6 Press ®.
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Editing or deleting dialing restriction 
overrides

To edit or delete dialing restriction overrides:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 16 or press 
⁄ fl.

4 Press •. The first override number appears. If this is 
the number you want to edit, go to step 6. If not, go 
to step 5.

5 Press ß until you see the number you want 
to edit or delete. 

6 Edit or delete the number (press “ to back-
space).

7 Press ß. 

8 Repeat steps 5 and 6 for the overrides that you want 
to edit or delete.

9 Press ®.
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Preventing the telephone numbers you dial 
from appearing on the 9617 telephone 
display

The 9617 is equipped with a Security Numbers feature to 
keep selected numbers private when you dial. When you 
have entered a security number using this option, your 
telephone does not display or store the digits that you dial 
after that security number. Instead, the numbers that 
follow the security number are replaced with the * 
symbol on the telephone display. You can secure up to 
three 12-digit numbers. 

For example, Joe enters 291-9000 as a security number in 
the Options list. His Voice Mail number is 1234 and his 
password is 5678. To access his messages, Joe dials 291-
9000 1234 5678. Because the Voice Mail number and 
password follow the security number, the telephone 
display shows 291-9000 **** ****, and Joe’s password 
is not displayed or stored in the Redial List. For more 
information on the Redial List, refer to Making a call 
from the Redial List on page 346.

For more information, refer to the following topics:

■ Entering security numbers on page 384

■ Editing and deleting security numbers on 
page 385
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Entering security numbers

To enter a security number:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 17 or press 
⁄ ‡.

4 Press •.

5 Using the dialpad, enter the secure number.

6 Press ß to end.

7 Repeat steps 5 and 6 for each security number you 
want to enter.

8 Press ®.
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Editing and deleting security numbers 

To edit or delete a security number:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 17 or press 
⁄ ‡.

4 Press •.

5 Press ß until you find the number you want 
to change or delete.

6 Edit or delete the number (press “ to back-
space).

7 Press ß.

8 Press ®.
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Printing your Address Book

There are two main steps to print out the contacts stored 
in your Address Book.

1 Export your contacts to a text file. For information on 
how to do this, refer to Importing and exporting 
contacts on page 191.

2 Import the text file into spreadsheet or database pro-
gram, format it, and then print it from that program.

Note: You can open the text file containing your contacts 
in a word processor or editor such as the Windows 
Notepad accessory; however, you will have to format it to 
make it presentable.
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Connecting a fax machine or modem to the 
telephone

The Fax Switch feature allows you to attach a fax machine 
or modem to the 9617 telephone. The illustration below 
is a schematic view of all phone connections, including a 
fax machine.

To use a Fax Switch peripheral:

■ Both Line 1 and Line 2 must be combined on one 
telephone cord which is plugged into jack 1 of the 
9617 telephone (Refer to Determining whether 
you have two telephone lines on one telephone 
cord on page 6 for more information.)

■ The Fax Switch peripheral must be connected to jack 
2 on the back of the telephone (use the telephone 
cord that was supplied with your fax machine)

continued...
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■ You must subscribe to your telephone company for 
Distinctive Ringing on line 2. The telephone company 
will then provide you with an additional telephone 
number for line 2 which will ring with a slightly dif-
ferent ring tone. (The name of the Distinctive Ringing 
service varies from area to area. Contact your tele-
phone company for more information.) This addi-
tional telephone number is your fax number.

■ You must turn on the Fax Switch feature. For more 
information, refer to Setting the Fax Switch on 
page 390.

■ The Fax Switch peripheral should be set to answer 
after three or more rings.

Note: Do not subscribe to Call Waiting on Line 2 if you 
are using the Fax Switch feature. If Line 2 of your 9617 
telephone has Call Waiting enabled, your Fax Switch 
peripheral may lose data or be disconnected if you get a 
Call Waiting caller on line 2.

How it works

The first ring of an incoming call on line 2 rings at both 
the 9617 telephone and the Fax Switch peripheral. The 
9617 telephone uses this ring to identify which device the 
call is intended for. 

If it is a normal ring, the call is routed to the 9617 and the 
Fax Switch peripheral stops ringing. 

If it is a distinctive ring, the call is routed to the Fax Switch 
peripheral and the 9617 stops ringing.

continued...
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Note: If the Long Distance Ringing service is available in 
your area, long distance calls will be sent to the Fax 
Switch peripheral. If this is the case, do not use the Fax 
Switch feature.

When the Fax Switch peripheral is idle, line 2 of the 9617 
terminal can be used as a normal line. When the Fax 
Switch peripheral is in use, the line 2 indicator light is on.
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Setting the Fax Switch

You can program the telephone to enable or disable the 
Fax Switch feature.

To set the Fax Switch:

1 Press the Options key.

2 Enter your Options password if required. Refer to Set-
ting the Options password using the telephone 
on page 87 for more information.

3 Use ª to scroll to option number 10, or 
press ⁄ ‚.

4 Press • to enable or disable the Fax Switch.
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Uninstalling Personal Call Manager

In certain situations, you may want to remove Personal 
Call Manager from your computer. For example, when 
you get a new computer you will want to move Personal 
Call Manager to the new computer. The Uninstall 
program removes the files that comprise Personal Call 
Manager from the computer hard disk.

To remove the Personal Call Manager software:

1 Make sure you have exited from Personal Call Man-
ager, Launch Pad and any other accessory applications 
installed with Personal Call Manager.

2 Click on the Windows® Start button and point to the 
Settings menu item. A submenu appears.

3 Click on the Control Panel menu item.

4 Double-click on the Add/Remove Programs icon.

5 Click on Personal Call Manager.

6 Click on the Add/Remove button.

Most of the files associated with Personal Call Manager 
are removed from your computer hard drive. You may 
have to manually delete the following files from your 
Windows/System directory:

■ 9617.sys; 9617.inf

■ nttsp.tsp; ntuisp.hlp; ntuisp.dll
Tip: If you are moving Personal Call Manager to a new 
computer, use the Windows Find feature to locate the 
PCMAddressBook.mdb file and make a copy of it 
before you remove Personal Call Manager. You can then 
copy this file to the new computer where Personal Call 
Manager is installed. This copies all of the contacts you 
added to the Address Book onto the new computer.
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The Voice Mail Assistant
Personal Call Manager comes bundled with a Voice Mail 
utility call Voice Mail Assistant. This utility allows you to 
access your Voice Mail from your computer. 

To start Voice Mail Assistant:

1 If you see a desktop shortcut called “Voice Mail 
Assist,” double-click on it.

OR

1 Click on the Windows® Start menu.

2 Point to the Programs menu item. A submenu 
appears.

3 Point to the Personal Call Manager menu item. A 
submenu appears.

4 Click on the Voice Mail Assist menu item. The main 
window appears. 

OR

1 Right-click on the Message Waiting or Personal Call 
Manager icon in the task tray and then click on the 
Start Voice Mail Assistant menu item. 

Tip: Click once on the Voice Mail icon in the task tray to 
display the Voice Mail Quick Access bar.

Getting Help

The Voice Mail Assistant application contains help topics 
on how to set up and use it. To access help, do one of the 
following:

■ click on the Help menu;
continued...
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■ right-click on any field or button and click on the 
What’s this? menu item;

■ click in a field and then press F1 on the keyboard; or

■ click and hold the mouse button on a button and 
then press F1 on the keyboard.
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The Launch Pad application
Personal Call Manager comes with a utility called Launch 
Pad. This utility allows you to assign applications to any of 
the 9617 telephone’s memory keys. When Launch Pad is 
running, pressing a memory key on the telephone starts 
the assigned application.

Note: Launch Pad must be running in order for a memory 
key to launch an application. 

When Launch Pad is running, its icon (shown on 
the right) appears in the task tray. (See The task 
tray icon on page 55 for an illustration of the task 
tray.)

To launch an application using Launch Pad, you must first 
assign an application to a memory key. You can then use 
the memory key to launch the application.

For more information, refer to the following topic:

■ Starting the Launch Pad application on 
page 395

■ Assigning an application to a memory key 
using Launch Pad on page 396

■ Starting an application using Launch Pad on 
page 397
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Starting the Launch Pad application

When you launch the Launch Pad application, its icon 
appears in the task tray but not on the task bar. (See The 
task tray icon on page 55 for an illustration of the task 
tray.)

To start Launch Pad application:

1 Click on the Windows® Start menu.

2 Point to the Programs menu item. A submenu 
appears.

3 Point to the Personal Call Manager menu item. A 
submenu appears.

4 Click on the Launch Pad menu item.

OR

1 If a Launch Pad shortcut appears on your desktop, 
double-click on it.

The main window does not appear by default. To 
view the Launch Pad main window, double-click 
the Launch Pad icon (shown on the right) in the 
task tray.

Getting Help

Press F1 for help when in the application.
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Assigning an application to a memory key 
using Launch Pad

To assign an application to a memory key:

1 Double-click the Launch Pad icon (shown on 
the right) in the task tray. The main window 
appears.

2 Click on the Configure Phone button. The 9617 
Configuration Properties dialog box appears.

3 Click on the Memory Keys Assignment tab.

4 Select a memory key by clicking on a radio button.

5 Select Application from the drop down box.

6 Click on the Configure button. The Application Key 
dialog box appears.

7 Type in a short name for the application. 

8 Select the application’s executable (.exe) file by clicking 
on the Browse button.

9 To have the Launch Pad application start automatically 
when you start your computer, click on the Run 
Launch Pad on startup option.

10 Click on the OK button.

11 Label the memory key. (Refer to Labeling memory 
keys on page 150.)

Note: If the Launch Pad window doesn’t reflect the latest 
changes you have made, click on the Refresh button.

For information on using Personal Call Manager to do 
assign an application to a memory key, refer to 
Assigning an application to a memory key on 
page 117.
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Starting an application using Launch Pad

Launch Pad must be running in order for a memory key to 
launch an application. 

To start an application using Launch Pad:

1 On the 9617 telephone, press the memory key to 
which the application is assigned.
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Keyboard shortcuts
The follow keyboard shortcuts are available when 
Personal Call Manager is the active application.

Key Function

F1 activates Personal Call Manager help

F3 displays the Dial dialog box

F6 moves the cursor back and forth between 
the Tree View and the List View in the 
Address Book

F10
or
Alt

activates the menus in Personal Call 
Manager (use the arrow key on the 
keyboard to move right and left through 
the menu bar)

Delete hangs up the selected call, or deletes the 
selected contact or folder

Return selects the OK button on open/active 
dialog boxes

Esc selects the Cancel button on open/active 
dialog boxes

Alt+F4 exits the application

Tab moves the cursor from one field to the 
next on dialog boxes

arrow keys moves the cursor between folder and 
contact selections and menus
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Using this Guide
This Guide is meant as a reference for using the 9617 
telephone with Personal Call Manager. 

The instructions in this Guide assume that you have 
a working knowledge of Windows®.

While this Guide is designed primarily for use online, it 
can also be printed.

Note: For optimum online viewing, set both the Screen 
and Desktop Display Area settings to 1024x768, and the 
Color palette to True Colour (32 bit).

For more information, refer to the following topics:

■ Flipping through this Guide on page 400

■ Printing this Guide on page 406

■ Windows online help on page 407
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Flipping through this Guide

To view this online Guide, use Adobe Acrobat® Reader 
software. Some basic instructions on how to use this 
Guide are provided below. If you need more detail, refer 
to the Acrobat® Reader Online Guide.

To access the Acrobat® Reader Online Guide:

1 In Acrobat Reader, click on the Help menu.

2 Click on the Reader Online Guide menu item. The 
Guide appears.

Scrolling through this Guide

To scroll through the pages of this Guide, use the 
navigation toolbar buttons (shown below) or scroll bars in 
Acrobat Reader, or press the Page Up or Page Down 
keys on the keyboard.

For more information, refer to the following topics:

■ Using hotlinks on page 401

■ Bookmarks on page 402

■ Retracing your steps on page 403

■ Searching for topics – the Find feature on 
page 404

■ Zooming in or out on the page on page 405

A. Displays the first page   B. Displays the previous page  
C. Displays the next page  D. Displays the last page  
E. Goes to the previous view F. Returns to the next view

A B C D E F
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Using hotlinks

If it’s green, you can click on it

Hotlink text allows you to jump to different topics in this 
Guide by simply clicking. Hotlink text is green, like this. 

When you point to a hotlink, 
the mouse pointer arrow 
changes into a pointing hand 
(shown above, right). To jump to the topic the hand is 
pointing to, click on it.

To use hotlinks, ensure you have selected the 
Hand tool. This tool is selected by default. To 
select the Hand tool, click on the Hand tool 
button (shown on the right) on the Acrobat Reader 
toolbar.

You can click on these, too

The buttons at the top and bottom of the page are also 
hotlinks.

A. Displays the list of help topics.  
B. Displays instructions for using this Guide.

A B
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Bookmarks

When you opened this Guide, bookmarks appeared to 
the left of the page. Each bookmark is a hotlink to its 
associated topic. To jump to a topic, click on it. To see 
subtopics, click the arrow to the left of a topic. 

Bookmarks are provided for your convenience only. You 
can hide them to reduce the amount of space this Guide 
uses on the screen.

To hide bookmarks:

1 Click on the View menu in Acrobat Reader.

2 Click on the Page Only menu item. The bookmarks 
disappear.

OR

1 Click on the Page Only button (shown on the 
right) on the toolbar.
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Retracing your steps

You can easily retrace 
your steps through this 
Guide by using the Go 
Back or Go Forward 
buttons on the 
Acrobat Reader 
toolbar.

Click on the Go Back button to see the previous page you 
looked at. By continually clicking this button, you can 
review, one page at a time, all of the pages in the Guide 
you have seen. 

To go forward again one page at a time, click on the Go 
Forward button.

A. Go Back
B. Go Forward

A B
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Searching for topics – the Find feature

Be sure to use the Find feature in Acrobat® Reader to 
locate topics of interest to you. The Find feature finds all 
instances in this manual of the word you specify.

To search for a topic:

1 Click on the Tools menu in Acrobat® Reader.

2 Click on the Find menu item. The Find dialog box 
appears.

3 Enter the word related to the topic you are looking for. 
For example, to find topics related to the Directory, 
enter the word, “Directory” in the Find box.

4 Click on the Find button. Acrobat Reader highlights 
the first occurrence of the word you entered. 

5 To find the next occurrence of the word, click on the 
Tools menu and then click on the Find Again menu 
item. Acrobat Reader finds and highlights the next 
occurrence of the word.

6 Repeat step 5 until you have found the topic you were 
looking for.

Using the online index

You can also use the online index to locate help topics. To 
access the index, click on the Main button at the top of 
this page and click on the Index topic.
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Zooming in or out on the page

You may want to magnify the document to get a better 
look at screens or anything else that is not clear.

For example, to get a better view of the graphics in this 
Guide, zoom the page view to 200%.

To zoom the page view:

1 In Acrobat Reader, click on the View menu.

2 Click on the Zoom menu item.

OR

1 Click on the Zoom button (shown on the 
right) on the toolbar and then click on or draw 
a marqee around the area you want to zoom.
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Printing this Guide

You can print this entire Guide or just the pages with the 
topics that interest you. 

To print all or part of this guide:

1 Click on the File menu.

2 Click on the Print... menu item.

3 Enter the page number, a page range or click on All. 
This User Guide includes an Index that prints for your 
convenience.

Warning: Due to the size of this guide (over 400 
pages), we recommend that you only print the pages 
you need. 

4 Click on the OK button.

Tip: If you have a Postscript printer, you may be able to 
conserve paper by printing two pages of this Guide on 
each sheet of paper. This print method is known as “2-
up” or “2 pages per sheet”. To specify 2-up printing, use 
the Printer Properties dialog box.

To access the Printer Properties dialog box:

1 Click on the File menu.

2 Click on the Print Setup... menu item. The Print 
Setup dialog box appears.

3 Click on the Properties button.

Each type of printer has different properties. Consult your 
printer’s user guide or on-line help for information on 
setting properties.
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Windows online help

Much of the information in this Guide about Personal Call 
Manager can also be found in the Windows® online help 
files included with the Personal Call Manager application.

Note: Windows online help covers topics related to 
Personal Call Manager only, not the 9617 telephone.

The online help Contents screen

You can access the main Contents help window from the 
Personal Call Manager menu bar and toolbar. 

To access the main online help window:

1 Click on the Help menu.

2 Click on the Help topics menu item.

OR

1 Click on the  Help button on the toolbar.

The main help window gives you three options for 
accessing help information.

From the Contents tab, you can view all of the main help 
topics. To move to one of the topics, double-click on that 
topic.

From the Index tab, you can view an alphabetically sorted 
list of keywords and concepts. The terms listed on the 
Index tab are more detailed than the topics shown on 
the Contents tab. To see a topic associated with a 
keyword, click on it.

continued...
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The main help window also has a Find tab. The Find tab 
allows you to enter a word or topic for which you need 
help information. The Find feature searches through the 
help topics and displays a list of topics that contain 
information about the word or topic you entered.

Context Sensitive help

You can also use context sensitive help. Use this method 
to learn about specific areas you select on the screen 
using the mouse pointer. 

To see help about the currently active window, dialog box 
or text field, simply press F1 on the keyboard. 

To see help about a menu item, point to it, then press F1 
on the keyboard.

If a question mark appears in the top left corner of a 
dialog box, or window, click on it. The cursor changes 
into a pointing arrow with a question mark on it. Click on 
any area of the dialog box to see help information about 
it.

In the 9617 Configuration Properties dialog, you can 
also try right-clicking on text field or area. When the 
menu item “What’s this?” appears, click on to it see help 
information about that area.
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Troubleshooting
Following are some solutions to common problems. If you 
see your problem listed below, click on it to jump to the 
page it is found on. Then determine which cause of that 
problem applies to you and then follow the suggested 
solution.

■ The telephone display is not in the language I 
want.

■ The telephone display is blank and the ringer 
volume is low.

■ I can’t see the name and number of my callers 
on the telephone display.

■ I can see Caller ID information for regular calls, 
so why can’t I see it for Call Waiting calls?

■ How do I answer a Call Waiting call?

■ My incoming calls are not being logged in the 
Callers List.

■ I cannot dial a number in the telephone’s Call-
ers List.

■ When I call from the Callers List, the area code 
is dialled for local calls.

■ I cannot program a memory key.

■ I cannot save a Directory number into a mem-
ory key.

■ The cursor doesn’t move when saving in the 
Directory.

■ I cannot hear anything on the handset receiver.
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■ The telephone was ringing and when I 
answered all I could hear was a dial tone.

■ The Handsfree speakerphone is not working.

■ How do I make my fax work with this tele-
phone?

■ I keep getting the message Check phone cord.

■ The red set light is on, and the message, fea-
ture on, appears on the telephone display.

■ When I press numbers on the telephone dial-
pad, they appear on the telephone display 
but are not dialed out.

■ The telephone wobbles.

■ I can’t get rid of a call icon in the Personal Call 
Manager Calls box even though the caller 
has hung up.

■ The name of a contact in the Directory is differ-
ent from the name that appears in the Quick 
Dials folder.

■ The Personal Call Manager Calls Log Window 
takes a long time to appear.

■ The ring configuration setting I chose for a con-
tact in my Quick Dials folder is not working

■ When I export contacts from the Address Book, 
the resulting text file is incomplete and/or 
the contact information is jumbled.

■ When contacts saved in my Address Book call, 
the names I entered in my Address Book 
don’t appear (i.e., the Name Matching fea-
ture (see page 273) isn’t working).
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■ The problem I’m having isn’t listed here
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The telephone display is not in the language I want.

Cause: An alternate language has been chosen. Display 
prompts on the 9617 telephone can appear in English, 
French, or Spanish. 
Solution: To choose the language you want, refer to 
Changing the telephone display language on 
page 20.

The telephone display is blank and the ringer 
volume is low.

Cause: The telephone is not receiving electrical power.
Solution: Check that the power adapter is connected to 
the telephone, and that the phone is connected to a 
working outlet. You can test the outlet with another 
device, such as a lamp.

Note: During a power outage, the 9617 telephone 
still operates as a regular telephone (only Line 1 works 
in this situation). You can still receive and make calls 
(using the dialpad); however, the other keys and the 
telephone display will not operate until the power is 
restored.

I can’t see the name and number of my callers on 
the telephone display.

Cause: You have not subscribed to a Caller ID service 
from your telephone company.
Solution: Contact your telephone company to ensure 
you subscribe to this service.

Cause: You answered the call before the second 
telephone ring. Caller ID information is sent to your 
telephone between the first and second ring.
Solution: Let the telephone ring at least twice before 
answering.
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I can see Caller ID information for regular calls, so 
why can’t I see it for Call Waiting calls?

Cause: You have not subscribed to a Call Waiting ID 
service from your telephone company.
Solution: Contact your telephone company to subscribe 
to this service. 

Cause: You do not have the Call Waiting ID display 
option turned on.
Solution: For information on turning this option on, refer 
to Choosing the Call Waiting ID option on page 268.

Note: When two or more telephones are on the same 
call, you will not be able to receive Call Waiting ID.

How do I answer a Call Waiting call?

To answer a Call Waiting call using the telephone, press 
˚. To answer a Call Waiting call using Personal Call 
Manager, double-click on the call icon in the Calls box. 
For more information, refer to Answering a Call 
Waiting call using the telephone on page 266.

My incoming calls are not being logged in the 
Callers List.

Cause: You don’t subscribe to the Caller ID service. 
Without this service, your telephone does not log 
incoming calls.
Solution: Contact your telephone company to ensure 
you subscribe to this service.

Cause: You may have set up the Callers List to log “No 
Calls”.
Solution: Change the Callers List mode to log either all 
calls or unanswered calls. For more information, refer to 
Setting the Callers List mode on page 338.
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I cannot dial a number in the telephone’s Callers List.

Cause: The caller may have an “Unknown” or “Private” 
number.
Solution: None. You won’t be able to return calls unless 
the number is stored in the Callers List.

Cause: The number as it was received from the telephone 
company cannot be dialed.
Solution: You may have to edit the number in the Callers 
List before you can dial it. For more information, refer to 
Editing in the Callers List on page 341.

Cause: The local telephone numbers received with Caller 
ID include the area code, and your telephone service 
won’t allow you to dial the area code for local calls.

Solution: Try stripping the area codes from incoming 
telephone numbers so you can dial them. For more 
information, refer to Stripping area codes from 
numbers in the telephone Callers List on page 375.

When I call from the Callers List, the area code is 
dialled for local calls.

Cause: The local telephone numbers received with Caller 
ID include the area code, and your telephone service 
won’t allow you to dial the area code for local calls.
Solution: Try stripping the area codes from incoming 
telephone numbers so you can dial them. For more 
information, refer to Stripping area codes from 
numbers in the telephone Callers List on page 375.
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I cannot program a memory key.

Cause: Some of the memory keys on your telephone may 
be factory-programmed. 
Solution: None. Factory programmed keys are locked; 
you cannot erase or reprogram them.

I cannot save a Directory number into a memory 
key.

Cause: You cannot copy Directory contacts directly into 
memory keys.
Solution: Save the name and number manually. For more 
information, refer to Adding a contact to the 
telephone Directory on page 140.

The cursor doesn’t move when saving in the 
Directory.

Cause: The number or name you are entering is too long. 
Solution: Don’t enter numbers longer than 24 digits or 
names longer than 16 characters.

I cannot hear anything on the handset receiver.

Cause: The handset cord is not connected properly.
Solution: Make sure the handset cord is inserted securely 
into the handset jack. For more information, refer to 
Connecting the cords on page 7.

Cause: The handset receiver volume is too low.
Solution: Make sure the receiver volume is high enough. 
For more information, refer to The handset and 
Handsfree speaker volume on page 52.

continued...
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Cause: Your telephone line setup may not be connected 
properly.
Solution: Check to ensure your setup is correct. For more 
information, refer to Installing the M9617 telephone 
on page 5. 

Cause: The Headset mode is enabled. When the Headset 
mode is enabled, you cannot use the handset.
Solution: Disable the Headset mode. For more 
information, refer to Using a headset on page 238.

The telephone was ringing and when I answered all 
I could hear was a dial tone.

Cause: If the telephone continued to ring after you 
answered it, the incoming call was on the other line.
Solution: Press the line key with the flashing light beside 
it to answer the call. You may want to change your 
answer mode. For more information, refer to Selecting 
the answer mode on page 270.

The Handsfree speakerphone is not working.

Cause: The Headset mode is enabled. When the Headset 
mode is enabled, you cannot use the Speakerphone.
Solution: Disable the Headset mode. For more 
information, refer to Using a headset on page 238.

Cause: If your caller couldn’t hear you, you may have 
muted the Handsfree speakerphone. When it is muted, 
the red light beside the © key flashes quickly.
Solution: Press the © key again to unmute it. 
(The light stops flashing and your caller can hear you.) for 
more information, refer to Handsfree calls on page 261 
and Handsfree/Mute indicator light messages on 
page 40.
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How do I make my fax work with this telephone?

There are several steps to connecting your fax to the 9617 
telephone. For instructions, refer to Connecting a fax 
machine or modem to the telephone on page 387.

I keep getting the message Check phone cord.

Cause: One of your telephone cord(s) is not connected 
properly.
Solution: Check to ensure your telephone cord(s) are 
connected properly.

Cause: You are only using one telephone line with the 
9617 telephone. The two-line 9617 telephone assumes 
that you are using two lines, and warns you that one of 
them is not connected.
Solution: Disable the Check phone cord message using 
the Options list. For more information, refer to Clearing 
the Check line cord message on page 48.

The red set light is on, and the message, feature on, 
appears on the telephone display.

Cause: Someone has pressed a FeatureLight On key.
Solution: You need to press the corresponding 
FeatureLight Off key. For more information on 
FeatureLight keys, refer to Using feature keys for 
network telephone services on page 356.
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When I press numbers on the telephone dialpad, 
they appear on the telephone display but are not 
dialed out.

Cause: The Live Dialpad option has been turned off.
Solution: Turn on the Live Dialpad option in the Options 
List. For more information, refer to Selecting the 
dialpad option on page 239. If this does not solve the 
problem, disconnect and then reconnect the AC power 
adapter.

The telephone wobbles.

Cause: The telephone cords aren’t routed properly.
Solution: Ensure that the handset cord has been routed 
in the channel between the stand and the telephone and 
that the rest of the cords are routed properly through the 
desk stand. For more detail, refer to Installing the 
M9617 telephone on page 5.

I can’t get rid of a call icon in the Personal Call 
Manager Calls box even though the caller has hung 
up.

Cause: If you answer a Call Waiting call and your original 
caller hangs up, the icon of the original caller in the Calls 
box in Personal Call Manager remains on the screen even 
though the caller is no longer there. If you select that icon 
and choose the Release command, the label for the icon 
changes to “Unknown” but the icon does not disappear.
Solution: The call icon is harmless; it does not affect your 
call. To prevent it from happening, try to release the 
original caller before s/he hangs up.

The name of a contact in the Directory is different 
from the name that appears in the Quick Dials 
folder.
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Cause: A contact entry with the same telephone number 
is stored in the My Contacts folder with a different 
name. The contacts in the Quick Dials folder are always 
the same as those in the Directory. However, if a contact 
in the Quick Dials folder has the same telephone number 
as a contact in the My Contacts folder, the contact in the 
Quick Dials folder always uses the same name as that in 
the My Contacts folder.
Solution: None.

The Personal Call Manager Calls Log Window takes 
a long time to appear.

Cause: The Calls Log Window continually adds your 
incoming and outgoing calls to its log. It has no size limit 
and will grow indefinitely.
Solution: Delete some of the older entries to make the 
Calls Log smaller. The smaller the Log, the faster it 
appears.

The ring configuration setting I chose for a contact 
in my Quick Dials folder is not working

Cause: The same telephone number you saved in the 
Quick Dials folder is also saved in a memory key on the 
telephone. You can set ring configuration features for 
contacts stored in the telephone Directory or Quick Dials 
folder AND for contacts stored in memory keys. If you 
store the same contact (i.e., the same telephone number) 
in the telephone Directory or Quick Dials folder AND a 
memory key, the ring configuration settings for the 
memory key take precedence.

continued...
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Solution: Specify the ring configuration setting you want 
in the memory key, or else delete the memory key. For 
more information, refer to Specifying Ring 
Configuration properties for contacts stored in 
memory keys on page 155 or Deleting memory keys 
on page 152.

When I export contacts from the Address Book, the 
resulting text file is incomplete and/or the contact 
information is jumbled.

Cause: The data for some contacts in your Address Book 
might contain hard returns (line breaks) or commas. 
These characters are interpreted in special ways by 
Personal Call Manager when data is exported.
Solution: Check the Address Properties dialog box for 
each contact to ensure you haven’t entered any commas 
or hard returns in the data fields. If you have, delete the 
commas or hard returns, and then try exporting. In 
particular, check the Phone Number or the Address 
fields on the Business tab of this dialog box (refer to The 
Address Properties dialog box on page 172).

When contacts saved in my Address Book call, the 
names I entered in my Address Book don’t appear 
(i.e., the Name Matching feature (see page 273) isn’t 
working).

Cause: You entered the dashes in telephone numbers 
saved in your Address Book.

Solution: Remove the dashes you entered from the 
telephone numbers saved in your Address Book.

The problem I’m having isn’t listed here
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If you’ve read this owner’s manual and consulted the 
Troubleshooting section and still have problems, please 
call 1-800-574-1611 for technical assistance.
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Warranty and Technical Support
Getting warranty or technical support

If you need warranty or technical support, please have the 
serial number on the back of your telephone and the 
software version of Personal Call Manager ready before 
you call. (For information on how to find the software 
version you have, refer to The About Personal Call 
Manager window on page 75.) Refer to the applicable 
topic below.

■ Telephone Warranty and Technical Support on 
page 423

■ Software Technical Support and Warranty on 
page 427
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Telephone Warranty and Technical Support

Limited Warranty 

Aastra Telecom warrants this product against defects and 
malfunctions during a one (1) year period from the date 
of original purchase.   If there is a defect or malfunction, 
Aastra Telecom shall, at its option, and as the exclusive 
remedy, either repair or replace the telephone set at no 
charge, if returned within the warranty period.

If replacement parts are used in making repairs, these 
parts may be refurbished, or may contain refurbished 
materials. If it is necessary to replace the telephone set, it 
may be replaced with a refurbished telephone of the 
same design and color. If it should become necessary to 
repair or replace a defective or malfunctioning telephone 
set under this warranty, the provisions of this warranty 
shall apply to the repaired or replaced telephone set until 
the expiration of ninety (90) days from the date of pick 
up, or the date of shipment to you, of the repaired or 
replacement set, or until the end of the original warranty 
period, whichever is later. Proof of the original purchase 
date is to be provided with all telephone sets returned for 
warranty repairs.

continued...

Exclusions

Aastra Telecom does not warrant its telephone sets to be 
compatible with the equipment of any particular 
telephone company. This warranty does not extend to 
damage to products resulting from improper installation 
or operation, alteration, accident, neglect, abuse, misuse, 
fire or natural causes such as storms or floods, after the 
telephone is in your possession.
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Aastra Telecom shall not be liable for any incidental or 
consequential damages, including, but not limited to, 
loss, damage or expense directly or indirectly arising from 
the customers use of or inability to use this telephone, 
either separately or in combination with other equipment. 
This paragraph, however, shall not apply to consequential 
damages for injury to the person in the case of 
telephones used or bought for use primarily for personal, 
family or household purposes.

This warranty sets forth the entire liability and obligations 
of Aastra Telecom with respect to breach of warranty, and 
the warranties set forth or limited herein are the sole 
warranties and are in lieu of all other warranties, 
expressed or implied, including warranties or fitness for 
particular purpose and merchantability.

continued...

Important Power Supply information

Power Supply: 16 V AC, 500mA.

To avoid potential electrical shock hazard or damage to 
the telephone, use only the manufacturer-supplied 
equipment and installation procedures. Specifically, use 
only 2 or 4 conductor modular teledapt plug/cords with 
this product, and an AC transformer that is CSA/UL or 
CSA-NRTL/C approved Class 2, Level C, rated. 

Substitution of non-approved equipment will void the 
Aastra Telecom warranty. For more information about 
installation and safety concerns, call 1-800-574-1611.

Warranty Repair Services 

Should the telephone fail during the warranty period:
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In North America, please call 1-800-574-1611 for 
further information. 

Outside North America, contact your sales 
representative for return instructions.

You will be responsible for shipping charges, if any. When 
you return this telephone for warranty service, you must 
present proof of purchase.

After Warranty Service

Aastra Telecom offers ongoing repair and support for this 
product. This service provides repair or replacement of 
your Aastra Telecom product, at Aastra Telecom's option, 
for a fixed charge. You are responsible for all shipping 
charges. For further information and shipping 
instructions:

continued...

In North America, contact our service information 
number:1-800-574-1611. Outside North America, 
contact your sales representative.

Note: Repairs to this product may be made only by the 
manufacturer and its authorized agents, or by others who 
are legally authorized. This restriction applies during and 
after the warranty period. Unauthorized repair will void 
the warranty.

Technical Support

If you’ve read this owner’s manual and consulted the 
Troubleshooting section and still have problems, please 
call 1-800-574-1611 for technical assistance.
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Software Technical Support and Warranty

Technical Support

For installation and configuration questions, Aastra 
Telecom provides 90 days of support starting from the 
date of the first call at no charge. 

To receive technical support, call 1-800-574-1611.

END USER LICENSE

SOFTWARE LICENSE AGREEMENT

1.Grant of License

Grant of License from Aastra Telecom Limited (“Aastra”). 
This document (“Agreement”), is the legal Agreement 
which will govern the use of the Aastra distributed 
product called Personal Call Manager software and its 
associated documentation. That product and 
documentation is called “Software” in the Agreement.

Aastra hereby grants to any user which has acquired the 
Software from Aastra or from a Aastra Authorized 
Distributor (“You”), a license to use the Software. Such 
license is limited to use in accordance with the terms of 
this Agreement.

continued...
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2.Acceptance of Term

BY OPENING THE SEALED PACKAGE WHICH CONTAINS 
THE SOFTWARE, OR BY INSTALLING THE SOFTWARE, OR 
BY USING THE SOFTWARE, YOU AGREE TO THE TERMS 
OF THIS AGREEMENT. DO NOT USE THE SOFTWARE 
WITHOUT FIRST READING, UNDERSTANDING, AND 
AGREEING TO THE TERMS AND CONDITIONS OF THIS 
AGREEMENT. IF YOU DO NOT AGREE WITH THE TERMS 
AND CONDITIONS OF THIS AGREEMENT, YOU MUST 
RETURN THE SOFTWARE AND ALL RELATED HARDWARE 
COMPONENTS THAT WERE PACKAGED WITH THE 
SOFTWARE TO Aastra OR YOUR Aastra AUTHORIZED 
DISTRIBUTOR FOR A FULL REFUND.

This Agreement is effective from the day You open the 
sealed package containing the Software and will continue 
until You return the Software and related hardware 
components that were packaged with the Software to 
Aastra or Your Aastra Authorized Distributor, and certify 
in writing to Aastra or Your Aastra Authorized Distributor 
that You have destroyed any archival copies of the 
Software You have made in any memory system or 
medium.

3.Your Obligations and Restrictions on Use

You may use the Software only on one computer terminal 
at a time. If You choose to use the Software 
simultaneously on more than one computer terminal You 
must purchase additional licenses from Aastra or a Aastra 
Authorized Distributor. You may not transfer or 
sublicense, temporarily or permanently, Your right to use 
the Software under the terms of this Agreement.

continued...
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You are granted no title or ownership rights, in or to the 
Software, in whole or in part, and you acknowledge that 
title to and all copyrights, patents, trade secrets and/or 
any other intellectual property rights to and in all such 
licensed Software and associated documentation are and 
shall remain the property of Aastra and/or Aastra’s 
suppliers/developers.

You shall not disassemble, decompile, or reverse engineer 
the Software, or by any other means seek to determine 
the source code programming comprising the Software. 
You shall make no more copies of the Software than are 
reasonably necessary to protect Your information and 
investment therein.

You shall use any copies You make only for archival 
purpose and shall keep a record of the location of all such 
copies. You shall not allow anyone to use the Software 
except Your employees and /or authorized agents.

4.Limited Warranty

Aastra warrants that for the first ninety days from the 
date the Software is delivered to You (a) the medium on 
which the Software is delivered to You shall be free of 
defects and/or faulty workmanship; and (b) the Software, 
excluding printed documentation, shall be machine 
readable by the computer terminal for which it was 
supplied; and (c) the code contained in the Software shall 
be executable by the microprocessor of the computer 
terminal for which it was supplied; and (d) the 
documentation is substantially complete and contains all 
information Aastra deems necessary to use the Software.

continued...
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If the Software should fail to meet the above warranty 
You should return it and all related hardware that was 
packaged with the Software, during the ninety day 
warranty period only, to Aastra or Your Aastra Authorized 
Distributor for replacement with another copy or for a full 
refund, at Your option. Such replacement or refund shall 
be Your sole remedy.

THERE ARE NO OTHER WARRANTIES, EXPRESSED OR 
IMPLIED PROVIDED WITH THE SOFTWARE. Aastra 
EXPRESSLY DISCLAIMS THE WARRANTIES OF 
MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR 
PURPOSE.

5.Limitation on Liability

Any possible liability to You or to any other party, by 
Aastra and/or Aastra’s suppliers and/or Your Aastra 
Authorized Distributor, arising out of this Agreement and/
or the license and use of the Software shall not exceed 
the license fee paid by You for the Software.

Aastra SUPPLIERS, AND/OR YOUR Aastra AUTHORIZED 
DISTRIBUTOR SHALL NOT BE LIABLE TO YOU FOR ANY 
SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THIS AGREEMENT AND/OR 
THE LICENSE AND USE OF THE SOFTWARE, EVEN IF 
ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH 
DAMAGES.

continued...
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6.Termination of Agreement

You may terminate this Agreement by returning the 
Software and destroying all copies, and by returning all 
hardware components that were packaged with the 
Software, as provided in paragraph 2. Aastra may 
terminate this Agreement, and require You to return the 
Software and destroy all copies, as provided in paragraph 
2, if You violate any of the terms and conditions of this 
Agreement.

7.Entire Agreement

This Agreement constitutes the entire Agreement 
between You and Aastra with respect to the licensing and 
use of the Software.
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Glossary
Address Book Tree View

The Tree View portion of the Address Book appears on 
the left of the Personal Call Manager main window, and 
shows the My Contacts and Quick Dials folders:

Address Book List View

The List View portion of the Address Book appears on the 
right side of the Personal Call Manager window, and 
contains the contacts in the folder selected in the Tree 
View portion

Comma delimited format

A file that is stored in comma delimited format has a 
comma between each field, and a carriage return 
between each record. 

A field is a single piece of information, such as a last 
name.

A record is a collection of fields that make up a single 
contact, including that contact's name, business number, 
fax number, and so on.

A carriage return is the character produced by pressing 
the Enter or Return key.

Contact Icon

Contacts are represented by an icon and a name. 
Depending on how the icon view is set, contact icons can 
appear as:

Contacts

A contact is any person or business that you add to the 
Address Book.
431



Quick Dials

The Quick Dials folder of the Address Book is used to 
store contacts that you use frequently or need to access 
quickly. The contacts that you add to the Quick Dials 
folder are automatically added to the Quick Dials menu 
item in the Calls menu or the Personal Call Manager task 
tray menu. (See The task tray icon on page 55.)

Right-click

Right clicking (moving the mouse pointer over an object 
and pressing the right mouse button) will open a menu 
for most items in Personal Call Manager. 

TAPI

TAPI stands for Telephony Application Programming 
Interface. It provides a graphical computer interface for 
your 9617 telephone and allows it to synchronize with 
your computer. 

Task Tray

The Personal Call Manager task tray icon is located at the 
bottom right hand corner of the computer screen as 
shown below. 

When you click on it, the task tray menu appears. This 
menu is identical to the Calls menu.

The task tray
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A
About PCM menu item 75
About Personal Call Manager 75
Acrobat Reader (see Adobe Acrobat Reader) 402
Active Call icon 56, 69, 241, 281
Adding, contacts (see Contacts) 137
Address Book 60, 137, 157

contacts
adding 169–170

an active caller 189
copying 198–206
deleting from Address Book 211
editing 195
importing and exporting 191
moving 207–210

displaying 67
folders 212

adding 213–215
copy and pasting 216–219
deleting 226
moving 220–224
renaming 225

icon appearance
large icon view 165
list view 167
report view 168
small icon view 166

List View section of 164
making a call from 242–246
organizing 197
Tree View section of 158

Address properties 172
Business tab 173
Email tab 177
Note tab 188
Settings tab 178

Address, entering for a contact 174
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Adobe Acrobat Reader 400–401, 403–404
Find Feature 404
Go Back button 403
Hand tool 401
online Guide 400
Page Only menu item 402
printing 406
scrolling pages 400
showing and hiding bookmarks 402
toolbar 400
zooming the page view 405

Advanced features 305
Always Ring 155, 161
Always Ring option 320
Announcements, hearing who is calling 180
Answer longest option 270
Answer mode option

Answer longest 270
Answer prime 270

Answer Preference (see Answer mode option) 96
Answer prime option 270
Answer toolbar button 278
Answering calls 263

using Personal Call Manager 271
knowing who is calling 272
main window 274–275
task tray or Calls menu 283
the You Have a New Call dialog box 276

using the telephone 264–266
Call Waiting Calls 266

Application memory key 117
Applications

(see also Launch Pad application) 394
assigning to a memory key 111, 117

using Launch Pad 396
deleting from a memory key 152

Area Codes
entering your own 126
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for dialing rules used by Personal Call Manager 126
stripping from Callers List 99, 375–376, 414

editing or deleting 377
Arrow keys 30–31
Auto Dial See Memory keys 119
Automatic Busy Redial 372–374

adding to a memory key
using Personal Call Manager 110, 115
using the telephone 85, 371

specifying the delay between attempts 85, 103, 372
specifying the number of retry attempts 86, 373

B
Backdoor feature, for bypassing Options password 88
Block Private Call option 97, 316
Block Unknown Call option 97, 315
Blocking calls (see Screening calls) 312
BMP (bitmap) file 184
Bookmarks 402
Both Address Book and Calls menu item 67–68
Busy attempts option 86
Busy redial key option 85
Busy Redial, See Automatic Busy Redial 86
Busy retry delay option 85

C
Call Announcements 178, 180–183
Call blocking (see Screening calls) 312
Call contacts (see Contacts) 137
Call Display (see Caller ID) 21
Call duration (see Call Timer) 72
Call Log (see Calls Log Window) 349
Call screening (see Screening Calls) 312
Call Timer 364

automatic display of 95, 365
Call Timer memory key 111, 116, 366–369

Call timer option 85
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Call Waiting 83, 267
and Personal Call Manager 267
Call Waiting ID option 266, 268
calls

answering 31, 266–268, 271, 275
hanging up 290
switching between calls 280
telephone display icon for 45

disabling for a telephone call 126, 269
troubleshooting 413, 418
using a fax machine 388

Call Waiting ID 94, 266, 268, 274, 413
Call Waiting ID option 83
defined 22
turning on or off 268–269

Caller ID 43–44, 97, 99, 104, 149, 180, 189, 236, 264–265,
273–274, 313, 315–316, 335, 340, 412–414

and automatic date and time setting 21
and Name Matching 273
and Personal Call Manager 272
and the Callers List 335, 353
and the Pager feature 104, 306
and the Suppress First Ring option 97, 313
and the telephone display 42
defined 22
troubleshooting 412–414
when received from telephone company 264

Callers Display option 94
Callers key 30
Callers List 43, 57, 335, 352–353

and the Pager feature 337
copying contacts from

to a memory key 344
to Directory 141
to the Directory 344

deleting callers 345
dialing from 236, 247, 355
dialing long distance 343
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display messages 44–45
editing in 341
finding items 339
list mode setup 96, 338
making a call from 247, 340
setting up 336
stripping area codes from 375–376
synchronizing 78
troubleshooting 413

Callers List is empty message 44
Callers List key 30
Callers List menu item 247, 355
Calling (see Calls, making) 340
Calling card 126
Calls

adding active caller to Directory 142
answering 263

using Personal Call Manager 271
using the telephone 264–266

blocking (see Screening calls) 312
Call Waiting 266
Callers List, stored in 336
conference calls (see Conference calls) 291
Dial dialog box 250–251
dialing manually 250
displaying the number of 55
ending 289
Handsfree calls 261

muting 262
hanging up 289
holding and unholding 284

using Personal Call Manager 287–288
using the telephone 285–286

icons
(see Task Tray menu) 69
Active Call icon 69
Extension in Use icon 70
Held Call icon 69



Index
A
B
C
D
E
F
G
H
I
K
L
M
N
O
P
Q
R
S
T
U
V
W
Y
Z

Held Conference icon 69
Ringing icon 69
status icons

in task tray or Calls menu 56
in the Calls box 69

in Personal Call Manager 68
logs and lists of 333
making

using Personal Call Manager 241
dialing manually 250
with the Address Book 242–245
with the Callers List 247, 355
with the Manual Dial menu item 250
with the Memory Key dialog box 253
with the Redial List 248, 355
with the toolbar 250–251, 253

using the telephone 230
on a second line 232
redialing a busy number automatically 370,

372–374
with a memory key 235
with the Callers List 236, 340
with the Directory 233
with the Redial List 237, 346

Memory key dialog box 253
screening (see Screening calls) 312
switching between calls

using Personal Call Manager 280–282
using the telephone 232

timing duration of (see Call Timer) 364
Calls bumped message 44
Calls List 355
Calls Log Window 333, 349

copying entries to the Address Book 190
deleting entries from 351
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displaying 349
making a call from 350
toolbar 349
toolbar button 65
troubleshooting 419

Calls menu 61
answering a call from 283
Callers List 57
DND 57
making a call from 249
Manual Dial 57
Quick Dials 57
Redial List 57

Change answer option 83
Change callers option 83
Characters, entering using dialpad 154
Check line cord message 6, 19, 34, 48, 84, 93
Check phone cord, troubleshooting 417
Choose a TAPI Line dialog box 24, 90, 124
Clear Message Waiting

option 47, 83
Clearing, a memory key 113
Closing the main window 59
Comma delimited text format 191, 432
Computer

speakers 180
synchronizing with the telephone 76

Conference Call icon 69
Conference calls 291–293, 295, 299–301, 303–304

Conference Call icon 69
four-call conference, defined 293
hanging up 304
Held Conference icon 69
holding 299
icon 56
key 31
making 292–293, 295
splitting
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a four-call conference 303
a three-call conference 301

three-call conference, defined 293
unholding 300

Conference held message 35
Conference key 31
Configure Telephony Device toolbar button 65
Connecting

a fax or modem 387, 390
the telephone cords 7

Contacts
adding 137

to Address Book 169
to Directory 141
to memory keys 146

Address Book 157
address, entering 174
Call Announcements 180–183
copying 198–206

linked copy method 200–203
template copy method 204–206

cutting 208
default telephone number 179
deleting 211
editing

in memory keys 151
in the Address Book 195
in the Directory 143

exporting 191, 194
folders 212
importing 191–192
looking up or finding 227

in Address Book 254–255, 257
in Directory 234

moving 207–210
My Contacts folder 159
pasting 201, 208
Quick Dials folder 160
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searching by name 259
sorted in Directory 139
specifying a graphic for 185–186
storing 137

Contents tab, in Windows online help 407
Contrast 18, 30, 99
Copy menu item 190, 203, 205–206, 217, 219
Copy toolbar button 63
Copying

contacts 198–206
choosing the copy method 199

folders 216–219
Cords

(see Telephone lines) 6
connecting 7

Current calls
in Personal Call Manager 68
toolbar 71

Current Calls section, of the Address Book 60
Customer support 422
Customizing the telephone

using the computer 89
using the Options List 81

Cut menu item 210, 221, 224
Cut toolbar button 63

D
Date and time, setting 21
Default telephone number, dialing 244–245
Delay in Seconds option

for Automatic Busy Redial 103
Delete menu item 211, 226, 351
Deleting

a folder 226
area codes 377
Callers List 345
contacts
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from Address Book 211
from memory keys 113, 152
from the Calls Log Window 351
from the Directory 144

dialing restrictions 380
overrides 382

features in memory keys 152
Redial List 347
security numbers 385

Desk mounting the telephone 13, 15
Dial dialog box 250–251

searching for contacts 251
Dial key 31
Dial pad (see Dialpad) 154
Dial Using menu item 90, 113–117, 119, 121, 124, 156,

307–308, 311, 319, 321, 329
Dialing

default telephone number 244
hiding the numbers dialed 383
long distance 343
manually 57, 250
non-default telephone number 245
properties used by Personal Call Manager 132
restrictions 379–381

overrides 382
Dialing Properties 24, 61, 123, 125–126

dialog box 126
disabling Call Waiting 269
turning on or off 132

Dialing Properties menu item 125
Dialing restrictions 106

overrides 107, 382
Dialing Rule Setting 132–133
Dialpad

entering characters 154
entering names 153
selecting the dialing mode 239

Directory 137, 139, 145
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adding contacts 140–141
active callers to 142

copying numbers from Callers List 344
deleting contacts 144
editing 143
entering names 153
finding contacts in 234
key 30
making calls with 233
synchronizing with Quick Dials 77, 134

Directory empty message 34
Directory full message 34
Directory key 30
Directory Synchronization toolbar button 66
Display

changing language 365
contrast 18, 99
language 20
messages

Callers List 42
general 34
viewing multiple messages 42

Distinctive Ringing service 388
DND (see Don’t Disturb feature) 57
DND menu item 328
Do Not Disturb (see Don’t Disturb feature) 322
Don’t Disturb feature 57, 322

allowing override for some contacts 329
Don’t Disturb key 325
memory key

adding to 110, 114, 325
deleting from 152, 326

screening calls with 320
turning on and off 328

using a memory key 325
using Personal Call Manager 327
using the telephone Options List 323

Don’t disturb key option 85
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Don’t disturb option 85

E
Edit menu 61
Editing

Address Book 195
area codes 377
dialing restrictions 380

overrides 382
memory keys 151
security numbers 385
the Callers List 341
the Directory 143

Email address, entering 177
Enable Call Timer option 95
Enable DND option 102
Enable Headset option 95
Enable line cord check option 93
Enable live dialpad option 95
Enable Pager Notification option 93, 104
Ending a call 289
Enter area codes option 84
Exit menu item 26
Exiting Personal Call Manager 26
Export Contact menu item 194
Exporting contacts 191, 194, 386
Extension in Use 41

icon 70, 73
notification 73

Extension in use message 34

F
Fast Search 128, 257
Fax

connecting to telephone 387–390
number 388

Fax Switch feature 83, 387
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turning on or off 95, 390
Feature highlights 4
Feature keys 356

(see FeatureLight keys) 356
creating 358
saving feature codes to memory keys 357
using 359

Feature ON message 34
FeatureLight keys

creating 121, 360–362
FeatureLight Off key 111
FeatureLight ON key 38, 111
using 363

File menu 61
Find Now button 128
Find Person menu item 255, 257
Find Person toolbar button 65
Find tab, in Windows help 408
Finding contacts (see Searching for contacts) 254
Firmware version 86
Flashing lights on the telephone 38–40
Folders 212

adding 213–215
copy and pasting 216–219
deleting 226
moving 220–224
renaming 225

Forwarded Call message 35
Forwarded message 44
Four-call conference, defined 293

G
Glossary 432
Go Backward button, in Acrobat Reader 403
Go Forward button, in Acrobat Reader 403
Graphics, specifying for contacts 184–186
Guide, how to use 399
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H
Handset volume 52
Handsfree calls 261

dialing 239
muting 40, 262
troubleshooting 416

Handsfree speaker 40
volume of 52

Handsfree/Mute
indicator light 40
key 32

Hanging up 289
Headset 95

option 84
using 238

Headset mode option 238
Held Call icon 56, 69, 287
Held Conference icon 56, 69
Help menu 61
Help messages, in the Status Bar 74
Help toolbar button 65
Help topics

accessing Windows online help topics 407
table of contents 2

Help topics menu item 407
Hold

key 31
line indicator light 39

Hold toolbar button 278
Holding and unholding calls 284

using Personal Call Manager 287–288
using the telephone 285–286

Hotlinks, using 401

I
Icons

Active Call icon 56, 69
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appearance in the Address Book 165–168
Conference Call icon 56, 69
Extension in Use icon 70
for calls

in task tray menu 56
in the Calls box 69

Held Call icon 56, 69, 287
Held Conference icon 56, 69
Message Waiting 46
Ringing icon 57, 69
startup 54
task tray icon 55
task tray menu 56

icons
DND (in task tray) 102, 327

Import Contact menu item 193
Importing contacts 191–192
Incoming call 38–39
Incoming Calls Log Window 333, 349

copying to Address Book 190
deleting items from 351

Index tab, in Windows online help 407
Installing, 96179617 telephone 5

K
Key is locked message 35
Keyboard shortcuts 398
Keys, telephone

described 30
location of 29
memory keys, labelling 150

L
Labeling memory keys 150
Language 96

See also Display language 20
troubleshooting 412
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Language choice option 82
Large Icon menu item 165
Large Icons toolbar button 64, 71
Launch Pad application 394

assigning an application 396
starting 395
using 397

Left arrow key 30
Letters, entering 153–154
Lights

flashing on the telephone 46
location of 29
on the telephone 38–39

Lights, stopping from flashing 47
Line

(see also Line-cord setup and Telephone lines) 6
choosing 9617 TAPI line 124
keys 31
Prime line, for telephone 96, 240
TAPI line used 74, 90

Line indicator light
extension in use 41
messages 39

Line x is prime option 82
Line-cord setup

one telephone cord 10
two telephone cords 11

Link key 31
Linked copy method 200–203
List menu item 167
List Mode, of Callers List 96
List toolbar button 64, 72
List View section, of Address Book 67, 164, 167
Live dialpad option 82, 95, 239, 418
Long distance 98, 126, 343

dialing from the Callers List 343
using a Special Ring for 98

Looking up contacts 227
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in the Address Book 254
in the Directory 234

M
9617

Options List 81
setting up 80

9617 Configuration Properties dialog box 80, 92
(see also Options List) 92

9617 Options menu 61
9617 Property Page toolbar button 66
9617 Toolbar menu item 62
Main window

closing 59
components 60
opening 58
startup option 130

Make calls first message 35
Make second call message 35
Making Calls (see Calls, making) 229
Manual Dial menu item 250–251, 253
Manual Dial toolbar button 71
Memory Key dialog box 253
Memory Key toolbar button 65
Memory keys 32, 76, 137, 146

adding contacts to 119, 147
adding an active caller 149
from Callers List 148, 344
from Redial List 148
saving numbers and names 147

adding features to
assigning an application 396
pager feature 310
telephone network features 357

FeatureLights 360
the Don’t disturb feature 325

copying from memory keys to Directory 141
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deleting 113, 152
editing 151
labeling 150
launching an application with 397
making a call with 235, 253
Memory key dialog box 253
programming in Personal Call Manager 110
telephone network features 358
troubleshooting 415

Menu bar 60–61
Message Waiting 38, 46
Message Waiting message 35, 46
Messages

(see Voice Mail) 38
viewing multiple display messages 42

Microsoft 126
Modem, connecting to telephone 387, 390
Moving

contacts 207–210
folders 220–224

Muting Handsfree calls 262
My Contacts folder 159

N
Name Matching and Personal Call Manager 273
Names

different in Directory and Quick Dials folder 418
editing

in memory keys 151
in the Directory 143

entering 119, 140–141, 147–148, 153–154, 172–174,
189, 205–206, 344

searching by 234, 251, 254–255, 257, 259–260
using wildcard characters 260

sorted in Directory 139
Network services 22

adding links to in telephone numbers 175
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saving to memory keys 357
Never Ring 155
Never Ring option 161, 317, 319
New Callers message 36
New Contact toolbar button 63
New Folder toolbar button 63
New menu item 170, 214–215
No number message 44
Number card 17
Number of Tries option, for Automatic Busy Redial 103
Numbers 107

adding dialing pauses and links 175
dashes, in Personal Call Manager 174
default telephone number 179, 244
deleting from Callers List 345
dialing restrictions 106, 378

overriding 381
editing in Directory 143
editing in memory keys 151
entering 119, 140–141, 147–149, 153, 172–174
long distance 126
non-default telephone number 245
Security Numbers feature 106
Security numbers feature 383

O
Online Guide, using 399
Online help, Windows online help topics 407
Only Address Book menu item 67
Only Calls menu item 68
Options

Busy attempts 86
Busy redial key 85
Busy retry delay 85
Call timer 85
Call Waiting ID 83
Change answer 83
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Change callers 83
Check line cord 84
Clear message waiting 83
Don’t disturb 85
Don’t disturb key 85
Enter area codes 84
Fax switch 83
Headset 84
Language choice 82
Live dialpad 82
Overrides 84
Password 86
Prime line 82
Restrictions 84
Ring tone 82
Security numbers 84
Set list mode 83
Time/date 82
Timer key 85
Versions 86

Options key 32
Options List 76, 81

password 87, 107–108
bypassing using backdoor feature 88

summary 82
Outgoing Calls Log

copying entries to Address Book 190
Outgoing Calls Log Window 333, 349

deleting entries from 351
Outside lines, accessing 126
Overrides option 84
Overriding dialing restrictions 107, 381
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Page view, magnifying 405



Index
A
B
C
D
E
F
G
H
I
K
L
M
N
O
P
Q
R
S
T
U
V
W
Y
Z

Pager feature
Caller ID 104, 306
Enable Pager Notification option 104
Pager Notification options 104
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setup
enabling 104, 308
entering pager settings 307
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overview and how it works 306
setting the Callers List 337

Pager Notification option 155
Pages, turning or scrolling 400, 402
Password

bypassing using backdoor feature 88
for Options List 86–87, 107–108

Paste menu item 190, 203, 210, 217, 219, 221, 224
Paste Special menu item 205–206
Paste toolbar button 64
Pasting, contacts 201, 208
Personal Call Manager

exiting 26
Getting familiar with 53
main window 60

closing 59
opening 58

preferences 127
setting up 123
software version 75
starting 25

for the very first time 24
switching between calls 281
task tray icon 54, 274
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taskbar icon 54
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Phone numbers (see Numbers) 119
Pick ring tone option 82
Power

adaptor 9, 425
outage 412
supply 425

Pre-dial mode 239
Preferences 127

Dialing Rule Setting 132
main window at startup 130
Personal Call Manager 127
Search 128
startup synchronization 134

Preferences menu item 129, 131, 133–134
Press Conference message 35
Press line key message 35
Prime line 96

choosing 82, 240
Printing

Address Book contacts 386
this Online Guide 406

Private callers 414
blocking 316

Private name message 36
Private number message 36, 44
Problems, troubleshooting 409
Properties menu item 181–182, 185–186, 188, 195, 225,

275, 277, 283, 317, 332
Properties toolbar button 64, 71, 279
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folder 160
menu item 57

making a call from 249
pager feature 310
synchronizing with Directory 77, 134, 145

Quick Dials menu item 169, 178, 249, 433
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Recommended telephone network services 22
Redial key 31
Redial List 57, 237, 352, 354

copying contacts to Directory 141
deleting 347
making calls from 248, 346
synchronizing 78

Redial List is empty message 36
Redial List menu item 248, 355
Redialing a busy number automatically 370, 372–374
Release Call toolbar button 71
Release key, on the telephone 31
Release toolbar button 278
Removing area codes 376
Renaming a folder 225
Repairs 422–426
Report menu item 168
Report toolbar button 72
Report view, of icons in Address Book 168
Restricted Number Settings 106
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Restrictions option 84
Returning a call 236
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Right-click 433
Ring Configuration
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settings for Quick Dials 161
troubleshooting 419
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Ringer

tone 51, 94
turning off using Don’t Disturb 322
volume 50, 94, 412

Ringer is OFF message 36
Ringing icon 57, 69
Rls key (see Release key) 31

S
Save key 30
Screening calls 98, 312

Always Ring option 320
Block Private Call option 316
Block Unknown Call option 315
Never Ring option 155, 161, 317, 319
Special Ring 155, 161, 314
Suppress First Ring option 313

Scroll keys, on the telephone 30
Scrolling pages 400
Search mode 128–129, 254

Fast Search 257
Slow Search 255

Search preferences 128–129
Searching for contacts 227, 254

in Personal Call Manager 255
Address Book 254, 257
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using wildcards 260

preferences
Fast Search 257
Slow Search 255
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telephone Directory 234
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Searching for help topics 404
Second Line 232
Security numbers 383

editing and deleting 385
entering 384
in Personal Call Manager 106
option 84

Set indicator light messages 38
Set Language 96
Set List Mode 83, 96
Set Prime Line 96
Setting date and time 21
Setup

installing the 9617 telephone 5
one line-cord 10
Personal Call Manager 123
two line-cords 11

Shortcuts 398
Show Call Log Window menu item 190, 349–350
Show Warning 136
Slow Search 128
Small Icon menu item 166
Small Icons toolbar button 64, 71
Software

(see Applications) 396
warranty for 429

Solving problems 409
Sound recording software 180
Special Ring for Long Distance option 98
Special Ring option 155, 161
Stand, attaching to telephone 12
Starting, Personal Call Manager 25
Startup icons 54
Startup option 130

changing 131
Startup synchronization 134
Status bar 60, 74

displaying 74
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Status Bar menu item 74
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for calls in task tray or Calls menu 56
for calls in the Calls box 69

Stripping area codes 375–376
Suppress First Ring option 97, 312–313
Switching between calls, using the main window 281
Switching between lines 265
Synchronization

at startup 134
between the telephone and computer 76
Quick Dial folder and Directory at startup 145

T
Table of Contents (see Bookmarks) 402
TAPI line 24, 61, 74, 123

defined 124, 433
specifying 9617 124
used 90

TAPI Line Configuration dialog box 107
Task Tray 433
Task tray icon 54–55

answering calls from 283
displaying the number of calls 55
menu 55
menu icons 56
popup menu 56
seeing who is calling 274
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Technical support 422
Telephone
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messages 34
troubleshooting 412
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key descriptions 30
location of keys and lights 29
numbers (see Numbers) 174
setting features for using the computer 89
setup 80
synchronizing with the computer 76

Telephone lines
accessing outside 126
determining your setup 6
one line-cord setup 10
options for 93
two line-cord setup 11

Telephone network services 22
Telephone numbers (see Numbers) 174
Template copy 204–206
Three-call conference call 293
Three-Way Call

defined 22
making 297

Time and date, setting 21
Time/Date option 82
Timer key

adding 367
deleting 369
option 85
using 368

Timing calls (see Call Timer) 364
Tone dialing service 126
Toolbar

Call Log 349
Current Calls 71–72
main 63–66

button descriptions 63
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location 60

making calls from 250–251, 253
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You Have a New Call dialog box 278
Toolbar menu item 62
Tools menu 61
Tree View section, of the Address Book 67, 158
Troubleshooting 409
Turning pages 400

the Go Backward button 403
the Go Forward button 403

txt, file extension 192
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Undo menu item 211, 226, 289
Unhold toolbar button 278
Universal Serial Bus 8, 10–11
Unknown callers 414

blocking 315
Unknown Name message 36, 44–45
Unknown number message 36, 44
Up One Level toolbar button 63
USB 8, 10–11
User Guide

how to use 399
Using this Online Guide 399–400

printing 406
searching for help topics 404
zooming 405

V
Version

of Personal Call Manager software 75
of telephone firmware 86

View menu 61
Voice Mail 35, 38, 47, 383

notification 46
Voice Mail Assistant application
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muting a Handsfree call 262
ringer 94
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Warranty 9, 422–426

software 429–430
WAV file 180
Wildcard characters, for searching 260
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You Have a New Call dialog box

answering a call using 276
graphics in 184
opening 276
toolbar buttons 278

Z
Zooming in or out on the page 405
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